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VISITREN DIPLOT™ 

PREFACE 

USER'S 
GUIDE 

PREFACE 

This manual teaches you how to use the VisiTrendlPlot™ program and 
provides a complete reference for the program. 

Chapter One is an introduction to the product. It describes its pur­
poses and teaches many of the basic concepts required of a user. 

Chapter Two is a tutorial. Each subprogram of the VisiTrend/Plot pro­
gram is described with examples and illustrations. You are introduced 
keystroke-by-keystroke to drawing graphs, managing files, editing, and 
analyzing data. 

Chapter Three is a reference. All program functions are listed 
alphabetically. You can look up any menu option by name. It is a useful 
tool to refresh you memory about any function. 

The Glossary explains the terminology associated with the product and 
the functions it performs. 

The Appendices cover special topics such as error messages (Appen­
dix A), printer information (Appendix B), file storing details (Appendix 
C), and using VisiTrend/Plot with other programs such as as VisiCalc® 
(Appendix D). 

xv 





CHAPTER 1 
VISITREN D/PLOTTM USER'S 

GUIDE INTRODUCTION 

INTRODUCTION 

The VisiTrendlPlot™ program turns your computer into a data analysis 
and chart-plotting system. With this program you enter and save 
business series data, do complex forecasting and analysis, display charts 
of your current status and goals, print charts on your printer, and save 
charts on diskette for use by another program. The VisiTrend/Plot pro­
gram communicates with the VisiCalc® program and other VisiCorp ™ 
programs that support DIFTM (Data Interchange Format) files. 

The VisiTrend/Plot program consists of three subprograms: 

• One for file management and data editing (Main subprogram). 

• One for statistical analysis, forecasting, regression, and time-series 
generation (Trend subprogram). 

• One for creating charts of the series data managed and generated by 
the other subprograms and for creating text-only foils (Plot 
subprogram) . 

Figure 1-1 shows the relationship of these subprograms. 

Main Subprogram 

VIEW, INITIALIZE, STORE 

Store 

~BBI 
Load 

Plot Subprogram 

GRAPHICS 

012-001 

Figure 1-1. VisiTrend/Plot Program Overview 
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INTRODUCTION 

THE MAIN SUBPROGRAM 

The Main subprogram: 

• Loads series data from disk. 

• Saves series data on disk. 

• Lists the series data currently in memory. 

• Controls the assignment of disk drives. 

• Clears unwanted series data from memory. 

• Provides the means of entering new series data and modifying the 
existing series data. 

The Main subprogram also provides the means of loading the Plot or 
Trend subprograms. When you load the VisiTrendlPlot program, opera­
tion begins in the Main subprogram; you must load series data from disk 
or create new series data before drawing charts. 

THE TREND SUBPROGRAM 

The Trend subprogram: 

• Develops data series used for analysis and forecasting techniques. 
The available methods include derivation of moving averages, 
smoothing data, percent of change, leading, lagging, and 
cumulative total functions. Additionally, new series can be created 
by taking sums, ratios, logs, or other mathematical or logical transfor­
mations of the time series data. 

• Performs linear multiple regressions (using the ~rdinary least squares 
method). It calculates and displays the major statistical measures of a 
multiple regression including the standard errors of the coefficients 
and the regression, T- statistic, R-bar squared, the F-statistic, and the 
Durbin-Watson statistic. 

• Performs trendline forecasting. 

• Calculates and generates statistics such as mInImum, maximum, 
mean, variance, standard deviation, and correlation coefficient. .. 
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THE PLOT SUBPROGRAM 

The Plot subprogram communicates series data visually by generating 
the types of charts shown in Figures 1-2 through 1-7. 

012-001/P 

Figure 1-2. Typical Line Chart 

Line charts consist of points plotted against a value axis and a time 
axis. The points can be plotted with or without the connecting line. 

012-002/P 

Figure 1-3. Typical Bar Chart 

Bar charts consist of vertical bars that show value by their height. 
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012-003/P 

Figure 1-4. Typical Area Chart 

Area charts are line charts with the area between the plotting line and 
the base line filled in. 

012-004/P 

Figure 1-5. Typical Pie Chart 

Pie charts show percentage of a whole or total with segments of a 
circle. 
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012-005/P 

Figure 1-6. Typical High-Low-Close Chart 

High-low-close charts use a vertical line at each series data point to 
show the high value, low value, and intermediate value for that point in 
time. 

012-006/P 

Figure 1-1. Typical XY Chart 

An XY chart shows two sets of values plotted against each other. 
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Additionally, with the use of the Visi'l'rend/Plot overlay and window 
capabilities, combinations of all the formats, except pie, are possible. (A 
pie chart is a unique form that is always handled separately.) The charts 
in Figures 1-8, 1-9, and 1-10 are examples of some combinations. 

012-007/P 

Figure 1-8. Combined Line and Bar Chart 

012-008/P 

Figure 1-9. Comparative Bar Chart 
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012-009/P 

Figure 1-10. Combined High-Low-Close and Line Chart 

COMPUTER REQUIREMENTS 

To use the VisiT rend/Plot program your computer must have: 

• 128K or more of memory. (Having more than 128K of memory does 
not increase capabilities.) 

• A video monitor. You can use any video monitor, that can be con­
nected to your IBM Personal Computer I except the, IBM Monochrome 
Display (Model 5151). A black and white or color monitor can be used 
even though the program displays do not appear in color. 

• An IBM Color/Graphics Monitor Adapter (1504910) must be installed 
in your computer. The adapter is required even though the 
VisiTrend/Plot program displays do not appear in color. 

• One or more floppy disk drives. Two drives are recommended. 

• The three VisiTrend/Plot product disks that come with this manual. 
These disks are in the plastic sleeve in the binder containing this 
manual. 

• You should have at least one blank disk to begin. 
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One Disk Drive System Differences 
The VisiTrend/Plot program operates with one or two disk drives. Two 

disk drives are recommended. This manual assumes that you have two 
disk drives. If you have only one drive, the only difference in program 
operation is that you are told when to remove the program disk and insert 
the data disk and vice versa. 

In the few instances when you are told to enter IBM DOS commands, 
the command for a one drive system is also shown if it is different. 

TAKING CARE OF DISKETTES 

You can't be too careful with your disks. Each disk is magnetically 
coated and sealed in a protective square plastic cover. You can see the 
magnetic surface of the disk through the oval cutout in the square cover. 

Never touch the exposed magnetic surface with your fingers or any 
implement. Protect disks from dust by storing them in the paper sleeves. 
Do not store them within six inches from magnetic fields generated by a 
TV, speakers, or other magnetic devices. 

Temperature extremes (such as in a car trunk on a warm day) destroy 
disks. Never fold, bend, or staple a disk. And don't write on the square 
plastic cover with a hard pen or pencil (use only the soft felt tip pens). 
Store disks in a special disk binder or disk case . 

How To Make Backup Copies of Your Data Disks 
Always keep a backup copy of data disks that contain information that 

is not available elsewhere or that you cannot afford the time to recreate . 
. Use the IBM DOS DISKCOPY command to copy whole disks or the 
COPY command to copy individual files. See your IBM Personal Com­
puter Disk Operating System manual for information on the use of these 
commands. 

Your program disks are protected; you cannot make operational 
copies of them. 

GETTING STARTED 

The Keyboard 
Figure 1-11 shows the computer keyboard. With the exception of the 

function keys and a few other keys, the keyboard is self-explanatory. Any 
special keys will be explained as you need to use them. 
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Certain keys that you use frequently have key cap symbols that are 
represented differently in the manual. They are shown in the manual as 
follows: 

Manual 
Key Function Representation 
+-- Backspace [BKSP] 

~ Tab [TAB] 

The use of these keys is explained in the lessons. For now it is impor­
tant that you know their names and locations on the keyboard. 

012-002 

Figure 1-11. The Keyboard 

PREPARING THE PROGRAM DISKETTE 

The VisiTrend/Plot program disk does not include the disk operating 
system (DOS). Before loading the program, you must place DOS on the 
VisiTrend/Plot Program Disk #1. You only have to put DOS on the 
disk once. 

1. Load the IBM DOS disk (Version 1.00 or 1.10) according to the 
instructions in the Disk Operating System manual. 

2. Put the VisiTrend/Plot Program Diskette #1 in drive B. 

3. Type sys b: (also sys b: for a single drive system) and press ~. 
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4. Type copy command.com b: (copy command. com a: for a single 
drive system) and press ~. 

5. Remove the IBM DOS disk, insert the VisiTrend/Plot Program 
Diskette # 1 in Drive A, and proceed to the next section. 

LOADING THE PROGRAM 

1. With Program Diskette #1 in Drive A and the Example Diskette in 
Drive B, video monitor and printer (if applicable) turned on, turn on 
the computer. If the computer is already operating, press the Ctrl key 
and hold it down while you press the Alt and Del keys together. 

NOTE: If you turn on the printer after loading the program, the pro­
gram will not know that a printer is connected to the computer and you 
will not be able to print. 

2. When the program tells you, remove Program Diskette # 1 and insert 
Program Diskette #2 into Drive A and press the ~ key. 

3. When the VisiTrend/Plot startup display, shown in Figure 1-12, 
appears, the program is loaded. 

THE STARTUP DISPLAY 

Figure 1-12 shows the startup display after loading the VisiTrend/Plot 
program. 

Figure 1-12. Startup Screen Display 
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The dark and light lines at the top of the screen are called the status 
area. Status areas provide operating information and contain com­
mand menus. 

A command menu is a list of the commands available to you at this 
point in the program. You select a command from a menu with a visual 
pointer called a cursor. The cursor is described in the next section. 

The inverse video lines (dark characters on a light background) supply 
information or give direction. The normal video lines (light on dark) 
display menus, messages from the program, or space for data entry. 

Below the status area are the program version number, the copyright 
notice, and the serial number of your program disk. Write the version 
number and serial numbers down for future reference in case you call or 
write to VisiCorp with a question about the program. The copyright 
notice shows that the program is protected by the United States copyright 
laws. Be sure to read the VisiCorp Customer License Agreement in 
the User Support Plan about the copyright protection of this program 
and manual. 

Near the bottom of the screen are some lines of directions on how to 
select an item from the menu. 

THE CURSOR 

The cursor-an inverse video rectangle-is your pointer to items on 
the screen. If you just loaded the program and have not pressed any 
keys, the cursor highlights the item Load. 

Press the ~ key on the keyboard. The inverse video area (cursor) 
moves to the word Plot. Press the ~ key and the cursor moves back 
to Load. 

As you move the cursor, the top line of the status area (called the long 
prompt) changes. With the cursor pointing to Load, the top line 
indicates you can load a file from the data disk. With the cursor pointing 
to Plot, the top line indicates you can go to the Plot subprogram. The long 
prompt gives a longer description of the menu item to which the cursor 
is pointing. 

You can move the cursor left or right with the ~ and ~ keys; you can 
move it up or down one line in the menu with the i and ~ keys or the space 
bar. Experiment with the arrow keys and the space bar to put the cursor 
on various menu items until you feel at ease moving the cursor. 

1-11 



VISITREN DIPLOT™ g~r~~s IBM PERSONAL COMPUTER 
INTRODUCTION 

SELECTING A MENU ITEM 

Just moving the cursor to a menu item does not command the program 
to do anything. To make the program respond, you must select a menu 
item. 

You can select a menu item in two ways: 

• You can move the cursor to the item, then press the ~ key. 

• Type the first two letters of the desired item name-there is no need to 
press the ~ key. 

Move the cursor to Display, and press the ~ key. A message about no 
active series replaces the menu in the status area and a beep sounds from 
the computer. The program cannot display series information because 
nothing has been loaded into memory. 

SUMMARY 

This completes your introduction to the VisiTrend/Plot program. 
Already, you know how to set up your computer for the VisiTrend/Plot 
program. You've learned how to load the program, how to move the cur­
sor around a menu, how to select an item from the menu, and how to use 
certain keys to get the menu display back on the screen. 

Now you are ready to go on to the VisiTrend/Plot lessons. Lesson One 
is about drawing charts on the screen. Lesson Two covers the Main sub­
program except for the Edit functions. The Edit functions are covered in 
Lesson Three. Lesson Four describes how to use the statistical analysis 
functions in the Trend subprogram. In Lesson Five, you will plot a 
number of charts to gain experience with more complex data series. 
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LESSON ONE 

THE PLOT SUBPROGRAM 

This lesson assumes you have read the Introduction and know: 

• How to load the VisiTrend/Plot program from diskette. 

• How to move the cursor in a menu. 

• How to select an item from a menu. 

Refer back to the Introduction if you are not sure how to do these 
operations. 

This lesson deals with plotting existing data series. You will learn how 
to load plotting data and use the Plot subprogram. By the end of this 
lesson, you will know how to: 

• Display a chart. 

• Add titles and other enhancements to a chart. 

• Change the scale and range of a chart. 

• Print a chart. 

• Save the screen image of a chart. 

LOADING THE PROGRAM 

Load the VisiTrend/Plot program according to the directions under 
"Loading the VisiTrend/Plot Program" in the Introduction. 

When the program is loaded, the display should look like Figure 2-1. If 
the display does not look like this, reload the program carefully accord­
ing to the preceding instructions. 
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Figure 2-1. Startup Screen Display 

The bottom line of the status area should specify the drive with the 
data disk. 

The startup screen displays the Main subprogram menu. From this 
menu you can get to the other subprograms. You must load data from the 
Main subprogram before going to the Plot subprogram to draw a chart. 
Do the following: 

1. Put the cursor on Load, and press ~. The program displays a list of 
the data files on the example disk. 

2. Put the cursor on x:SAMPLE1.SER, and press ~. (x: identifies the data 
drive.) A list of the data series in SAMPLE1.SER is displayed. 

3. With the cursor on Return, press ~ again. The list disappears and the 
menu returns. The series in the SAMPLEl.SER file have been loaded 
into memory, and you can now use them to draw (plot) charts. 

4. Move the cursor to Plot, and press ~. 

You are now in the Plot subprogram. The Select menu, shown in 
Figure 2-2, appears in the status area at the bottom of the screen. A 
prompt asking you to choose a chart type appears above the status area. 
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Figure 2-2. Select Menu 

SELECTING A CHART TYPE 

From the Select menu you select the type of chart you want to draw and 
the data series for the chart. The menu items indicate the six kinds of 
VisiTrendiPlot charts: Line, Bar, Area, Pie, High-Low-Close, and XY. 
The last item on the menu, None, exits from this menu without choosing 
.a chart type. This exit path comes in handy at times, especially if you get 
to this menu by mistake, which can happen before you become familiar 
with the program. 

With the cursor on Line, press ~. You elected to draw a line chart. 

The menu is replaced by the prompt Cursor movement, <SPACE>, 
or < ENTER> telling you which keys to use to select from the list. The list 
of names you saw after loading SAMPLEl.SER appears at the top of 
the screen. 

The list includes some information about each series. Going across the 
header line, the informational items are: 

Name 

Per 

The name of the data series. 

The period of the series. The series in the list have a period of 1. 
The period is the number of subdivisions within the basic time 
unit. The period can be any value from 1 to 99. Typical values 
are 1 (annual), 4 (quarterly), 12 (monthly), and 30 (daily). 

2-3 



VISITRENDIPLOT™ ~~T~~s IBM PERSONAL COMPUTER 
LESSON ONE TUTORIAL 

Start The start date for the series. Both series in the list start in 1973. If 
the period is other than 1 (annual), the start date is the year and 
the period of the first data point. For example, a start value of 
"1980 9" (with a period of 12) means the 9th period of 1980 or 
September, 1980. 

End The end date for the series. Everything mentioned in the 
description of Start applies to End. 

# The number of data points in the series. A series can contain 
250 data points. 

You must select a series from this list. You cannot go further in the Plot 
subprogram unless you have selected a series to plot. Selecting an item 
from a list is not much different than selecting from a menu. Move the 
cursor to the item and press the ~. 

To move the cursor up and down in this list, use the t key and the ~ key. 
The cursor wraps around from bottom to top and vice versa. For 
example, if you try to go beyond the bottom line of the list, the cursor 
jumps to the top line. 

Move the cursor to the series named Floppy Soles and press ~. 

PLOTTING A CHART 
When you select a series, the list disappears and the Plot menu, shown 

in Figure 2-3, appears in the status area. Most of your work with the Plot 
subprogram is done from this menu. 

Figure 2-3. Plot Menu 
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The left side of the bottom line contains Floppy Soles/Line and the 
right side, Wh.Bk. The left side indicates you selected a Line chart and 
the series named Floppy Sales. The right side indicates the data will be 
displayed in white (Wh.) and the background in black (Bk). 

The cursor is pointing to the word Plot, and. the top line of the status 
area indicates this item plots the current series. The current series is the 
last series or group of series you selected. You can select more than one 
series, then they all become the current series. Selecting multiple series 
is described in Lesson Five. 

DRAWING THE CHART 

With the cursor on Plot, press ~. The screen should now look like 
Figure 2-4. 

012-013/P 

Figure 2-4. Line Chart With Floppy Sales Data 

Examine the chart. The numbers along the vertical or Y-axis are the 
scale of the chart. The numbers along the horizontal or X-axis are the 
range. Remember that the series listing said this series covered the years 
1973 through 1984. The numbers along the X-axis are 73, 74, and so 
forth. When the range is given in years and there are many plotting 
points, the Plot subprogram abbreviates the range numbers to fit on 
the axis. 
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The legend at the bottom contains: the chart-type code (L for Line), the 
plotting symbol used for the series (a square with a dot in the center), and 
the name of the series (Floppy Sales). A square with a dot is always used 
when a single series is plotted. Later, when you draw charts with multiple 
series, you will see the other symbols: triangle with a dot in it (8), 
number sign (#), asterisk (*), plus sign (+), and x. 

To get the menu back, press the Esc key. The status area reappears 
and covers the legend. The full chart is still visible above the status area. 
The status area still contains the Plot menu. 

If you want to see the chart again without the status area, press the Esc 
key again. You can switch back and forth as often as you want. 

DRAWING A BAR CHART 

If the status area is not on the screen, display it by pressing Esc. You 
can use the other functions in the Plot menu to change the chart. You can 
put titles on it, change the range and scale, put grid lines on it, and much 
more. You are going to start over and repeat what you did to draw the 
line chart. The difference is that you are going to draw a bar chart. 

Move the cursor to Select. The long prompt is Select a chart type. 
Press ~. 

The Plot menu is replaced by the Select menu and the chart is erased. 

Move the cursor to Bar and press ~. 

The Select menu is replaced with the Bar menu. From this menu you 
select the type of bar. Your options are: 

• Full, shown in Figure 2-5, produces full-width bars that are centered 
on the X-axis tick marks. 

• Both, shown in Figure 2-6, produces half-width bars that are positioned 
on either side of the X-axis tick marks. When you choose this option 
you must select two data series; the first is positioned on the left of the 
tick marks and the second on the right. 

• Left or Right, shown in Figure 2-7, produce half-width bars that are 
positioned to the left or the right of the tick marks. 
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Figure 2-5. Full-width Bars 
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Figure 2-6. Both Bars 
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Figure 2-7. Left and Right Bars 

With the cursor on Full, press ~. The list of data series is displayed. 
Select Floppy Sales. 

As before, the list disappears and the Plot menu reappears. You can 
see the Floppy Sales line chart again. The old chart remains until you 
Plot the new chart. The bottom line of the status area now reads Floppy 
Soles/Bar. 
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With the cursor on Plot I press ~. 

The line chart is replaced with a bar chart; the beep indicates the chart 
is completed. Your screen should now look like Figure 2-8. 

012-014/P 

Figure 2-8. Bar Chart With Floppy Sales Data 

Adding Detail To a Chart 
The chart on the screen is sparse. Sometimes you have to include more 

detail in a chart. You might want to expand the legend, to highlight some 
detail, or explain unusual data. 

Press Esc to display the status area. 

Options lets you add detail. Move the cursor to Options, and press ~. 
The Plot menu is replaced by the Options menu, shown in Figure 2-9. 
You are going to use all of these options in this lesson. 
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Figure 2-9. The Options Menu 

Putting Titles On a Chart 
With the cursor on Title, press ~. The Title menu, shown in Figure 

2-10, is displayed. 
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Figure 2-10. Title Menu 
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The first item is Exit which lets you return to the Plot menu. The other 
items perform their functions,. then return to the Title menu. 

Move the cursor to Top, and press ~. 

The menu is replaced by an entry area, as shown in Figure 2-11. The 
third line of the status area is the title-entry line. It displays what you type 
at the keyboard. 

012-020/P 

Figure 2-11. Entry Area 

Type My First Chart. The [BKSP] key lets you erase the last character. 
You can use it to make corrections. If you press [BKSP] past the begin­
ning of data, you'll hear beeps from the computer. (The ~ key cannot be 
used to erase; the computer beeps if you try to use it to do so.) 

When the title is correct, press ~. The Typeface menu, shown in 
Figure 2-12, appears. You can display your title in normal, bold, or 
inverse video. Everything you have seen on the screen so far has been in 
the normal typeface. Move the cursor to Bold, and press ~. 
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Figure 2-12. Typeface Menu 

The title is centered at the top of the chart. Notice that the characters 
are in bold typeface; the other characters on the screen are in normal 
typeface. The title you just created should look like the one in 
Figure 2-13. 
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Figure 2-13. Top Title in Boldface 
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The title is centered above the chart. You can put the title at the left 
side by ending the title with an at sign (@). If your left adjusted title 
requires an at sign at the end, enter two (@ @), one for the title text and 
one for left justification. 

The length of the title depends on the location (left or centered) and 
the typeface. Table 2-1 lists the maximum title lengths. 

Table 2-1. Maximum Title Lengths 

Location Typeface Maximum 

Left Centered Bold Normal or Inverse Length 

X· X 73 
X X 58 

X X 77 
X X 64 

If you change your mind and want a different title, enter a new one. 
The new title replaces the old one. 

The Title menu lets you enter one, two, or three bottom titles. The bot­
tom titles occupy the first, second, and third lines in the legend area. A 
bottom title line erases the legend if there is a legend on the same line. 

Move the cursor to First, and press ~. The entry area appears again. 
Bottom titles have the same maximum lengths as the top title. Enter the 
title Disk Drive Sales. Press the ~ key and the Typeface menu appears. 
This time select the Normal typeface. Press the Esc key to see the bottom 
title. Press Esc again when you are ready to continue. Second and Third 
functions operate the same as First. They put titles on the second and 
third legend lines. 

Ending the bottom titles with the at sign (@) locates them to the left, the 
same as it did with the top title. 
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Next you are going to put a vertical title to the left of the Y-axis labels. 
Move the cursor to Side and press ~. The Side title can have a maximum 
length of 19 characters. Enter Units Per Outlet. Press ~. This time, 
select Inverse and press ~. 

The last item in the Title menu is Moveable. The Moveable function 
lets you enter a title and move it to any location in the chart. You can put 
as many titles as you want on the chart. 

Move the cursor to Moveable and press ~. 

Enter Plant Fire, and press ~. 

The title appears near the middle of the screen. You can move it to any 
location on the screen. 

Moving a Title 
The movement of a title is controlled with the +--, -, t, and J, keys. 

These keys move the title in the obvious direction: 

up 
t 

left +-- - right 
J, 

down 

Press the +-- key several times. You'll see the title move to the left; the 
title moves each time you press the key. Press the J, key to move the title 
down over the chart bars. Notice that it is white when over a black 
background and black when over a white background. 

Keep pressing the J, key to move the title all the way to the bottom of the 
screen. When it reaches the bottom, the computer clicks each time you 
press the key. 

With the number keys (1 through 9) you can change the distance the 
title moves each time you press an arrow key. The higher the number, the 
farther the title moves. If you do not increase the distance-per-move, it 
moves at the 2 rate. 

Press the 9, in the top row of keys, and then press an arrow key. You 
can move the title from border to border with fewer presses of the 
arrow key. 
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NOTE: The program configures the keyboard so that the number pad 
at the right is used for cursor movement, not number entry. To enter a 
number from this pad, you must first press the Num Lock key. You will 
have to press it a second time to regain use of the arrow keys. 

With a little practice, you will become adept at moving the title quickly 
to an area of the screen in big jumps, then fine-tuning the position at 
smaller jumps. 

Move thb Plant Fire title to the short bar for the year 1982. Center it 
across the bar about a quarter of an inch below the top. When it is in 
place, press ~. The Typeface menu appears as shown in Figure 2-14. 
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Figure 2-14. Typeface Menu 

The Typeface menu offers several choices. Bold displays the title in 
boldface; Inverse displays it in black letters on a white background; and 
Normal displays it in white letters against a black background. Cancel 
erases the title and returns you to the Title menu. Exit fixes the title in 
place, then returns you to the Title menu. 

Before canceling or fixing the title in place, you can switch between 
typefaces to see which is best. If the title extends over a light area and 
you select Bold and then return to a normal size type, the broadening of 
the title will leave a hole in the light area. There is no problem if the title 
is over a dark area of the screen. Once you select Exit, the title appears in 
the typeface specified, it will be fixed in place, and the Title menu 
reappears. 
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Select Normal and then Exit. The title is fixed in place. It is now a per­
manent part of the chart, and the Title menu returns to the screen. The 
display should look like Figure 2-15. 
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Figure 2-15. Example of Moveable Title in Place 

In this section you learned: 

• The ~, -, t, and ~ keys move a moveable title in the direction 
indicated by the arrow. 

• The number keys, 1 through 9, select the distance a title jumps each 
time the ~, -, i, and ~ keys are pressed. 

• After placing a moveable title on the chart, press ~ to display a 
Typeface menu. 

• The Exit option in the Typeface menu fbces a moveable title in place. 

Erasing Moveable Titles 
A moveable title can be erased before it's fixed in place. 

Select Moveable and enter Test!. Put the title anywhere and press ~. 
Select Cancel from the Typeface menu. The title vanishes, and the Title 
menu reappears. 
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After a title becomes fixed, it can still be erased, but by a 
different method. 

If the title is in or extends into any light area and you select Normal, 
Bold, or Inverse before selecting Cancel, a hole the size of the title 
remains in the light area. If this occurs you will have to start over to 
remove the hole. This situation does not occur if the title is in a dark area 
of the screen. 

Erasing Fixed Titles 
You can use the Text option from the Plot menu to erase fixed titles. The 

Text option is described in Lesson Five. 

Bringing Back the Legend 
The only other item in the Title menu is Legend. This option erases 

bottom title lines that cover legend lines and restores the original legend 
lines. Like bottom titles, there can be three legend lines. You covered the 
one-line legend with the First title; now, put the cursor on Legend and 
press -'. 

This option only erases those bottom title lines that covered legend 
lines. A bottom title line that did not cover a legend line is not erased by 
the Legend option. 

Press the Esc key to erase the status area. Your bottom title is gone, and 
the original legend is on the screen. 

The Legend fUllction works differently with pie charts. When you 
have a pie chart on the screen, the Legend function erases the pie chart 
legend. After you erase a pie chart legend, you must redraw the pie 
chart to restore the legend. 

Select Exit to return to the Plot menu. 

Moving and Changing Fixed Titles 
To be precise, fi;x:ed titles can't be moved or changed. They can, 

however, be erased, modified, and re-entered in the same location or in 
other locations. For example, to change My First Chart to DISK DRIVE 
SALES, enter the new title with the Top option. The new title replaces the 
old title. 

You can erase top, bottom, and side titles by replacing them with a 
blank title. When the program asks you to enter the title, press the space 
bar and the -' key. 
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The Range and the Scale 
The range of a chart is the time interval between the start date and the 

end date. It is plotted on the X-axis except for an XY or pie chart. The 
scale is the spread of values plotted along the Y-axis. The program deter­
mines the scale each time a series is plotted. It determines a reasonable 
scale that covers the values in the series. It also decides the number of 
divisions (tick marks) to display. 

In determining a scale, the program attempts to avoid divisions that 
result in fractional or non-round numbers. When possible, it chooses 
round numbers. For example, with a series of 0 through 700, the program 
tick-marks the Y-axis seven times and numbers them 0, 100,200, ... 700. 
It wouldn't choose eleven tick marks because that results in scale 
numbers of 0, 64, 127, 191, 255, and so on. 

When the Y-axis values are too large to be displayed, the 
VisiTrend/Plot program indicates the scaling factor at the top of the 
Y-axis as Thou (thousand) or Mill (million) in inverse video and truncates 
the labels. For example, with a scale of 0 through 30,000, the program 
generates numbers of 0, 10, 20, 30 and displays Thou as the factor. This 
tells you the numbers represent 0, 10,000 (10 x 1000), 20,000 (20 x 1000), 
and 30,000 (30 x 1000) respectively. Figure 2-16 shows a chart with a 
scale factor of thousands. 
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Figure 2-16. Example of Chart With Scale Factor 
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You can change both the range and the scale when you draw a chart. 
You might want to show only a subset of the range. You might want small 
variations to show up more or to show up less. The scale and range have 
significant impact on how a person perceives the information in a chart. 

How to Change the Scale 
This portion of the lesson uses a different chart. Go to the Select 

menu, specify a line chart, and select the series named Floppy Density. 

If you forgot, Select takes you back to the Select menu. Line specifies a 
line chart. Floppy Density is one of the series on the list. When the Plot 
menu returns, select Plot to display the line chart. Your screen should 
look like Figure 2-17. 
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Figure 2-17. Line Chart Before Changing the Scale 

Press Esc to bring back the status area after the chart is drawn. 
Select Options. 

Move the cursor to Rescale, and press ~. 

The prompts request limits for the plot scale. First you are asked for a 
Y-axis minimum. The current minimum is 20; change it to -200. Enter 
- 200, and press ~. Next you are asked for the Y-axis maximum. The 
maximum is currently 180; change it to 100. Enter 100, and press ~. 
Finally, you are prompted for the number of axis divisions. You can 
specify divisions (tick marks) from 2 to 12. 
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To determine the correct number of divisions, subtract the minimum 
scale value from the maximum value. A good number of divisions is any 
number in the range 2 through 12 that evenly divides into the difference. 
In the preceding example, 100 minus - 200 equals 300. 2, 3, 6, and 12 
give divisions of 150, 100, 50, and 25. Others, such as 4 and 5, will work 
but result in divisions of 75 and 60 which are not as common as chart 
units as 25, 50, and 100. 

The scale, - 200 to 100, divides nicely into 6 divisions. Enter 6, and 
press ~. 

The Plot menu returns, but nothing else happens. The scale did not 
change. 

You didn't do anything wrong. You must select Plot again to redraw the 
chart with the new scale. Press ~ with the cursor on Plot. A message 
appears in the status area telling you the data is off-scale and prompts 
you to choose one of two actions. This message means data points in the 
series are outside the scale you specified. This is a warning that the chart 
will not contain all the data points in the series. You have two choices: 
Proceed or Cancel. Proceed tells the program to continue and draws 
the chart with the off-scale data points. Cancel cancels the entire Plot 
request, leaves the current chart displayed, and redisplays the 
Plot menu. 

Select Proceed and press ~. For each data point that the program 
cannot put on the chart, it beeps. Two beeps sound while the program 
draws this chart. The last two points in the series do not fit within the 
scale. 

The off-scale data points are signaled this way for line, area, XY, and 
high-low-close charts. However, when you draw a bar chart that goes off 
the scale, the program draws a bar chart until it encounters the first data 
point that is off-scale, then it stops plotting. If you think about it, an off­
scale bar chart gives incorrect information. A person reading the chart 
does not know that certain bars continue beyond the top of the scale. Nor 
do they know that a missing bar is off-scale rather than O. It is better to 
rescale and try again than to show incorrect information. 

Press Esc to display the Plot menu. Move the cursor to Options and 
press ~. When the Options menu appears, select Rescale and press ~. 
For V-axis minimum, enter 0 and press ~. For V-axis maximum, enter 
750 and press ~. For the # axis divisions?, enter 10 and press ~. 

When the Plot menu returns, select Plot. This time your scale values 
are accepted and the chart is redrawn with a new Y-axis. 
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AUTOMATIC CORRECTING BY THE VISITREND/PLOT PROGRAM 

If you mistakenly enter a minimum scale valur.. that is greater than the 
maximum value, the program makes an assumption and continues. The 
program assumes that you reversed the values and switches them back. If 
you give the same value for the minimum and the maximum, the program 
uses 0 as the minimum and sets the maximum to twice this value. 

If you give a number of divisions less than 2 or greater than 12, the 
value won't be accepted. The computer beeps, and the status area waits 
for you to enter a value from··2 through 12. 

WELL-SCALED CHARTS 

The VisiTrendlPlot program tries to generate a well-scaled chart. 
There are times, however, when the values it chooses are not well-scaled. 
When this happens, you should consider rescaling the chart. 

When you select a scale, the program takes your request literally and 
does not try to change it. You will, at times, come up with odd-looking 
scales. This is especially true if you select Y-axis divisions that are not 
even divisors of the difference between the minimum and maximum scale. 
values. For example, if you set a scale from - 200 to 800 with 10 divi­
sions, the labels read - 200, -100, 0, 100 and so on. But if you pick a 
scale from - 212.39 to 643.22 with 9 divisions, the chart, while correct, is 
hard to read as you can see in Figure 2-18. 
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Figure 2-18. Example of Poorly Selected Scaling Divisions 
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How to Change the Range 
Start with program generated scale for the Floppy Density series. Go 

back to the Select menu, and select Line and the Floppy Density series or 
change the scale back to 20 to 180 with 8 divisions. If you need help with 
your choice, see either 'The Select Menu" or "How to Change 
the Scale." 

Now you should have a Floppy Density line chart on the screen that 
looks like Figure 2-19. 

012-026/P 

Figure 2-19. Example of a Well-scaled Chart 

Press Esc to redisplay the Plot menu. Move the cursor to Options, and 
press ~. 

Move the cursor to Range, and press ~. 

The program displays the Range menu shown in Figure 2-20. The top 
line lists the current range, 1973 to 1981. The menu offers three choices: 
Set, Clear, and Exit. 
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Figure 2-20. Range Menu 

Exit returns you to the Plot menu. 

The Set option lets you change the range. With the cursor on Set, 
press ~. The prompt asks for a start date. Enter 1974, and press ~. The 
program then prompts for an end date. Enter 1990 and press ~. The Plot 
menu returns and nothing happens to the chart. As with the Rescale op­
tion, you must select Plot to see the chart with the new range. Select Plot. 

You took a year off the beginning of the series but did not add nine 
years to the end. You can shorten a range but you cannot lengthen a 
range beyond the end of the series. 

If you change the range and take out data points, you might wish to 
change the scale. If you specify a range that does not coincide with any 
of the data points, you will get a bad-range message. A new range must 
overlap the range of the series by at least two points. You cannot com­
pletely exclude a selected series. 

When the program prompted for start and end dates, it did not ask for a 
period, only a year. If the period had been other than 1 (annual), the pro­
gram would have prompted for the year and the period. 
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Press Esc to redisplay the Plot menu, then select the Options menu 
again. Select the Range option. This time move the cursor to Clear and 

- press.J. When the Plot menu returns, Plot the chart again. This time it is 
drawn with the original range. The Clear function returns to the original 
range of the series. Clear does nothing if you have not changed the 
range. 

The Interplay Between Scale and Range 
When you change the range of a chart, the scale is automatically 

recalculated for the data points within the new range. However, if you 
explicitly change the scale with the Rescale option, before or after 
changing the range, the program does not recalculate the scale. 

Formatting a Chart 
You can modify line, bar, and XY charts with the Format option. 

Display the Plot menu (press Esc if the status area is not on the screen) 
and select New. New erases the existing chart and clears all options you 
have set. 

Now select Line and the Floppy Sales series. Plot it. 

Display the Plot menu and select Options. Move the cursor to Format, 
and press .J. The program displays the Format menu. The options are 
Symbols, Lines, Points, and Both. All the line charts you have drawn up 
to now used Both (symbols and lines). 

Move the cursor to Points, and press .J. Plot the chart again. It is 
redrawn without the plotting symbols - just the points to indicate the 
values. 

Use the other Format options by displaying the chart with Lines only 
and Symbols only. 

The Format option is valid only for line, bar, and XY charts. Symbols 
only, lines only, points only, or both symbols and lines are the Format 
options for line and XY charts. The bar chart options are solid bars, 
outlined bars, or shaded bars as shown in Figures 2-21, 2-22, and 2-23. 
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Figure 2-21. Solid-Bar Chart 
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Figure 2-22. Outlined-Bar Chart 
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Figure 2-23. Shaded-Bar Chart 

If you try to select the Format option with an area, pie, or high-Iow­
close chart, you will get an error message. 

Drawing Grid Lines 

Go to the Select menu by selecting New. Select Line, the Floppy Den­
sity series, and then Plot the chart. 

Press Esc and select Options. Move the cursor to Grid, and press ~. 
The program displays the Grid menu. You can draw horizontal, vertical, 
or both horizontal and vertical grid lines. With the cursor on Both, press 
~. The program draws grid lines for every tick mark that has a label. 
Your screen should now look like Figure 2-24. 
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Figure 2-24. Chart With Grid Lines 

Plot the series again. There is no need to go to the Select menu; press 
~ with the cursor on Plot. The program redraws the chart without the grid 
lines. Go to the Grid menu again and draw only the Horizontal grid 
lines. 

Go back to the Grid menu once more and again select Horizontal. The 
program erases the existing grid lines. This grid-line erasing feature 
operates on the horizontal and vertical grid lines. Note in Figure 2-25 
that only the grid lines are erased; the added border on the top and right 
are not erased. 
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Figure 2-25. Chart With Grid Lines Erased 

You do not have to erase grid lines in the same manner that you drew 
them. You can draw both horizontal and vertical grid lines, then erase 
only one set. You can later redraw an erased set of grid lines. 

A chart (other than a pie chart) must be displayed when choosing the 
Grid option. If you select the option when no chart is displayed, you get 
an error message. 

OTHER OPTIONS 

You now have enough experience to examine the remainder of the 
options. There are three you haven't used: Unlabel, Background, and 
Shade. 

The Unlabel option removes the X-axis and Y-axis labels. It must be 
used with a displayed chart. If you remove the labels with this option, you 
must replot the chart to get them back. 

The Background and Shade options let you change the background 
and plotting shades. They offer you a variety of visual enhancements. For 
a complete description of how you can enhance your charts with black, 
white, and the various shades of gray offered by the Shade option, see 
the Options menu explanation in Chapter Three (the Reference). 
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PRINTING THE CHART 

You can print a copy of the chart on a printer if you have a graphic 
printer that the Plot subprogram supports. (See Appendix B for a list of 
the supported graphic printers.) If a non-graphics printer is connected 
to your computer, skip this exercise, since you can only print listings 
and tables. 

The VisiTrend/Plot program is configured to print on an IBM 
80-Character-Per-Second Matrix Printer. If you have one of the other 
supported graphics printers, see Appendix B; it is a simple process to 
change the configuration to one of the other supported graphic printers. 

To print a copy of the chart from the screen to a printer move the cur­
sor to Print, and press ~. The program displays the Print menu. With the 
cursor on Print'f press ~. The program immediately prints the chart. 

The Print menu allows you to specify the printer driver and to specify 
what printer is connected to the computer. The Driver option lets you 
change the printer driver for the current session. The Device option lets 
you change the selected printer for this session. The Configuration 
option lets you change both the printer driver and current printer for the 
':!urrent session and all future sessions. Exit returns you to the Plot menu. 

NOTE: If you loaded the program with the printer turned off and the 
program cannot find the printer, select the printer with the Device 
option. This saves you from re-Ioading the program with the printer 
turned on. 

SAVING THE CHART ON DISK 

Once you have plotted a chart on the screen, you can save (store) the 
screen image in a disk file. This allows you to retrieve the chart later for 
viewing on the screen or printout. The Screen option lets you save and 
retrieve your charts. 

Move the cursor to Screen and press ~. The Screen menu gives you 
the options of loading, saving, changing the data drive, or returning to 
the Plot menu. 

At this point you can go ahead and save the chart on the current 
data disk. 

Move the cursor to Save, and press ~. If you have saved screens on 
the disk, their file names are displayed here, with [NEW FILE], and 
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[NONE] at the end. You are going to save the chart in a new file, so make 
sure the cursor is on [NEW FILE], and press ~. The [NONE] item lets you 
exit the list without saving a file. 

The status area asks for the file name. Enter SCREENl, and press ~. 
The VisiTrend/Plot program saves the displayed chart on the disk in a file 
named SCREENl.PIX. The program adds the suffix PIX to the name. You 
never have to enter it. 

When the screen image file has been saved on disk, the program 
displays the Plot menu. 

RETRIEVING A CHART FROM A SCREEN IMAGE FILE 

Select New to clear the screen. Then select None to return to the Plot 
menu. Finally, select Screen and then Load. 

The program displays a list of the screen image files stored on the disk 
appears. Each file name ends with .PIX. The last entry in the list is 
[NONE]. When there are more file names than can fit on one screen, the 
last entries in the list are [NONE] and [MORE]. When the last screenful 
appears the last entry in the list is [NONE]. 

With the cursor on SCREEN1.PIX, press ~. The program displays the 
chart you saved. This chart is identical to the original chart. The only 
way to tell that it is a screen image is with the Plot menu displayed. The 
Plot menu does not have a data series name or chart type in left side of 
the bottom status area line. 

The only Plot or Opt~ons menu options that you can use with the screen 
image are Select, New, Print, Text, Screen, and Exit. 

THE EXIT, TEXT, AND WINDOW OPTIONS 

You have used all the options in the Plot menu except Exit , Text, 
and Window. 

The Exit option lets you go to the Main subprogram, the Trend sub­
program, or return to the Plot subprogram. The data series in memory 
are not lost when you change subprograms. 

The Text option lets you create text-only screens and annotate charts. 
The text-only screens you create can be printed as well as displayed. The 
Text features for annotating charts allow you to place more information 
on the charts themselves. The use of the Text option is described in 
Lesson Five. 
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The Window option lets you two charts on the screen. The charts can 
be side by side or above and below each other. The use of the Window 
option is described in Lesson Five. 

The next lesson describes the use of the Main subprogram. Following 
that, Lesson Three covers the Edit functions, and Lesson Four covers the 
Trend subprogram. You will be introduced to more plotting features, and 
experiment with area, XY, and high-low-close charts in Lesson Five. 

SUMMARY 

In this lesson you've learned how to use most of the features of the Plot 
subprogram. At this point, you should know how to load the Plot sub­
program, how to plot a chart, and how to enhance a chart with titles, for­
mat options, and grid lines. You should be able to change scale and 
range, and store and retrieve a screen image. 

FUNCTIONAL SUMMARY 

To From Select/Enter 

Load a data file Main menu l. Load 
2. File name 
3. Return/Print 

Load the Plot Main menu l. Plot 
subprogram 

Draw a line chart Select menu l. Line 
2. Series name 
3. Plot 

He-display or erase Plot menu l. Esc 
the Plot menu 

Draw a bar chart Select menu l. Bar 
2. Full/Left/Both/Right 
3. Series name 
4. Plot 

Put fixed titles Plot menu l. Options 
on a chart 2. Title 

3. Top/First/Second/ 
Third/Side 

4. Title (end with @ _to left-
justify; correct with Esc) 

5. Normal/Bold/In verse 
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To 

Put a moveable 
title on a chart 

Erase a fixed title 

Erase a legend 

Restore original legend 

View the legend 

Change the scale 

Set a new range and 
redraw the chart 

Return to the original 
range and redraw the 
chart 

Erase all existing 
chart options 

USER'S 
GUIDE IBM PERSONAL COMPUTER 

TUTORIAL 

From Select/Enter 

Plot menu l. Options 
2. Title 
3. Moveable 
4. Desired title 
5. 1 through 9 (change jump 

increment) 
6. i,~, ~, ~ 

(position a moveable title) 
7. Normal/Bold, Inverse 
8. Exit 

Title menu l. Moveable 
2. .spaces. 
3. i,~, ~, ~ 

(position a moveable title) 
4. Normal/Bold/Inverse 
5. Exit 

Title menu l. First/Second/Third 
2. Spaces 

Title menu l. Legend 

Chart with l. Esc 
status area 

Options menu l. Rescale 
2. Y -axis minimum 
3. Y -axis maximum 
4. Number of intervals 
5. Plot 
6. If in scale: Plot 

If off-scale: Proceed/ 
Redraw 

Options menu l. Range 
2. Set 
3. Start of range 
4. End of range 
5. Plot 
6. Proceed 

Options menu l. Range 
2. Clear 
3. Plot 

Plot menu l. New 
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(Continued) 

To From Select/Enter 

Format a line or XY Options menu l. Format 
chart 2. Symbols/Lines/Points 

3. Plot 

Add grid lines Options menu l. Grid 
2. Horizontal/Vertical/Both 

Erase grid lines Options menu l. Grid 
2. Horizon tal/Vertical/Both 

Change the printer Plot menu l. Prin t driver 
2. Driver 
3. Printer name 
4. Y es/N 0 (au tolinefeed) 
5. Exit 

Print displayed chart Plot menu l. Print 
2. Print 

Specify printer Plot menu l. Print 
2. Device 
3. Name of default printer 
4. Exit 

Save displayed chart Plot menu l. Screen 
2. Save 
3. Existing/new file name 

Erase axis labels Options menu l. Unlabel 
2. Both/Horizontal/Vertical 

Change background Options menu l. Background 
shade 2. Shade 

3. Plot 

Restore original Options menu l. Background 
background shade 2. Original 

3. Plot 

Change plotting Options menu l. Shade 
shade 2. Shade 

3. Plot 

Restore original Options menu l. Shade 
plotting shade 2. Original 

3. Plot 
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LESSON TWO: MAINTAINING DATA 

This lesson describes the functions of the Main subprogram, except for 
the Edit functions which are described in Lesson Three. 

The Main subprogram is the first subprogram you encounter when you 
load the program. The Main subprogram lets you create, load, and save 
VisiTrend/Plot series data. It also lets you access DIFTM data from other 
VisiCorp products, such as the VisiCalc® program. (See Appendix D for 
DIF information.) 

In the last lesson, you briefly used some Main subprogram functions. 
In this lesson, you will use it more fully. 

GETTING TO THE MAIN MENU 

If the VisiTrend/Plot program is not loaded, load it according to the 
directions in "Loading the Program" in the Introduction, and go to the 
following section. 

If you are in the Plot subprogram from Lesson One, return to the Main 
subprogram. To get to the Main subprogram: 

• If no menu is displayed, press Esc; 

• If you are in the Plot menu, select Exit and Main. 

• If you are in the Select menu, select None, Exit, and Main. 

• If you are in the Options or Title menu, select Exit, Exit, and Main. 

THE MAIN MENU 

Each time you load the VisiTrend/Plot program, the Main menu, shown 
in Figure 2-26, appears at the top of the screen. (If you've gotten to the 
Main menu from the Plot or Trend subprogram, your screen is blank 
below the status area.) 
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Figure 2-26. Main Menu 

DISKS AND DISK DRIVES 

Data disks store data, and the program disks store the VisiTrend/Plot 
program. The program disks are always used in Drive A. Your data disks 
can be used in any disk drive attached to your computer. 

The bottom line of the Main menu identifies the current data disk 
drive, as shown in Figure 2-26. This is the drive that loads or saves data, 
and that has (or should have) the data disk. When both the program and 
data disks use Drive A, the program issues messages telling you when to 
change disks. 

The data drive name is A:, B:, C:, or D:. The Device option lets you 
change the data drive. 

Always check the drive name before selecting a function that uses the 
data disk and change it if necessary. If you try to load from a non-existent 
drive, empty drive, or drive with the door open, you get the error 
message: Can't access data diskette!. 

Never store data on the program disks. The VisiTrend/Plot example 
disk contains all of the sample data used in these lessons. It also has 
space for many more. You used the SAMPLEl file in Lesson One. 
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For the purposes of this lesson, make sure that the program disk is in 
Drive A and that the example disk is in Drive B. 

Changing the Data Drive 
Move the cursor to Device and press ~. 

Move the cursor to drive name you want as the data drive and press ~ 
again. The selected drive is the data drive until you change it again or 
until you exit the program. When you load the program, Drive B is 
always the data drive. 

Files and Series 
Data is stored on a data disk in files. This data can be a screen image, 

such as a chart, or it can be one more collections of data points. A file is 
nothing more than stored data that is identified by a file name. 

The VisiTrend/Plot program processes data series. A series is a collec­
tion of data points. A series has a name just like a file. Series are stored in 
files. Figure 2-27 shows the relationship between files, series, and disks. 

Diskette Files 

.~---"'Pl"-l 
Series 

Floppy Sales 

Floppy Density 

Quantity 

Revenue 

Units Shipped 

Expenses 

Market 

Figure 2-27. Relationship Between Files, Series, and Disks 
001·005 

A data series can be used only after the file in which it is stored is read 
into memory from the data disk. Reading the file does not erase it from 
the disk. When a file has been read into memory, the program processes 
the series individually. Files are used only for storage on disk. 

Often series with related data are used together. Store related series in 
a single file in the same way you would store related documents in a 
sing Ie file folder. 

The points to remember are: 

• Both files and series have names. 

• Files are units of storage on disks. The computer uses files for storing 
data. 
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• Series are units of data in files. The computer uses series for process­
ing data. 

File and Series Names 
File names can be a maximum of 8 characters in length. If the name 

contains a period, only the portion of the name following the period is 
used. If the name contains a space, the space is removed. For example: 

FILEA. X becomes X 

FILEA X becomes FILEAX 

The program appends a period and three letter suffix to file names. 
The suffix identifies the type of data in the file. The suffixes are: 

SER Data series stored in the normal VisiTrend/Plot format. 

DIF Data .series stored in the DIF format. 

PIX Screen image. 

When the program displays the file names it also adds a prefix identify­
ing the data drive. A data series file in the normal format on a disk that is 
in Drive B is displayed as: 

B: FILEA. SER 

Series names can be a maximum of 14 characters in length. The names 
can contain any characters including spaces and periods. No prefixes or 
suffixes are added to series names. 

LOADING VISITREND/PLOT DATA 

There are two ways to get series data into the computer: create it with 
the Edit option (described in Lesson Three) or load it from disk with the 
Load. 

After you load the VisiTrend/Plot program and the Main menu 
appears, the cursor points to the Load option. The long prompt tells you 
that this option loads data from the data disk. 

With the cursor on Load, press -I. 

A list of file names appears under the status area as shown in Figure 
2-28. The cursor is no longer in the status area; it is pointing to the top 
name on the list. 
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Figure 2-28. List of Files for Loading 

You load a file by moving the cursor to the file name and pressing ~. 
The i and ~ keys move the cursor up and down the list. Selecting [NONE] 
returns you to the Main menu without loading a file. If the whole list of 
files does not fit on the screen, the last itemd are [NONE] and [MORE]. 
Selecting [MORE] displays the next portion of the list. You are at the end 
of the list when the last item is [NONE]. 

Move the cursor to B:SAMPLE1 ,SER, and press ~. 

The program loads the SAMPLEl.SER file and displays a list of the 
series in the file, as shown in Figure 2-29. 
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Figure 2-29. List of Series in Loaded File 

You can select Exit, which returns you directly to the Main menu, or 
Print, which prints the list, and then returns you to the Main menu. Select 
Exit. 

You can load more series into memory by repeating the load option. 

There are two limiting factors on the number of files you can load: 16 
data series or 2000 data points. You can load any number of files (up to 
16) as long the total number of series does not exceed 16 and the total 
number of data points does not exceed 2000. 

When either limit is reached, a message that there is no more room 
appears on the screen. 

DISPLAYING THE SERIES IN MEMORY 

Move the cursor to Display, and press ~. 

The list shows the names of the series, the period of the data (the fre­
quency of data points per year), the start date, the end date, and the 
number of points in the series. 
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Following the list is the name of the last file you loaded and the total 
number of series and data points along with the maximums for each. 
With some simple arithmetic you can determine how may more series or 
data points you can load. 

Select Exit to return -to the Main menu. 

FORMATTING A DATA DISK 

Disks must be formatted before they can be used for data storage with 
the VisiTrend/Plot program. A data disk is any disk that is formatted by 
the VisiTrend/Plot Format function or the IBM DOS Format command. 
The example disk you are using is formatted. 

Do not format the program or example disks. Formatting erases the 
data on the disk. 

You should have a new, blank disk or a used disk that does not contain 
any useful data. Put that blank disk into the data disk drive, now. 

Move the cursor to Files and press ~. With the cursor on Format, 
press ~. 

The prompt reminds you that you have selected to format a data disk. 
Below the prompt is a message that gives you the choice of canceling the 
Format option by pressing the Esc key or proceeding by pressing any 
other key, such as ~. Press ~. 

The Format function destroys all the data on a used disk. When the 
Format function is complete, you are returned to the Main menu. The 
disk can now be used for storing series data and screen images. 

Remove the newly formatted disk from the drive and replace the 
example disk. 

SAVING DATA 

Now that you know how to format a data disk, you have to know how to 
write data onto it. 

The Save function writes data in computer memory onto the current 
data disk. This is the only way to save data between VisiTrend/Plot ses­
sions. If you turn the computer off or load a different program, you will 
lose the data in computer memory. 

Move the cursor to Save, and press ~. 
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The Storage Format menu, shown in Figure 2-30, gives you the option 
of storing data in the normal VisiTrend/Plot or the DIF format. If the data 
is to be used only with the VisiTrend/Plot program, save it with the 
Normal option. The DIF option stores data in a format that can be used by 
other VisiCorp programs, such as the VisiCalc program. 

012·037/P 

Figure 2-30. Storage Format Menu 

With the cursor on Normal, press ~ again. 

Below the status area, the program displays a list of the data series in 
memory as shown in Figure 2-31. At the bottom of the list are the items 
[NONE] and [ALL]. 
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Figure 2-31. List of Series for Saving 

You can now: 

• cancel the Save operation by moving the cursor to [NON E] and 
pressing ~. 

• save all the data series in a single file by moving the cursor to [ALL] 
and pressing ~. 

• save a single series by moving the cursor to the name and pressing ~. 

• save selected series in a single file by moving the cursor to the name 
and pressing the space bar. When you press the space bar, an 
asterisk (*) appears next to the series name. The asterisk means the 
series is selected to be saved when ~ is pressed. The series to which 
the cursor points is also saved when you press ~ even if it is not 
marked. You can unselect a selected-series by moving the cursor 
back to it and pressing the space bar again. 

If the cursor is on [ALL] or [NONE], this option is used regardless of the 
n umber of asterisks in the list. 

Move the cursor to [ALL] and press ~. The directory of the files cur­
rently on the disk is listed under the status area. It is the same list you saw 
when you loaded the file. But there is a slight difference: there is now an 
entry called [NEW FILE] in this list. 
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You must select the file in which the selected series are to be saved, 
but you must be careful. If you select an existing file, you store the 
selected series in it, but you destroy all the data previously stored in the 
file. You must be careful not to erase any data you want to keep. For 
example, if you load a file that contains series 1, 2, and 3, then save only 
series 2 in the same file, the file will contain only series 2. 

It is good practice to save all data in new files. If after a period of time 
you find you don't need the old data, you can erase the old file with the 
Delete function which is described later in this lesson. 

Also remember that all selected series are saved in the same file 
regardless of which file they were loaded from. 

Move the cursor to [NEW FILE], and press ~. 

When you choose to create a new file, the program prompts for a file 
name. Type samplel, then press .J, and see what happens. An error 
message appears saying this file already exists; the Save operation is 
canceled. When saving series in a new file, you must use a file name dif­
ferent from all others on the data disk. 

Press Esc to erase the error message and go back to the Main menu. 

Remember to check the data disk drive assignment before beginning a 
Save. The data disk drive name cannot be changed during the opera­
tion. If you need to change the drive name but forgot to, cancel the Save 
function. 

You can cancel a Save operation by selecting [NONE] from either the 
series name list or the file name list. 

If you try to save data on a write-protected disk, you will get an error 
message a:nd the Save operation will be canceled. 

CLEARING SERIES FROM MEMORY 

When you save data ona disk, the copy of the data in memory is not 
erased. After you have saved new and modified series on disk, you might 
want to clear them from memory to make room for new data you want to 
load. The Clear function erases some or all of the series from memory. 

Move the cursor to Clear, and press .J. 
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You can now: 

• cancel the Clear operation by moving the cursor to [KEEP ALL] and 
pressing ~. 

• clear all the data series from memory by moving the cursor to [KEEP 
NONE] and pressing ~. 

• clear a single series from memory by moving the cursor to the name 
and pressing ~. 

• clear selected series from memory by moving the cursor to the name 
and pressing the space bar. When you press the space bar, an 
asterisk (*) appears next to the series name. The asterisk means the 
series is selected to be cleared when ~ is pressed. The series to which 
the cursor points is also cleared when you press ~ even if it is not 
marked. You can unselect a selected-series by moving the cursor 
back to it and pressing the space bar again. 

You are going to clear the series Floppy Sales from memory. 
Remember, this doesn't affect the copy of the series that is on disk. Move 
the cursor to Floppy Sales, and press ~. 

After you press ~, the program displays an updated list of the series in 
memory and gives you the choice 6f printing out the list of series or 
returning to the Main menu. Press ~ with the cursor on Exit. 

MOVING BETWEEN SUBPROGRAMS 

When you are done loading and editing data, you normally want to go 
to either the Plot or the Trend subprogram. The Plot option loads the Plot 
subprogram. The Trend option loads the Trend subprogram. 

You loaded the Plot subprogram in the Lesson One. In this lesson you 
will load the Trend subprogram. 

Move the cursor to Trend, and press ~. 

Unlike the Plot subprogram, you can load the Trend subprogram 
without first loading or creating data series. The Trend subprogram con­
tains the same edit functions as the Main subprogram; therefore, you can 
create data series iIi the Trend subprogram. 

When the Trend subprogram is loaded, the Trend menu is displayed. 
Move the cursor to Main, and press ~. Now the direction is reversed: you 
leave the Trend subprogram and return to the Main subprogram. The 
Main menu is again displayed. 
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When the Trend menu is displayed, you can also go directly to the Plot 
subprogram. Just move the cursor to Plot, and press ~. The Plot 
subprogram will display the Select menu. 

To go to the Trend subprogram from the Plot subprogram, start with 
the Plot menu displayed. Then select Exit and Trend. When the Trend 
menu appears, the Trend subprogram will be loaded. 

When you load the Plot or Trend subprograms, you usually have one 
or more series in memory. (When going to Plot, you must have data in 
memory.) The data in memory is preserved when you change sub­
programs. 

To see for yourself that the data is kept, move the cursor to Display and 
press ~. Look at the list and remember what is on it. Now load the Plot 
subprogram and select any chart type from the Select menu. Compare 
the list of series with the list from the Display function. They are iden­
tical. No data was lost in the transition. 

Now go to the Trend subprogram. Select the Display option and you 
will find that the list has not changed. The data remains no matter which 
program you load. 

Select Main and return to the Main subprogram. 

DELETING FILES FROM THE DATA DISK 

You should delete files from your data disk from time to time to make 
space for new files and get rid of out-dated files. For this part of the 
lesson, remove the example disk and insert the disk you formatted with 
the Format function. 

Save whatever series are currently in memory on the disk under the 
name FILEA. 

The Delete function erases one file from your data disks. This function 
is part of the Files option. Move the cursor to Files and press ~. Then 
move it to Delete, and press ~ again. 

The file name is displayed below the status area. Move the cursor to the 
file name and press ~. Because this function permanently erases files, 
you are asked to verify that you do, in fact, want to erase a file. You must 
press the Y key to continue the Delete function. If you press any other 
key, the function is canceled. Press the Y key. 

If the data disk has a write-protect tab on it, the file is not deleted. 
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You can verify that the file is deleted from the disk by selecting the 
Delete option again. The name FILE A is not in the list. Do not delete any 
other files from this disk. Move the cursor to [NONE] and press ~. 

EXITING THE VISITREND/PLOT PROGRAM 
There is one remaining option in the Main menu, Quit. This option 

exits the VisiTrend/Plot program and puts you into the IBM DOS environ­
ment. The program tells you to insert a DOS disk in Drive A. Put Disk #1 
into Drive A and press ~. The A> prompt is displayed. The 
VisiTrend/Plot program is cleared from memory. To reload the 
VisiTrend/Plot program press the Ctrl, Alt, and Del keys simultaneously. 

USING VISICALC DATA IN THE VISITREND/PLOT 
PROGRAM 

This section describes how to move data from the VisiCalc program 
(Version 177 or later) to the VisiTrend/Plot program. If you do not use 
both of these products or have no need to transfer data, you can skip this 
section and go to the summary at the end of Lesson Two. 

You can load and plot VisiCalc data with the VisiTrend/Plot facilities. 
The VisiCalc data must be saved in a DIF file. 

You must use the IS# command to save the VisiCalc data in the DIF for­
mat. The stored data should be a sequence of data values that are mean­
ingful to plot. When you enter data in a VisiCalc worksheet, do not 
mix periodicities. 

You can store the VisiCalc data in rows or columns. A single file can 
contain up to 16 rows or columns. Each row or column is treated as a data 
series. When a row is used, the first field in the row becomes the data 
series name if it is a label. When a column is used, the first field in the 
column becomes the data series name if it is a label. If the first field is not 
a label, the VisiTrend/Plot program supplies a name for each series in 
the sequence: SERIESl, SERIES2, etc. 

Data from the VisiCalc program, while in a format acceptable to the 
VisiTrend/Plot program, does not contain all the information the Main 
subprogram expects. It does not contain a period or a start date. When 
you load VisiCalc data, you are prompted for these missing items for 
each series. 

The following exercise takes two data series, Utilities and Telephone, 
from a VisiCalc worksheet, stores it as a DIF file, then loads it into the 
VisiTrend/Plot program as a data series. The steps in this exercise are 
summarized in Figure 2-32. 
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Figure 2-32. Using VisiCalc Data for Plotting 

The VisiCalc worksheet to be used is from the personal budget 
example in Lesson Four of the VisiCalc manual. If you did the exercise in 
that lesson, you can store a portion of it on a VisiTrend/Plot data disk as a 
DIF file. Follow these instructions to create a DIF file from two rows of 
data in the VisiCalc worksheet: 

1. Load the VisiCalc program;then load the VisiCalc file containing the 
worksheet created in VisiQalc Lesson Three. The screen with the 
worksheet on it should look like Figure 2-33. 
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Figure 2-33. VisiCalc Worksheet 

2. Move the cursor to the Utilities label. The cursor location marks the 
upper-left corner of the rectangle of data to be saved. The lower-right 
corner is specified . later . 

3. Enter /S# to save the data in the DIF format. 

4. Enter S (SAVE). 

5. Enter the name UTIL.DIF. You must add the suffix .DIF to the file 
name. 

6. Specify the lower-right corner M7. 

7. Enter R to save the data in rows. 

Load the VisiTrend/Plot program. Select Load function and load the 
file named UTIL, DIF. Move the cursor to this file name, and press ~. 

The loading of the file begins. When the file has been loaded, the drive 
stops and the program prompts for a period for the first data series. Enter 
12 because the data in this file is on a monthly basis. Next you are 
prompted for a major start date (year). Enter 1980. Finally, you are 
prompted for a minor start date (period). Enter 1 for January. The pro­
gram then asks for the same information for the second data series. Enter 
the same values as you did for the first series. 

The program displays the list of series in memory. The B:UTIL.DIF file 
contains two data series named Utilities and Telephone. The series names 
are taken from the label in the first cell in the VisiCalc row. 
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You can go to the Plot subprogram and create a chart of these data 
series from your VisiCalc worksheet. If you've followed all the steps in 
this lesson so far, you can create a line chart using the Utilities data 
series that looks like Figure 2-34. 

012-040/P 

Figure 2-34. Chart Plotted from VisiCalc Data 

You can also modify the data with the VisiTrend/Plot Edit or Trend 
functions (described in Lesson Three and Lesson Four). After modifying 
the data you can return to the VisiCalc program and put the data back 
into the worksheet. 

USING VISITREND/PLOT DATA IN THE VISICALC 
PROGRAM 

The following steps show you how to take a data series from the 
VisiTrend/Plot program and use it to build a VisiCalc worksheet. These 
steps are summarized in Figure 2-35. 
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Figure 2-35. Using Data Series in the VisiCalc Program 

Data saved in the DIF format does not contain the formulas, if any, 
from the worksheet. If the data series contains more than 63 data points, 
you must load it into a VisiCalc spreadsheet by columns. 

1. Clear memory and Load the SAMPLE1.SER file from the example 
disk. Then Save both series in the DIF format under the name 
SAMPLEID. The program adds .DIF to the name. 

2. Load the VisiCalc program. 

3. Load the SAMPLEID.DIF file into the VisiCalc program from the 
VisiTrend/Plot data disk with the /8#L. 

4. The data series in the SAMPLEID.DIF file appear as two rows of 
values in the VisiCalc worksheet. Your screen should look like 
Figure 2-36. 

2-50 



IBM PERSONAL COMPUTER VISITRENDIPLOT™ ~~f~~s 
TUTORIAL LESSON TWO 

005-016/P 

Figure 2-36. Data Series Loaded in VisiCalc Worksheet 

You can add data to this VisiCalc worksheet using additional DIF files 
that contain data series created in the VisiTrend/Plot program. 

Notice that the VisiTrend/Plot series names do not become labels when 
transferred into the VisiCalc worksheet. You must add labels. 

It is important to remember that the IS# command does not load or save 
VisiCalc formulas, only data values. 

If you wish to create your own DIF programs for use with the 
VisiTrend/VisiPlot program, you will find the information in Appendices 
C and D helpful. For complete details on DIF, see the Programmers 
Guide to the Data Interchange Format, document number SATN-18, 
which is available from the DIF CI~aringhouse, P.O. Box 527, Cam­
bridge, MA 02139. 

SUMMARY 

This completes the Main subprogram functions except for Edit which is 
described in Lesson Three. You have used all the other Main subprogram 
functions. You might want to go back to the Load function and look at 
some of the other files on the program disk. 
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If you have any trouble with a function, look it up in Chapter Three 
(the Reference) or this lesson. 

FUNCTIONAL SUMMARY 

To From Select/Enter 

Load data files without Main menu l. Load 
printing series 2. File name 
information 3. Exit 

Load data files and Main menu l. Load 
print series information 2. File name 

3. Print 

List series in memory Main menu l. Display 
2. Exit/Print 

Change data disk name Main menu l. Device 
2. Desired name. 

Save one series in Main menu l. Save 
a file 2. Normal/DIF 

3. Series name 
4. File name/[NEW FILE] then 

file name 

Save all series in Main menu l. Save 
a file 2. Normal/DIF 

3. [ALL] 
4. File name/[NEW FILE] then 

file name 

Save several series in Main menu l. Save 
a file 2. Normal/DIF 

3. Each series name except 
last ... Last series name 

4. File name 

Format a floppy data Main menu l. Files 
disk 2. Format 

3. Put unformatted disk 
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(Continued) 

To From Select/Enter 

Delete data files Main menu l. Files 
from disk 2. Delete 

3. File name 
4. Y to proceed 

Clear all series Main menu l. Clear 
2. [KEEP NONE] 

Clear one series Main menu l. Clear 
2. Series name 

Clear several series Main menu 1. Clear 
2. Series and press space bar 
3. Last series and press ~ 

Enter Trend Main menu 1. Trend 
subprogram 

Return to Main Trend menu 1. Main 
subprogram 

Enter IBM DOS Main menu 1. Quit 
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LESSON THREE: THE EDIT FUNCTION 

The purposes of the VisiTrend/Plot Edit function are to: 

• Create new data series. 

• Modify existing data series. 

Identical Edit functions are available in the Main and Trend sub­
programs. This lesson uses the Edit function in the Main subprogram. 

Load the VisiTrend/Plot program or return to Main subprogram if you 
are in the Plot or Trend subprogram. You do not have to load a file; in 
this lesson you will create a new data series. If you have data series in 
memory, you can leave them there. However, if memory is full, that is, if 
it has 16 series in it or 2000 data points, clear some of the series before 
continuing with this lesson. 

Move the cursor to Edit and press ~. 

USING EDIT 

After selecting the Edit function, you must enter a name for a new 
series or select an existing series from the displayed list. You did not 
have data in memory only [NONE] and [New series] are in the list as 
shown in Figure 2-37. 

012-041/P 

Figure 2-37. Series List for Editing 
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[NONE] returns you to the Main menu. 

In this lesson you will enter data for a series called First. Move the cur­
sor to [New Series], and press ~. The status area changes to the data­
entry format and prompts for a series name. 

Type First then press ~. Remember, you can correct. typing mistakes 
with the BKSP key. The BKSP key erases the last character typed. 

Next enter the period of the new series. The prompt shows the default 
period the program will use if just press the ~ key. If you have not 
entered a different period in this session, the default period is 1. The 
default period is 1 or the last period you entered during this session. 

Type 1 and press ~. 

Next enter the start date of the new series. The program asks for a year. 
If the period is other than I, you are prompted for the start year and 
period. A series can begin at any period in its start year. If you do not 
enter a date and only press ~,the date 0 is used. 

Enter 1966 and press ~. 

Finally, the program asks for the first value in the new series. The bot­
tom line of the status area contains Dote and First, as column headers. 
The cursor is in the column headed by the series name. 

The value for 1966 is 23. Type 23. The value appears in the third line of 
the status area until ~ is pressed. You can correct it with the BKSP key. 
When it is correct, press ~. The value appears under First. The start date 
is in the Dote column. The display for creating a new data series is shown 
in Figure 2-38. 
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Figure 2-38. Creating a Series 

The status area now reminds you that pressing Esc displays the Edit 
commands. This completes the initial sequence for entering a new series. 
If you had selected an existing series, you would have come immediately 
to this point in the program. The only difference is that a series, or the 
first 20 data points of the series, would be displayed on the screen. 

Adding Values to the Series 
To add a value for the year 1967, press the ~ key. The date 1967 

appears under 1966, and the cursor moves down one line. Type 28. 
Again the value appears on the third line of the status area. Press ~, and 
the value appears opposite 1967. 

Gaps are not allowed in the date sequence. The program automatically 
adds 1 to the date for each new entry. If the period is 1, the year is 
incremented by 1. If the period is other than 1, the period is incremented 
and the year is incremented when the period goes full cycle. 

To add the next few values, repeat the preceding process: press the ~ 
key, enter the value, and press ~. Enter the values 33, 37 and 41. Note 
that a solid bar separating the dates from the values appears after you 
make a couple of entries. 

There is a shortcut for entering new data. Press the ~ key again to show 
the date 1971, type 44, but do not press ~. Instead, press the t key again. 
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The value 44 enters the correct place, and the cursor moves down a line 
to the next date. 

Add the remaining values in this manner. Press the ~ key and enter the 
values 44, 53, 61, 75, 64, 73, 82, and 79. 

After entering the last value, the cursor is below the list with the date 
1980. We don't have a value for 1980, so press i. The cursor moves up to 
the 1979 value, and the 1980 date disappears. 

Replacing a Value 
You can replace a value by moving the cursor to the old value and 

entering the new value. The new value replaces the old value when you 
press the ~ or ~ key. 

With the i key, move the cursor to the entry for 1969 which is 37. This 
value should have been 39.9. Type 39.9, and press ~. 37 is replaced with 
39.9. 

THE EDITOR COMMANDS 

You have been entered data and done simple modification with the 
Edit function; you can do more with the Edit commands. To go to the Edit 
Command menu, press the Esc key. The program displays the Edit menu 
as shown in Figure 2-39. 

012·043/P 

Figure 2-39. Edit Command Menu 
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With the Edit Command menu you can: 

• Jump to a specific year (and period) within the series. 

• Insert new data 'points between data points. 

• Delete data points. 

• Change the specifications (Specs) of a series. 

• Format the manner in which data is displayed. 

• Print the contents of a series. 

• Undo (erase) all changes made to a series. 

• Return to the entry level (Edit). 
• Fill areas of a series with values generated by predefined algorithms. 

• Exit to the Main menu, and save the work you have done. 

Exit: Leaving the Edit Function 
Move the cursor to Exit and press ~. This option returns to the Main 

menu. When you exit route, the work you created or modified is kept in 
memory. 

Returning to the Edit Function 
Select Edit again. This time select the file named First, the one you just 

created. You are at the entry level of the Edit function. This time you 
don't have to enter a name, period, or starting date. The contents of the 
series are displayed. The status area contains the message about using 
the Esc key. 

Jump: Moving from Point to Point 
The Jump command lets you move from date to date in the series 

without repeatedly pressing an arrow key. Press Esc. The cursor is on 
Jump when you enter the Edit Command menu. Press ~ 

You can move by pressing the i or t keys or by typing the year. 

Pressing the t key moves the cursor to the last entry in the series. The i 
key moves the cursor to the first entry in the series. After the jump, you 
are returned to the Edit entry level. 

If you enter a year, the cursor moves to that year. If the series has a 
period other than 1, you are prompted for the period also. If the specified 
year is displayed, the cursor simply jumps to it. If the year is on a screen 
other than the first screen of the series, the first screen is erased and the 
date appears at the bottom or top of a new screen (depending on the 
direction you are moving in the series). The cursor is on the value for the 
specified date. 
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If the date does not exist in the series, the program beeps and the date 
is not accepted. At this point, you should enter a valid date. 

Press ~ to jump to the end of the series. 

You can return to the Edit menu without making a jump by pressing the 
Esc key. 

Insert: Adding an Entry 
The Insert command lets you add a value at the current cursor location 

in the series. Insertion with this command works like adding a value 
except that it operates anywhere in the series, not just at the end. The 
command inserts new data at the cursor location. All values at and below 
the cursor are pushed ahead to the next date. You can insert any number 
of lines as long as the series does not exceed the 250 data point max­
imum. 

Move the cursor to value for the year 1969: 39.9. Press Esc. Select 
Insert. Type 35 and press .J. 35 becomes the value for 1969 and all follow­
ing values move up one year. 

Pressing the .J key inserts a single value. If you have more than one 
value to insert, type the new data and press the ~ key. Press .J after the 
last entry. You can correct errors with the BKSP key before pressing the 
.J key or the ~ key. Pressing the .J key returns you to the entry level. 

Delete: Erasing a Data Point 
The Delete command erases one or more values beginning with the 

cursor location. The range to be deleted is listed in the status area. You 
can cancel the Delete command by pressing the Esc key. 

Move the cursor to the new value for the year 1969: 35. Press Esc. 
Select Delete. The status area shows the range to be deleted: 1969 to 
1969. Move the cursor up and down and watch the range change. 
Return the cursor to the 1969 value and press .J. The 35 is erased and the 
following values move back to their original positions. 

You can Delete in either direction from the original cursor position. 
However, the initial cursor position will always be the beginning or end 
of the range to be erased. 

Pressing .J when you have defined the correct range removes the 
selected values from the series. The values below the removed area move 
up to fill the new empty dates. You return to the entry level. 
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Specs: Changing the Series Specifications 
The Specs command lets you change the name, period, or start date of 

the series. This command displays the Specification menu which is 
shown in Figure 2-40. 

012·044IP 

Figure 2-40. Specification Menu 

When you change a series specification, the change takes place 
immediately on the screen. A new series name replaces the old name 
when you press ~. A new period or starting date changes the date and/or 
period on the screen. The data points do not change, only their date 
and/or period. 

Press Esc. Select Specs. Move the cursor to Periodicity and press ~. 
Type 2 and press ~. The dates change from 1966 through 1979 to 1966 
through 1972 with 2 periods per year. 

You can press the ~ key without entering data. When you do this, the 
program assumes values. For Nome, it generates the name SERIESn, 
where n is a number from 0 through 99. For Periodicity, it uses 
the default period. For Stort, it uses the date 0 and, if applicable, the 
period 1. 

You can return to the edit entry display without changing a specifica­
tion by selecting Exit. 
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Format: Changing the Data Display 
The Format command lets you specify how the series data is displayed. 

You can select fixed-decimal format and specify the number of digits to 
the right of the decimal point (0 to 6) and column width (6 to 16). Or you 
can select the floating-decimal format and specify the column width. 

The command first prompts for a number of decimal places (0 to 6) or 
the floating-decimal format (-1). Pressing ~ retains the current format 
and precision. Next, it asks for the column width. Pressing ~ retains the 
current column width. 

In the floating point format the numbers limited to 7 digits of precision, 
if possible. The displayed number are accurate up to 7 digits. In the fixed 
format, the data is displayed as you request. This can result in the display 
of numbers far beyond the program's internal storage precision. 

If the program displays a series of greater than symbols 
(»»»): 

• The value is too large for the column width. If this is the case, 
increase the column width. 

• You are in the fixed format and the number can only be displayed in 
the floating format. Table 2-2 shows how different values are 
displayed in the two formats. 

Table 2-2. Numeric Display Format Ranges 

Value Floating Format Fixed Format 

X < .000001 in exponential »»»» 
format 

.000001 < X in exponential as entered 
< .001 format 

.001 < X < as entered as entered 
10000000 

X > 10000000 in exponential »»»»> 
format 

If you do not choose a display format, the current format is used. 

Press Esc. Select Format. Type I and ~ for the fixed-decimal format 
with one decimal place. Type 10 and ~ for a column width of 10. 

The Format command does not affect how the values are stored, only 
how they are displayed. The format remains in effect until changed or 
until you exit the Edit function. 
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Print: Listing a Series 
The Print command lets you print the displayed series in its entirety on 

your printer. 

When Print is selected, the displayed series is printed without the bold 
bars, and without any blank lines at the bottom of the screen. 

If you have a printer, press Esc and select Print. 

After the displayed series is printed, you are returned to the 
entry level. 

Undo: Remove All Changes 
The Undo command cancels all the changes, except Format, made to 

the series since you selected the Edit function. If you Undo a newly 
created series, it is completely erased. 

Press Esc and select Undo. The series is returned to its condition when 
you last selected it for edit. 

Keep in mind that the Undo command removes all changes made since 
selecting the series, not just the last change. 

Edi t: Returning to the Entry Level 
The Ed it command takes you back to the entry level of the Ed it function 

without executing any of the Edit commands. 

Press Esc and then select Ed it . 

Fill: Adding to a Series 
The Fill command inserts values into the middle of a series and inter­

polates missing values. You can insert values in an arithmetic or 
geometric progression beginning with the value at the current cursor 
location. You can also select a whole series and insert it into the series 
being edited. You can fill in missing values in a series, interpolating 
between two known values. 

The Fill command displays its own menu, shown in Figure 2-41. 
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Figure 2-41. Fill Command Menu 

The Arithmetic and Geometric functions operate in a like manner. 
They prompt for a number of values to be inserted. The number can be 
any value that, when added to the existing points in the series, does not 
exceed the maximum of 250 points in a series or 2000 points in memory. 
Next the function prompts for a factor to be used in the calculation of the 
new values. In the Arithmetic function, the next data point is computed 
by adding the factor to the previous data point. In the Geometric func­
tion, the next data point is computed by multiplying the previous data 
point by the factor. 

The Series function displays the current list of series in memory. You 
can select a series to insert, in its entirety I into the current series at the 
cursor location. If you insert a series into itself, the inserted values are 
those that existed before entering the Edit function. 

The Interpolate function performs a linear interpolation of values 
beginning at the current cursor location and continuing to the first non­
zero value. Point the cursor to the first zero value in the sequence before 
invoking the function. This function fills in missing data values for zero 
values in the data series. Interpolation ends with the first non-zero value. 

If the value at the cursor is not zero, the command is canceled. If the 
value is zero, the function looks at the preceding period for a starting 
point and the next non-zero for an ending value. It then linearly inter­
polates all points in between. 

The Exit option returns to the Edit entry level without performing a Fill 
command. 
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With the cursor on the 1966 value, press Esc. Select Fill and then select 
Geometric. Type 5 and ~ to add 5 new data points. Type 2 and ~ as the 
geometric progression factor. The program adds 5 points beginning with 
year 1967. Each new data point is double the previous point. 

FUNCTIONAL SUMMARY 

To From Select/Enter 

Enter Edit function Main Menu l. Edit 

Create a data series List of l. [New Series] 
series 2. Series name 

3. 1 through 12 for period-
icity 

4. Starting year or reference 
point 

5. Desired values 
6. Exit 
7. Save 
8. Normal/DIF 
9. New series name 
10. Existing file name/ [NEW 

FILE] then new file name 

Edit a data series List of l. Series name 
series 

Add a value Series l. DA beyond last vaue 
2. New value 

Go to the beginning Series l. Esc 
or end of a series 2. Jump 

3. t, i 

Go to a specific point Series l. Esc 
2. Jump 
3. Reference point 

Change a value Existing val. l. New value 

Insert a new value Preceding l. Esc 
value 2. Insert 

3. New value 

Delete one, value Value to l. Esc 
delete 2. Delete 

3. ~ 
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(Continued) 

To From Select/Enter 

Delete several values Series l. First value to be deleted 
2. Delete 
3. Last value to be deleted 

Set fixed point Series l. Esc 
2. Format 
3. Number of places (0-6) 
4. Column width (0-16) 

Set floating point Series l. Esc 
2. Format 
3. -1 
4. Column width (0-16) 
5. Esc 
6. Exit 

Change column width Series l. Esc 
2. Format 
3. ~ 
4. Column width (0-16) 

Add to/multiply Value l. Esc 
previous value 2. Fill 

3. Arithmetic/ Geometric 
4. Number of values 
5. Factor 

Copy values from Value l. Esc 
another series 2. Fill 

3. Series 
4. Series name 

Perform linear Series l. Esc 
interpolation 2. Interpolate 

3. Value 

Change name/period Series l. Esc 
2. Specs 
3. Name/Periodicity 
4. New name/0-99 

Change start of range Series l. Esc 
2. Specs 
3. Start 
4. Year and period 

Erase all changes Series l. Esc 
2. Undo 

Print series Series l. ~ 
2. Print 
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LESSON FOUR: THE TREND 
SUBPROGRAM 

TUTORIAL 

You need some familiarity with statistics to completely understand the 
Trend subprogram functions. However, you need no special background 
to use the program. 

The Trend subprogram analyzes data series and develops trend 
forecasts. It uses the following techniques: 

• Moving averages, smoothed data, percent of change, leading, lag­
ging, and cumulative totals. 

• Mathematical and logical transformations of data into new series. 

• Linear multiple regressions with up to five independent variables 
(using ordinary least squares), including standard errors of coeffi­
cients and regressions, T-statistic, R-bar squared statistic, F-statistic, 
and the Durbin-Watson statistic. 

• Statistics: minimums, maximums, means, variances, standard devia­
tions, and correlation coefficients. 

LOADING THE TREND SUBPROGRAM 

This lesson uses the series in the STOCKMKT.SER file. This file con­
tains 13 series. If you have any new or modified series in memory, Save 
them on disk and Clear memory. Then Load STOCKMKT. SER and 
select Return to return to the Main menu. Now you are ready to begin the 
Trend subprogram lesson. 

Move the cursor to Trend, and press ~. 

The Trend menu, shown in Figure 2-42, replaces the Main menu. 
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Figure 2-42. Trend Menu 

Five of the eight menu items should look familiar. You used Edit, Main, 
Display, Clear and Plot in the Main or Plot subprograms. If you are not 
sure about the use of these functions, review their use in lessons One, 
Two, or Three. 

The remaining three functions are the heart of the Trend subprogram: 

• Analyze performs linear multiple regression and trendline 
forecasting; calculates common data series statistics such as 
minimum, maximum, mean, variance, standard deviation, and coeffi­
cient of correlation; generates tabular output; and formats the 
displayed data. 

• Function generates new series from existing ones. It calculates the 
moving average, percent of change, and cumulative total; does 
exponential smoothing; and generates leading and lagging series. 

• Xform lets you develop your own transformation of a data series. It 
allows the creation of new series through mathematical and logical 
operations on existing series. 

The Function options and Xform each create one new series. The 
multiple regression function in Analyze creates two new series. Before 
using these functions, select Display to make sure there is enough space 
for the new series. If there is not enough space, you must make space 
with the Clear function. 
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USING THE ANALYZE FUNCTION 

Move the cursor to Analyze, and press ~. The Analyze function 
displays the Analyze menu, shown in Figure 2-43. 

012-047/P 

Figure 2-43. Analyze Menu 

There are two familiar functions in this menu: Exit and Format. Exit 
returns to the Trend menu without performing any operation. Format lets 
you specify how the data is displayed. This function works exactly like 
the Format function in the Edit Command menu. It lets you specify: 

• Fixed or floating point formats. 

• The precision (0-6 decimal places) in the fixed-point format. 

• The column width (6-16). 

The remaining menu items, Table, Statistics, and Regression, are 
described in the following sections. 

Listing Series in Table Format 
The Table function lets you display information about a series on the 

screen or print it on a printer. 

Because there is limited display space on the screen, this function does 
not display series for which it has no room. The number of series that can 
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be displayed depends on the column size specified in the Format func­
tion. You enter the program using a column width of 7 characters and the 
floating point format. 

With the cursor on Table, press ~. The program displays list of series 
as shown in Figure 2-44. 

012-048/P 

Figure 2-44. List of Series for a Table 

You can select a single series by moving the cursor to the name and 
pressing ~. To select two or more series, move the cursor to each name 
in turn and press the space bar. As you have seen before, pressing the 
space bar marks a name with an asterisk (*), indicating that the series 
will be selected when ~ is pressed. You can remove the asterisk (and 
deselect the item) by pressing the space bar a second time. 

[ALL] selects all items on the list. Unless the list is small, not all series 
will fit on the screen. [NONE] exits the function without selecting 
a series. 

Move the cursor to XY EARNINGS, and press the space bar. Do the 
same with XY DIVIDENDS. Move the cursor to XY BOOK VALUE, and 
press ~. 

The program displays the union of the series ranges (the earliest start 
date and the latest end date). The maximum range is 250 data points. You 
can Keep that range or Change it. If you decide to Change it, you are 
asked for start and end dates and, if applicable, periods. Select Keep. 
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This function lines the values up by date for easy comparison and 
evaluation. The dates are down the left side of the screen. The series are 
displayed in the order in which you selected them. If a series name is too 
long for one line, it is split between two lines. If possible the program 
splits the names at spaces. Names that do not fit on two lines are trun­
cated. The table in Figure 2-45 contains information from the XY EARN­
INGS, the XY DIVIDENDS, and XY BOOK VALUE series. 

012-049/P 

Figure 2-45. Table of Series 

The status area gives you the choice of continuing or printing the table 
on the printer. 

You always have the choice of printing the display before exiting to the 
Trend menu. The program can display a maximum of 19 lines of data 
points on the screen. When there are more data points to be displayed, 
you have the option of exiting to the Trend menu, continuing to the next 
set of data points, or printing the current screen. 

Select Exit. 

Calculating Series Statistics 
The Statistics function displays a table of common descriptive 

statistical measurements: 

• The count of data points in each series that were used in the 
calculations. 
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• The minimum and maximum values in each series. 

• The arithmetic mean (average) of each series. 

• The variance for each series. 

• The standard deviation for each series. 

• If more than one series is selected, the coefficients of correlation 
between all combinations of the selected series. 

Move the cursor to Analyze and press ~. Then move the cursor to 
Statistics and press ~. The function displays the list of series just as Table 
did. Select XV EARNINGS, XV DIVIDENDS, and XV BOOK VALUE. 

The range is displayed, and you have the option of keeping this range 
or changing it. The range used by the Statistics function is the intersec­
tion of the ranges (that part of all selected series that is common to the 
others) of the selected series, not the union of ranges the Table function 
used. Press ~ with the cursor on Keep. 

When the computations are complete, the calculated values are 
displayed in columns with the series name at the top. The left-hand 
column lists the meaning of each value. The bottom of the table lists the 
range that the data covers. Figure 2-46 shows how the speCified statistics 
are displayed. 

012-050/P 

Figure 2-46. Statistics Function Display 
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You have the option of continuing or printing the statistics. The only 
way to save the statistics is to print them now; they are not saved on disk 
or in memory. If you press Continue, a display of correlation coefficients 
appears. Print prints the display on the printer. Correlation coefficients 
are not calculated if any series has a variance of O. 

Select Continue. The function calculates the coefficients of correla­
tion between the three selected series and displays them in a matrix as 
shown in Figure 2-47. 

012-051/P 

Figure 2-47. Coefficients of Correlation Display 

You have the choice of printing the coefficients or exiting. With the 
cursor on Exit, press ~. You return to the Trend menu. 

Performing a Linear Multiple Regression 
The final option on the Analyze menu is Regression which performs a 

linear multiple regression (least squares). Multiple regression is a 
method of developing a formula that relates a single variable (called the 
dependent variable) to a possible five other variables (called the 
independent variables). The resulting equation should explain the 
dependent variable in terms of the independent variables and a constant. 
Put another way, the Regression function can tell you if there is a linear 
relationship between the independent and dependent series. 
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The VisiTrend/Plot Regression function accepts up to five indepen­
dent variables. The function requires, as a minimum, as many data points 
in the intersection of the ranges as there are coefficients to be estimated. 
If a constant to be computed in the regression, minimum number of data 
points increases by one. 

This technique can be used to forecast the output of one industry on 
the basis of the output of another industry. For example, we should be 
able to show that the steel industry follows the performance of the auto 
industry. It can also used to forecast the performance of a stock in terms 
of the measures of the economy. 

The technique develops a constant (B) and coefficients (m) for each 
independent variable (x) such that a point in the dependent variable (y) 
is approximated from the corresponding period (i) data in the indepen­
dent variables according to the formula: 

y(i) = B + m(1)x1 (i) + m(2)x2(i) + ... + m(5)x5(i) 

NOTE: You can do exponential and other types of regressions by 
using the Xform option to convert series to a form acceptable for a linear 
multiple regression. The Xform option is described later in this lesson 
under "Writing Your Own Series Transformation." 

The Regression option also calculates and displays the statistical 
measures of a linear multiple regression. These include the T-statistic , 
the R-bar squared statistic, the corrected R-bar squared statistic, the 
standard error for the regression and for the coefficients, the sum of the 
squared residuals, the F -statistic, and the Durbin-Watson statistic. The 
formulas used by VisiTrend/Plot for computing these statistics are shown 
in the Reference chapter under "The VisiTrend/Plot Menu Functions." 

The Regression function generates two new series. The first is a fitted 
series developed from the generated constant and coefficients. The 
second is a series of the differences (residuals) between the actual 
dependent series values and the fitted values. The new series have the 
same name as the dependent series with a qualifier appended to the 
name. The qualifiers are listed in Table 2-3. 
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Table 2-3. Regression Series Name Qualifiers 

Qualifier 

.Fnn 

.Rnn 

Purpose Comments 

Fitted series nn is a program-generated number 

Residual series nn is the same for the fitted and 
residual series from a single 
regression. 

Move the cursor to Analyze and press ~; then to Regression and 
press ~. 

The names of the series in memory are displayed. The status area 
directs you to select a dependent variable. Move the cursor to XV PE 
RATIO, and press ~. This example tests to see if the price/earnings ratio 
can be explained by the earnings, dividends, and book value. 

Next you must select the independent variables. You can select from 
one to five series as independent variables. The· independent variables 
must have the same period as the dependent variable. Move the cursor to 
XV EARNINGS, and press the space bar. Do the same for XV DIVIDENDS 
and XV BOOK VALUE. Now press ~. 

The intersection of the ranges of the dependent and independent 
variables is displayed in the top line of the status area. You have the 
option of keeping this range or changing it. 

More points must be in the range intersection than there are coeffi­
cients to be estimated. The exact number of points varies, depending on 
the use of a constant. For example, when you use a constant and select 
three independent variables, you must have five data points in the 
intersection of the ranges of the dependent and independent variables. 
In this same example, if you use no constant and select three indepen­
dent variables, rou must have four data points in the intersection of the 
ranges. Press ~ with the cursor on Keep. 

You can generate the regression with or without a constant. In this 
example, select Yes. 

The time it takes to perform the regression varies with the number of 
data points and number of series. The regression analysis is displayed as 
shown in Figure 2-48. 
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Figure 2-48. Regression Analysis Display 

If there is not enough room for the fitted and residual series, they are 
not created. The message that there is no room appears in the status area. 
You should return to the Main menu and clear some series from memory. 
Then go through the regression steps again. 

When the analysis is displayed, you can continue or print the analysis. 

The only way to save the regression analysis is to print it. You cannot 
save it in memory or on disk. You must run the regression again if you 
want the data at a later time. 

Select Continue. 

Now the analysis disappears, and you are asked if you want to save the 
series containing the fitted and residual values. If you select No, the 
series are discarded and you must do the regression again if you want 
them at a later time. Select Yes to save the series. The Regression func­
tion exits to the Trend menu. 

Move the cursor to Display, and press ~. Note that the bottom two 
items on the Display list are XY PE RATI,F01 and XY PE RATI,R01. The 
number on the end is program supplied; it is the same for both series. 
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To see the newly created values: 

1. Return to the Trend menu. 

2. Select Analyze and Tobie. 
3. Select XY PE RATIO, XY PE RA TI FO 1, and XY PE RA TI RO 1 . 

4. Select Keep. 

The values are displayed with their date. 

Figure 2-49 shows a line chart of the dependent and the fitted series 
plotted together. 

012-053/P 

Figure 2-49. Actual and Fitted Data Chart 

Trend Forecasting with the Regression Function 
The Regression function also does trend forecasting. It calculates the 

best straight-line fit for the dependent variable. You are prompted for the 
number of periods to forecast. The fitted straight line is extended for the 
specified number of periods. 

The function generates the same displays and series that are generated 
in the multiple regression: the regression analysis, the fitted series, and 
the residual series. 
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Before beginning this function, select Exit to go back to the Trend 
me~u, then select Clear. Remove the XY PE RATI.F01 and XY PE 
RATI.R01. 

With the cursor on Exit, press ~ to go back to the Trend menu. 

To generate a five-period forecast of the XY PE RATIO series, select 
Analyze, Regression, and XY PE RATIO. When the prompt to select the 
independent variables is displayed, the bottom item in the list is [TREND]. 
Move the cursor to [TREND], and press ~. You cannot include any series 
as independent variables when doing a trend forecast. 

Next you are prompted to specify a number of periods to forecast. 
Enter 5, and press ~. When the range prompt is displayed, select Keep 
to use the range of the dependent variable. The regression analysis 
displays. After you have read the analysis display, select Continue. 
Select Yes to save the fitted and residual series. The fitted and the depen­
dent series are shown in Figure 2-50. 

012-054/P 

Figure 2-50. Trend Forecast Chart 
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Remove the XV PE RAT I F02 and XV PE RATI,R02 from memory with the 
Clear option. 

Move the cursor to Function and press ~. Each item in the Function 
menu generates a new series. 

Each function generates a new series that has the name of the source 
series with a qualifier added to the end of the name. The qualifiers for 
each function are listed in Table 2-4. 

Table 2-4. Function Series Name Qualifiers 

Function 

Moving Average 
Smoothing 
Percent Change 
Difference 
Lag 
Lead 
Total 

Qualifier 

.Mnn 

.S 

.% 

.0 

.-nn 

.+nn 

.T 

Comment 

nn = number of periods averaged 

nn number of periods lagged 
nn = number of periods leading 

The Function menu items are all much alike. After selecting the func­
tion, you are prompted to select the source series from the series in 
memory. Some functions require no further input while others prompt for 
an additional factor~ Following the descriptions of the individual func­
tions there is an example showing how to generate a moving average. 

Smoothing 
The Smoothing function performs a single exponential smoothing of 

the source series. The series generated by this technique is based on the 
most current data point and current generated data point. This function 
generates a new series with .S appended to the name of the source series. 

The program asks for a smoothing factor ( A ) which must be greater 
than 0 and less than 1. The smoothed series is calculated with the 
formula: 

y(i) = A xCi -1) + (1- A )y(i -1) and y{l) = x(l) 

where y(i -1) is a data point in the new series, xCi -1) is a data point in 
the source series, and lambda is the smoothing factor. A high smoothing 
factor (a value greater than 0.5) gives greater weight to the point in the 
source series, and a low smoothing factor, to the previous point in the 
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source series, and a low smoothing factor, to the previous point in the 
smoothed series. The generated series lags the source series by one 
period as shown in Figure 2-51. This lag is a one period forecast for the 
data in the source series. 

Source Series 

Smoothed Series 012-005 

Figure 2-51. Smoothing 

Percent of Change 
The Percent-Change function calculates the percent of change 

between data points i and i + 1, and puts the value at point i + 1 in the new 
series .. This function generates a new series with . % appended to the 
name of the source series. 

The Percent-Change function lets you evaluate the change in related 
series rather than trying to compare divergent magnitudes in the original 
series. For example, you may generate percent-of-change series for 
sales and cost-of-sales data. The original data can look like there is a low 
correlation when in fact the percent of change shows a positive cause­
and-effect relationship. 

Difference 
The Difference function computes the difference between adjacent 

data points in the source series. The difference between points i and i + 1 
is put into point i + 1 in the generated series. This function generates a 
new series with .D appended to the name of the source series. 

When Difference displays the names of the series in memory. You can 
select one series for the Difference function. 

Lag 
The Lag function shifts the values in the source series a specified 

number of periods to the future in the generated series. This function 
generates a new series with . - nn appended to the name of the source 
series, where nn is the number of periods lagged. 
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A common usage of this technique is to align data in time in a mean­
ingful fashion. For example, if you spend X dollars on advertising in 
January, the effect of the expenditure will not be until February. The Log 
function shifts the advertising expenditures forward in time where they 
can be evaluated against the sales they prompted, that is: 

Sales(i) = f(advertising expenditure{i -1» 
The program asks for the number of periods to be lagged. The new 

series begins and ends at the specified number of periods later than the 
source series. Figure 2-52 shows the effect of a one-period lag on 
a series. 

..._ ..... _ .... __ ..... _ ..... _ ..... Lagged Series 

I Feb I Mar I Apr I May I Jun I 012-006 

Figure 2-52. One-period Lag 

Lead 
The Lead function shifts the values in the source series a specified 

number of periods to the past in the generated series. This function 
generates a new series with . + nn appended to the name of the source 
series where nn is the number of periods. 

The Lead function is the reverse of the Log function. Like the Log 
function, a common usage of this technique is to align data in time in a 
meaningful fashion. For example, if you spend X dollars on advertising 
in January, the effect of the expenditure will not be until February. The 
Lead function shifts the sales figures back in time where they can be 
evaluated against the advertising expenditure. 

The program asks you for the number of periods. The new series 
begins and ends the specified number of periods before the source 
series. Figure 2-53 shows the effect of a one-period lead on a series. 

2-80 



IBM PERSONAL COMPUTER VISITRENDIPLOT™ ~~T~~s 
TUTORIAL 

I Jan I Feb I Mar I Apr I May 

Source 
_.,...-...,.._....,._ ...... ~ ...... ..,.._ Series 

I Dec I Jan I Feb I Mar I Apr 

Figure 2-53. One-period Lead 

Totaling a Series 

LESSON FOUR 

012-007 

The Totol function calculates the cumulative total of the points in the 
source series. A given point in the new series is the total of that point and 
the preceding points in the source series. The most common usage of this 
function is to generate year-to-date totals of monthly or quarterly data. 
This function generates a new series with. T appended to the name of the 
source series. 

Moving Average 
The Moving-Average function calculates the moving average of the 

source series for a specified number of periods. This function creates a 
file with the identifier .Mnn, where nn is the number of periods. 

There are three common methods of calculating the moving average: 

• The N + 1 method (used in the Trend subprogram) which locates the 
first point of the moving-average series at one point beyond the 
periods being averaged as shown in Figure 2-54. 
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1970 I 1971 I 1972 I 1.973 1974 I 1975 I 1976 I 
.......-. I~' I~· I--'d --i, l--i, I 

Source 

= 
N + 1 
Moving Average 

..-. ____ ..... _ .... _ ..... Over 3 Periods 003-003 

Figure 2-54. N+l Moving Average Method 

• The N method which locates the first point of the moving average 
series at the last point of the periods being averaged as shown in 
Figure 2-55: 

1970 I 1971 I 1972 I 1973 I 1974 1975 

N Moving Average 
..-. ____ ..... _ .... _-.. Over 3 Periods 003-004 

Figure 2-55. N Moving Average Method 

• The Centered method which locates the first point of the moving 
average series at the center of the periods being averaged as shown 
in Figure 2-56. 
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1970 I 1971 1972 1973 1974 1975 

. I 

Centered Moving Average (over an odd number of periods) 

1970 

Centered Moving Average 
(over an even number of periods) 003-005 

Figure 2-56. Centered Moving Average Method 

The moving average is essentially a smoothing technique. A common 
use of this function is to remove the noise or seasonal factors from 
monthly or quarterly data. For example, if you have monthly sales data 
for several years and want to see the trends without the month-to-month 
fluctuations, you can generate a moving average over a 12-month 
period. For quarterly data that contains seasonal noise, you would 
generate a moving average over a four-quarter period. 

You are prompted for the number of periods. 
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A Function Example 
The Function menu options are executed in a like manner. This section 

describes a typical Function menu option. 

This is an example of the use of the Trend N + 1 Moving-Average 
function. Before starting, move the cursor to Display, and press ~. You 
must have at least one free series in memory. If you already have 16 
series in memory, remove one with the Clear function. 

In the Trend menu move the cursor to Function and press ~. The 
Function menu is displayed, as shown in Figure 2-57. 

012·055fP 

Figure 2-57. Function Menu 

The first item (under the cursor) is Moving-Average, press ~. You 
are asked to select a series. Move the cursor to XV DIVIDENDS, and press 
~. Next you are asked to enter the number of periods over which the 
average is to be calculated. Enter 3, and press ~. The Trend menu 
returns to the screen. 

Move the cursor to Analyze, and press ~; then to Table, and press ~. 
When the series list appears, move .the cursor to XV DIVIDEND and press 
the space bar. Then move the cursor to the new series at the end of the 
list with the name XV DIVIDEN.M03, and press ~. When asked about the 
range, select Keep. 

2-84 



IBM PERSONAL COMPUTER VISITREN DIPLOT™ g~~~~s 
TUTORIAL LESSON FOUR 

Figure 2-58 shows the table of the two series. The series are listed in 
the order in which you selected the series. 

012-056/P 

Figure 2-58. Series After Moving Average 

How to Convert an N+l Moving Average 
You can convert the Trend N + 1 moving average to an N or Centered 

moving average. 

CONVERTING TO AN N MOVING AVERAGE 

To create to an N moving average, first perform the N + 1 moving 
average for the desired number of periods. You must move the .Mnn 
moving average back in time by one period. Select Lead, the .Mnn 
series generated with Moving-Average, and enter a Lead period 
of 1. This series, with the identifier. + 01, generated by Lead is an N 
moving average. 

CONVERTING TO A CENTERED MOVING AVERAGE 
(ODD NUMBER OF PERIODS) 

If the N + 1 moving average is over an odd number of periods (p), the 
generated series must be moved back, with the Lead function, to the 
middle of the number of periods being averaged. In other words, the 
N + 1 moving average series must be moved backward (p + 1)/2 periods, 
where p is the number of periods averaged. 
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CONVERTING TO A CENTERED MOVING AVERAGE 
(EVEN NUMBER OF PERIODS) 

TUTORIAL 

When the number of periods (p) being averaged is even, the conver­
sion to a centered moving average is more complex. Follow this 
procedure: 

1. Perform a p period N + 1 moving average. 

2. Perform a 2 period N + 1 moving average on the series resulting from 
step 1. 

3. With the Lead function, move the series resulting from step 2 
backward in time by (p/2) + 2 periods, where p is the number of 
periods averaged in step 1. 

WRITING YOUR OWN SERIES TRANSFORMATION 

The Xform function lets you write your own transformation formula. 
The formulas are limited to 158 characters. You can use the following 
mathematical, logical, and comparative operators in writing your 
transformation formula: 

• Mathematical operators: + (addition), - (subtraction), * (multiplica­
tion), / (division), and 1\ (exponentiation). 

• Logical operators: AND, OR, and NOT. 

• Comparative operators: < (less than), < = (less than or equal), 
= (equal), > (greater than), and> = (greater than or equal). 

You can use parentheses to control the execution order of the formula. 
All operations in parentheses are performed before the operations 
outside the parentheses. All parentheses must be closed or an error 
will occur. 

In addition to the mathematical, logical, and comparative operators, 
you can use the following functions: 

• SGN(seriesx): Sign of data points in seriesx 

• INT(seriesx): Integer part of data points in seriesx 

• SQR(seriesx): Square root of data points in seriesx 

• LOG(seriesx): Natural logarithm of data points in seriesx 

• EXP(seriesx): e to the power of data points in seriesx 

• RND: Random number between 0 and 1 

• ABS(seriesx): Absolute value of data points in seriesx 
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• SIN(seriesx): Sine of data points in seriesx 

• COS(seriesx): Cosine of data points in seriesx 

• TAN(seriesx): Tangent of data points in seriesx 

• ATN(seriesx): Arctangent of data points in seriesx 

You can use these functions as they are used in a Basic program. The 
only difference here is that you can use a series as the variable on which 
the function operates. The function is performed on each data point in 
the series. For example, SQR(XY EARNINGS) generates a series with the 
same beginning and ending dates and period as XY EARNINGS. Each 
data point in the new series is the square root of the corresponding data 
point in XY EARNINGS. 

A word of explanation about RND: it's the only Transform function that 
does not require at least one argument in a formula. It operates like a 
constant in a Transform expression, in the sense that it does not have a 
range associated with it. 

You can include series names in your transformation formula. The 
Xform function displays the list of series currently in memory. You 
select a series by moving the cursor to the name of the desired series 
and press ~. 

The following example creates a new series with the name BD A VG. 
The series is the average of the daily high and low stock prices contained 
in the series BD HIGH and BD LOW. 

Before beginning, use the Display function, and make sure you have 
room for a series in memory. 

Move the cursor to Xform, and press ~. The function prompts for a 
name for the series that holds the transformed data. Enter BD AVG, and 
press ~. 

If you don't enter a series name, the Trend subprogram automatically 
supplies one for you. If you have no room for the BD AVG series, it is not 
created, and you see an error message. Because you have cleared room 
in memory, the BD A VG series name is accepted. 

Next you are asked whether the transformation should be performed on 
the intersection or the union of the series named in the transfor­
mation formula. 
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If you select Union the resulting series range will be from earliest in all 
series to the latest date in all series. All periods for which there is no data 
are assumed to be O. This may give you a resultant series with unex­
pected values if you multiply or divide by a O-filled data point. 

If you select Intersection the resulting series range be the period that 
is common to all series. 

Select Intersection. 

A list of the series in memory is displayed. The top line of the status 
area tells you to enter the transform, move the cursor, or press ~. You 
can enter any transform operator or function from the keyboard, enter a 
series name by moving the cursor with the i or ~ keys, or press ~ to 
indicate that the formula is complete. The transform formula uses all of 
these. This display is shown in Figure 2-59. 

012·057/P 

Figure 2-59. Transform Display 

When you want to erase part of a formula you have entered, press the 
BKSP key. The right most entry is erased each time you press the BKSP 
key. If a series name is the right most element when you press the BKSP 
key, the whole name is erased. You do not have to erase each letter of 
the name. 

Even though it's customary to show mathematical functions in capital 
letters, such as·OR and COS, you can type them in upper or lower case 
in your formula. The Trend subprogram accepts either. 
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Press the ( key. A ( appears in the formula line in the status area. 

Press the ~ key. A cursor appears in the series list. Also the name 
under the cursor appears in the formula line in the status area. Press the ~ 
key again; the cursor moves down, and the name in the status area 
changes. Move the cursor to BD HIGH, and press ~. The cursor disap­
pears from the list, and BD HIGH remains in the formula. 

Enter +. 

Again press the ~ key. Again a cursor appears and a series name 
is written in the status area. This time move the cursor to BD LOW and 
press ~. 

Enter ). 

Enter / (for division). 

Enter 2. 

You now have a formula in the status area that reads: 

[ BD HIGH + BD LOW)/2 

To generate a new series with this formula, press ~. If the last item in 
the formula had been a series ,name, you would have had to press ~ 
twice, once to enter the series name and once to execute the formula. 
You are given the choice of keeping or changing the range. Select 
Keep. 

When the function is finished, the Trend menu returns. Move the cur­
sor to Display, and press ~. The list shows that the function created a new 
series with the name BD A VG. Figure 2-60 shows the new series plotted in 
a line chart with BD HIGH and BD LOW. 
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NOTE: Series data, entered via the editor or loaded, is converted to a 
binary format and subsequent computations are done in binary 
arithmetic. The program uses two binary formats: single precision (a 24 
bit mantissa with precision equal to 7.22 significant decimal digits) and 
double precision (a 53 bit mantissa with 15.95 decimal digit precision). 
Statistics and regressions are computed in double precision. The pro­
gram stores series data in single precision. You can expect the program 
to remember in excess of 7 (7.22 to be exact) significant digits for each 
data point. Displayed values are rounded to 7 significant digits. It is 
important to remember that the program stores greater precision than it 
displays. The displayed number 238.9267 is a value in the range 
238.92665 and 238.92674999 ... Any number between 87.999995 and 
88.0000049999 ... is displayed as 88. Keep this in mind when working 
with values that have a large number of significant digits. This is 
especially true for sine, cosine, and tangent. 

Figure 2-60. Chart After Transformed Series 

Some Uses for the Xform Function 
with Multiple Regression 

012-009/P 

While the Function and Analyze options offer many series data func­
tions, they may not meet all your needs. The Xform function allows such 
operations as the conversion of exponential values to first orde~-¥alues 
for inclusion in a linear multiple regression. For example, if you think 
that there may be a meaningful correlation such that: 

Y = f(X2) where f(.) is a linear function. 
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You can perform a non-linear regression by using the Xform function 
to create a new series, Z, that is equal to X squared. Then you use the new 
series, Z, as an independent variable to perform the linear regression: 

Y = f(Z) 

As a further example of this use of Xform, suppose you suspect that 
dependent variable D is related to the sine of the cube of independent 
variable I: 

To test this hunch, use Xform to compute: 

Then do a linear regression with D as the dependent variable and II as 
the independent variable: 

D = f(lI) 

If the regression shows a good fit, your hunch about the relationship 
between D and sin(I3

) is correct. 

CONTINUING WITH THE TREND SUBPROGRAM 

You can go back to the functions you have used in this lesson and 
analyze your data. You should be able to use the Function items that you 
have not used. Finally, you can save your Trend output on the data disk 
and plot the data with the Plot program. 
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FUNCTIONAL SUMMARY 

To From Select/Enter 

Enter Trend Main menu l. Trend 
subprogram 

List series data in Trend menu l. Analyze 
a table 2. Table 

3. Series name SPACE BAR 
4. Last series name ~ 
5. Keep/Change 
6. Continue/Printer 

Calcula te series Trend menu l. Analyze 
statistics 2. Statistics 

3. Series name SPACE BAR 
4. Last series name ~ 
5. Keep/Change 
6. Con tin ue/Prin t 

Perform a linear Trend menu l. Analyze 
multiple regression 2. Regression 

3. Dependent variable series 
4. Up to 5 independent 

variable series 
5. Keep/Change 
6. Yes/No (Use/don't use 

constant 
7. Continue/Print 
8. Yes to save values; NO to 

discard 

Calculate a moving Trend menu l. Function average 
2. Moving-Average 
3. Source series name 
4. Number of periods 

Perform exponential Trend menu l. Function smoothing 
2. Smoothing 
3. Source series name 
4. Smoothing factor 

Calculate percent Trend menu l. Function 
of change 2. Percent-Change 

3. Source series name 

Calculate difference Trend menu l. Function 
2. Difference 
3. Source series name 
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(Continued) 

To From Select/Enter 

Generate a lagging Trend menu l. Function 
series 2. Lag 

3. Source series name 
4. N umber of periods 

Generate a leading Trend menu l. Function 
series 2. Lead 

3. Source series name 
4. Number of periods 

Generate a cumulative Trend menu l. Function 
total series 2. Total 

3. Source series name 

W rite a series Edit menu l. Xform 
transformation 2. Series name 

3. Intersection/U nion 
4. Formula (series names, 

math operators) 
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LESSON FIVE: PLOTTING EXAMPLES 

This lesson is a series of step-by-step examples showing how to make 
VisiTrend/Plot charts. The data series that are used in these examples are 
stored on the VisiTrend/Plot example disk in files named 
ACMERPT.SER, REGIONAL.SER, and XYCHART.SER. 

The ACMERPT.SER file contains annual revenue, units shipped, 
annual expenses, and income tax data for 1981. 

The REGIONAL.SER file contains Acme Company sales by 
geographic region in 1981. 

The XYCHART. SER file contains series of values for two math 
functions. 

This lesson assumes you are familiar with Lesson One and Lesson Two 
covering the Plot and Main subprograms. 

GETTING STARTED 

Load the VisiTrend/Plot program and then load the ACMERPT. SER, 
REGIONAL.SER, and XYCHART.SER files. Now Plot to go to the Plot 
subprogram. If you have trouble with any of these operations, review 
Lesson Two. 

This lesson shows how to draw many different charts and how to com­
bine charts. Each exercise begins with a picture of the chart. The picture 
is followed by a list of the keys you must press. A key name preceded by a 
word or phrase enclosed within parentheses indicates a cursor position 
before pressing the indicated key. A word or phrase in quotation marks 
preceded by the word "Enter" indicates that the word or phrase must be 
typed. For example: 

• SPACE BAR means press the space bar. 

• ~ means press the ~ key. 

• Line ~ means move the cursor to Line, and press the ~ key. 

• "Enter 2200 ~" means enter the value 2200 at the keyboard, and press 
the ~ key. 
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SINGLE-LINE CHART 

012-0581P 

Figure 2-66. Sample Single-Line Chart 

Beginning in the Select menu: 

Line ~ 

Revenue ~ 

Plot ~ 

You drew several single-line charts like this one in Lesson One. This 
chart has a different Y-axis scale. The Y-axis scale is labeled Thou at the 
top, indicating that Y-axis values must be multiplied by 1000. 
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TWO-LINE CHART 

Figure 2-67. Sample Two-Line Chart 

Beginning in the Plot menu: 

Select ~ 

Line ~ 

Revenue SPACE BAR 

Units Shipped ~ 

Plot ~ 

TUTORIAL 

012-059/P 

The chart contains two lines instead of one. The two lines are plotted 
with different symbols: the square, that you saw in Lesson One, and a 
triangle with a dot inside. The legend at the bottom of the chart identifies 
the chart type for each of the plotted series, shows what plotting symbol 
was used for each, and gives each series name. The bottom status area 
line contains the name of the first series selected. . 

Note that both series were selected before the chart was drawn. 
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THREE-LINE CHART 

Figure 2-68. Sample Three-Line Chart 

Beginning in the Plot menu: 

Select ~ 

Line ~ 

Revenue SPACE BAR 

Units Shipped SPACE BAR 

Expenses ~ 

Plot ~ 

LESSON FIVE 
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The new feature of this chart is the use of the number sign (#) as the 
plotting symbol of the third series. 

This chart is difficult to read. The information for the years 1977 
through 1980 is crammed into a small space. The only points that show up 
well are the 1981 and 1982 revenue points. This chart may be satisfactory 
if its purpose is to show how revenue increased in 1981. However, if the 
other information is equally important, it might be a good idea to change 
the range to 1975 through 1980 and handle the 1981 and 1982 revenue 
figures in some other manner. 
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Another approach is to change the scale to show the earlier data 
clearly and let 1981 and 1982 revenues go off the chart and show its value 
with a moveable title. This is the approach used in Figure 2-69. 
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Figure 2-69. Rescaled Three-Line Chart 

Go ahead and make the improvements that were suggested in the 
preceding paragraph. After you've made these improvements, return to 
the Plot menu. When the Plot menu appears, go to the Select menu. 
Specify the Line chart type; then observe the series list that appears, but 
do not select any . You are going to use the same series as in the first part 
of this exercise, but this time, you are going to use a shortcut to select 
them. Notice that the last entry in the list is [Some]. Choosing [Some] 
selects all the series that were plotted in the preceding chart. Instead of 
positioning the cursor on each series name to be plotted and marking it 
with an asterisk, you need to position the cursor on [Some], and press ~. 
Do that now. 

When the Plot menu reappears, keep the cursor on Plot, and press ~. 
Revenue, Units Shipped, and Expenses are drawn again as they were 
before you changed the scale. 

[Some] can be used as a shortcut on all chart types except a pie chart 
and an XY chart. Also be aware that it operates only in the Plot portion of 
the VisiTrend/Plot program. If you transfer to the Main or Trend sub­
program then return to Plot, the [Some] setting is canceled. 
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So far you've used the program to do multiple-series plotting of two 
and three series. As you've noticed, each series has a corresponding 
legend. 

The program displays up to six legends on a chart, even though up to 
16 series can be plotted on the same chart. Three or fewer legends are 
centered under the X axis of the chart, as shown in the preceding 
photograph. Four, five, or six legends are laid out somewhat differently. 

Figure 2-70. Location of Multiple Legend Items 

Beginning in the Plot menu: 

Select ~ 

Line ~ 

Revenue SPACE BAR 

Units Shipped SPACE BAR 

Expenses SPACE BAR 

Market ~ 

Plot ~ 
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SINGLE-BAR CHART 

012-063/P 

Figur~ 2-71. Sample Single-Bar Chart 

Beginning in the Plot menu: 

Select ~ 

Bar ~ 

Full ~ 

Revenue ~ 

Plot ~ 

Again, this chart is no different than the bar charts you did in Lesson 
One. It can be made different by selecting half-width bars. Repeat 
the preceding sequence but select Left instead of Full. Beginning in 
Plot menu: 
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Select ~ 

Bar ~ 

Left ~ 

Revenue ~ 

Plot ~ 

Figure 2-72. Sample Left-Bar Chart 

LESSON FIVE 
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The only differences in the chart are the width of the bars and the 
legend. Where it previously contained a B for bar it now contains BL for 
bar left. 

If you want to compare expense data to revenues, you can overlay it on 
the existing chart. Beginning from the Plot menu: 
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Figure 2-73. Sample Bar Chart With Overlay 

Select ~ 

Bar ~ 

Right ~ 

Expenses ~ 

Options ~ 

Format ~ 

Shaded ~ 

Overlay ~ 

The Overlay option draws a chart over an existing chart. It does not 
erase the existing chart as the Plot option does. The sequence Options, 
Format, and Shaded is necessary to distinguish the new bars from the 
old. If this sequence had been eliminated, both sets of bars would be 
solid. You can use the Format or the Shade options to differentiate 
between the bars. 
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The overlayed chart uses the range and scale of the existing chart. 
There is no limit to the number of overlays you can add to a chart. Only 
the first six series are identified in the legend. 

The next section describes another method of drawing a comparative­
bar chart. 

COMPARATIVE-BAR CHARTS 

Figure 2-74. Sample Comparative-Bar Chart 

Beginning in the Plot menu: 

New ~ 

Bar ~ 

Both ~ 

Revenue ~ 

Expenses ~ 

Plot ~ 
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The program asked for the left and right series separately, in 
individual passes through the series name list. If you had selected the 
series by marking them with an asterisk (as you did for multiple line 
charts) you would have drawn a stacked chart as shown in Figure 2-75. 

The overlay chart used the range and scale of the first chart you drew. 
When you use the Both option, the program uses the union of the ranges 
and a scale that fits both series. 

Note that the sequence to draw the preceding chart began with the 
New option instead of the Select option. The New option resets the 
Format option which was set for the overlay chart. The Select option 
does not reset Format, Shade, and Background options. 

012-067/P 

Figure 2-75. Stacked-Bar Chart 

The preceding chart was created by the following sequence, begin­
ning in the Plot menu: 

Select ..J 

Bar ..J 

Full..J 

Revenue SPACE BAR 
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Expenses ~ 

Plot ~ 

Generating the chart in this way, the two values are added. You can 
use this style of bar chart when you are interested in the sum of the two 
series. When bars are stacked, the legends reflect the order of stacking. 
That is, the first legend corresponds to the topmost values, the second 
legend corresponds to the next lower, and so on. 

THE PIE-CHART DATA 

In the following sections you are going to draw pie charts. The data 
used for drawing pie charts must meet the following requirements: 

• Each value used in a pie chart must be from a different series. The 
value from each series chosen is a slice of the pie. Up to 16 series can 
be used. 

• All the series must have the same period. For example, if series A 
period is 1, it can be used only with other series having a period of 1. 

• All values must be at the same location in each series. In other words, 
at least one location must be common to all the series to be used for a 
pie chart. For example, if you specify a pie chart to show data for 
1978, each series being used must contain a value for 1978. 

Pie charts can use values that are keyed to points of time, or to a set of 
circumstances. In the next example, the values are keyed to a set of cir­
cumstances: data point 0 represents revenues split among three regions; 
data point 1 represents revenues split among four regions. Keyed to 
points of time, the values could represent, for example, total revenues for 
each month of the year. 

A pie chart shows a single point of time (or a single set of cir­
cumstances) and not a comparison of different points (or circumstances) 
as other charts can. 

Figure 2-76 shows how the pie chart data requirements apply. 
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012-008 

Figure 2-76. Choosing Series for a Pie Chart 

The data for the pie chart in the next section is in four series: North, 
West, South, and Central. Each series has two data points. The first data 
point in each series represents the total revenue attributed to three 
regions (the Central value is 0). The second data point in each series 
reflects the allocation of total revenue if a fourth region (Central fourth) 
were added. 
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A PIE CHART 

Figure 2-77. Sample Pie Chart 

Beginning in the Select menu: 

Pie ..J 

North SPACE BAR 

West SPACE BAR 

South ..J 

Enter 0 ..J 

LESSON FIVE 
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Each segment of the pie is labeled with a letter. The letter refers to the 
items in the legend. This order of the series around the pie and in the 
legend is significant; it is the order in which you selected them. The first 
series always begins at the 3 o'clock position and extends in a clockwise 
direction. 

The bottom line of the legend contains a 0, the date or reference 
n umber of the selected data. 
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Shading and Titling a Pie Chart 
Press ~ to proceed to the shading function. 

TUTORIAL 

The Shading function asks you to enter a letter or press ~. It is asking 
for a letter indicating a segment of the pie. You can specify the labels in 
any order; you can skip any you don't want shaded. If you change your 
mind, you can change the shade of a segment you have shaded. Pressing 
~ without a letter ,exits the shading function. 

Enter A, and press ~. The Shade menu is displayed. You can choose 
black, white, fine gray, and coarse gray. Original specifies the form in 
which the segment is originally displayed. Select White. Segment A is 
filled in. 

You are asked for another letter. Enter B, and press ~. This time select 
Fine Gray, and press ~. The B segment is filled in. Leave the C segment 
as it is, black. Press ~. You are asked to confirm that you want to exit the 
shading function. This confirmation is necessary because you have only 
one chance to shade the chart. Once you leave this function you cannot 
get back to it without starting the chart over from the beginning. 

Enter Y when the Title exit prompt appears. 

The legend doesn't add much to the chart. It will look better if the 
legend were erased and the legend information put on the chart itself. 
Whereas the Legend function returned the legend in other charts, it 
erases the legend and the segment letters in pie charts. Select Legend, 
and press ~. You should remove the legend before locating titles over 
the legend or over the segment letters. Anything covering them is 
also erased. 

Use the Top and Moveable functions to make the chart look like 
Figure 2-78. 
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Figure 2-78. Shaded and Titled Pie Chart 

When you've finished titling the chart to look like Figure 2-78, move 
the cursor to Exit, and press ~. The pie chart disappears and the Select 
menu reappears. Your work on the chart is not lost. Select None. The 
chart reappears along with the Plot menu. 

From the Plot menu you can save, print, or add to the chart. The 
Screen option saves the pie chart screen image on disk. The Print option 
prints it on the printer. The Text option, which is covered later in this 
lesson under "Creating Annotation and Text Pages," lets you add text to 
the chart. 

To try your hand at another pie chart, use the same three series plus 
the Centro I series, and use 1 for the year instead of O. 

2-109 



IBM PERSONAL COMPUTER 
LESSON FIVE TUTORIAL 

AN XY CHART 
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Figure 2-79. Sample XY Chart 

Beginning in the Plot menu: 

Select ~ 

xv ~ 

Price ~ 

Quantity ~ 

Plot ~ 

An XY chart does not have a time axis. The Y-axis contains the scale 
for the Quantity series and the X-axis contains the scale for the Price 
series. 

The plotted values are points from the two series with matching dates. 
The first point plotted is the first value from each series, the second point 
is the second value, and so on. 

The VisiTrend/Plot program automatically draws an XY series with 
plotting symbols and a line. However, when there are more than 40 data 
points in the combined series, only a line is plotted. For example, if your 
chart contains 43 data points those data points are plotted with a line 
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only. But you can force all 43 data points to be drawn as plotting symbols 
on a line by specifying Both in the Format option in the Options menu, 
then plotting again. As with other chart types, you can respecify the 
symbols to be used through the Format option in the Plot menu. 

The normal use of the XY chart is to determine if there is a correlation 
between two series. The direction, slope, and curvature of the line shows 
the relationship between the two series. An analysis of the XY patterns is 
beyond the scope of this manual. 

A secondary use of the XY chart is to plot two sets of values against 
each other. Normal use of the VisiTrend/Plot program is with time series. 
To use the program to plot non-time series, you must put the X-axis 
values in one series and the Y-axis values in another. Then generate an 
XY chart of the two series. You must put the related X- and Y-axis points 
at the same time point in their respective series. 

When using the Overlay function with an XY chart, remember these 
two points: 

• XY charts cannot be mixed with other chart types in overlays. 

• Legends are laid out differently on overlayed XY charts. On overlaid 
XY charts, legend items appear only under the X-axis, stacked in two 
columns as for other types of overlaid charts. 

DATA OFF-SCALE DURING AN OVERLAY 

When you used the overlay function earlier in this lesson to create a 
comparative-bar chart, you encountered no problems with scale, or 
range, or any other plotting factors. However, when you are using the 
overlay function on actual charts, it's quite easy to be off-scale 
regardless of the type of chart you are working with. 

In Lesson One, you encountered an off-scale condition when overlay­
ing was not involved. The program gave you two options: Proceed and 
Cancel. When overlaying, the program gives you three options: Pro­
ceed, Redraw, and Cancel. 
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Figure 2-80. Line Chart With Added Title 

Beginning in the Plot menu: 

Select ~ 

Line ~ 

Revenue ~ 

Plot ~ 

Esc 

Options ~ 

Title ~ 

Moveable ~ 

Enter Revenue ~ (Move to location shown in Figure 2-80.) 

Normal ~ 

Exit ~ 
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Next, add a second series using the Overlay operation. 

Figure 2-81. Overlaid Line Chart 

Beginning from the Plot menu: 

Select ~ 

Line ~ 

Units Shipped ~ 

Overlay ~ 

012·071/P 

So far, so good. You have been able to plot two series on the same scale 
using the Overlay function. 

Again beginning from the Plot menu: 

Select ~ 

Line ~ 

Market ~ 

Overlay ~ 
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This time the overlay is not successful because the data in the Market 
series is off-scale. You now have three choices, as indicated by the menu 
in the status area: Proceed, Redraw, or Cancel. Proceed and Cancel 
operate as you saw in Lesson One when overlaying wasn't involved. 
Redraw, however, rescales the chart, then redraws it. This has several 
consequences, as you will see. 

Select Redraw. A warning about intermediate series lost appears in 
the status area. Press ~ to go ahead with the operation. Your screen 
should look like the following Figure 2-82. 

012·072/P 

Figure 2-82. An Off-Scale Chart Redrawn 

The Units Shipped series is gone and so is the title. Using Redraw 
after successful overlays erases all those overlays; it also erases any titles 
associated with those overlays. Only the originally selected series and 
the last attempted Overlay series are redrawn. 

The relationships among legends, overlays, and the Redraw function 
are illustrated in Figure 2-83. 
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Operations 

1. Plot Series 1 
2. Add miscellaneous 

titles 

3. Overlay with Series 2 
4. Add miscellaneous 

titles 
5. Redraw 

6. Overlay with Series 3 
7. Add miscellaneous 

titles 
8. Redraw 

Note: Overlays plot only 
first and last series 
on Redraw 

VISITREN DIP LOT™ ~~T~~s 
LESSON FIVE 

Display 

012·009 

Figure 2-83. Relationships Among Legends. Overlays. and Redraw 

An additional comment about Redraw: if the Units Shipped overlay 
attempt had been off-scale, a Redraw would have redrawn the Revenue 
data points but would have wiped out the Revenue title. 

DISPLAYING TWO CHARTS AT ONCE 

The data you used for the pie charts can also be shown in a different 
form. The Before and After series contain the same data as the North, 
West, South, and Central series. Before contains three data points 
representing the sales figures for a three region division. After contains 
four data points representing the same sales figures for a four sales 
region division. 

It is often desirable to show before and after data at the same time, in 
two different charts. The Window function in the Plot menu divides the 
screen into two parts. You can draw different charts in each window. You 
can put any kind of chart into the windows except the pie chart. A pie 
chart requires the whole screen. 
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The Window menu gives you the choice of dividing the screen into 
side-by-side or top-and-bottom sections. This example uses top-and­
bottom sections. The Window menu also lets you switch between win­
dows and return to single window format. 

The top window is active if you select Horizontal windows and the left 
window is active if you select Vertical windows. 

When you switch between windows, you lose the current active series 
and option data for the window you are leaving. When you return to the 
window, you must start over if you want to change an option and Plot the 
chart again. 

Figure 2-84. Sample Window Charts 

Beginning from the Select menu: 

None ~ 

Window ~ 

Horizontal ~ 

Bar ~ 

Full ~ 
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Before ~ 

Plot ~ 

Esc 

Window ~ 

Switch ~ 

Bar ~ 

Full ~ 

After ~ 

Plot ~ 

LESSON FIVE 

When you are working in one of the windows, the window is indicated 
by a code on the extreme right end of the bottom status line. The code is 
W for window, and T for top or B for bottom. If you use side-by-side 
windows, the codes are R for right and L for left. 

Legends are not included in charts drawn with the Window function. 
You must create any legends with the Title functions. You can include the 
meaning of the numbers in the legend, or replace the numbers with 
names, or put in meaningful abbreviations such as N, W, S, and C for 
North, West, South, and Central. 

There are two ways to return to the single window format: select New 
from the Plot menu or None from the Window menu. 

CREATING ANNOTATION ON CHARTS 
AND TEXT PAGES 

Suppose you have created a chart on the screen, and you would like to 
use it in a management report or in a slide presentation. The chart itself 
might need some enhancements, such as an extra-large title and dif­
ferent X-axis labeling. You'd also like to support it with a page of sup­
plementary information. You could use the Title option to make some of 
these enhancements, but not all of them. Another VisiTrend/Plot pro­
gram feature, the Text function, does everything that the Title function 
does and more. Text allows you to place text in various styles anywhere 
on a displayed chart. It also allows you to create entire pages of text, and 
to combine a chart on the same page with text. 
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A slide presentation example is a good way to introduce you to the 
features of the Text function and give you some practice using them. You 
are going to enhance an existing chart and create a page of supplemen­
tary notes in support of the chart. 

The existing chart, shown in Figure 2-85, is located on the example 
disk in a file named ACME1.PIX. Beginning from the Plot menu: 

Screen ~ 

Load ~ 

ACME1,PIX. 

012-074/P 

Figure 2-85. Chart For Text Exercise 

You will make several changes on this chart. They can all be made with 
the Text option. 

Press Esc, move the cursor to Text, and press ~. The status area is 
erased, and a white rectangular block cursor appears in the upper-left 
corner of the screen. You can move the block cursor anywhere on the 
screen with the arrow keys. Table 2-5 lists the commands available to you 
in the Text option. 
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Table 2-5. Text Commands 

Function 

Change cursor movement (course/fine) 
Move cursor up 
Move cursor down 
Move cursor left 
Move cursor right 
Move cursor 5 places right 
Move cursor to beginning of next line 
Erase character 
Turn onloff large type 
Turn onloff bold face 
Turn onloff inverse video 
Clear screen 
Return to Plot Menu 

LESSON FIVE 

Command 

Ctrl-Z 
i 
~ 

[TAB] 
~ 
Space Bar 
Ctrl-F 
Ctrl-B 
Ctrl-R 
Ctrl-Home 
Esc 

Before changing the chart, take a few minutes to experiment with mov­
ing the cursor. The ~ key and - key move the cursor one space to the 
right and one space to the left, respectively. ~ moves the cursor to the 
beginning of the next line. (In Text operations, the ~ key works like it 
does on a typewriter.) i moves the cursor up one line, and ~ moves the 
cursor down one line. These cursor movement keys are the only way that 
the cursor can be moved into the chart without blanking out anything. 
Using the space bar and BKSP to move the cursor erases the screen at 
that space. 

When you are familiar with the cursor movement keys, move the cur­
sor back to the upper left-hand corner of the screen. Take a look at 
Figure 2-86. It shows what the chart will look like after you change it. 
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Figure 2-86. Chart Changed With Text 

The first change consists of titling the chart in large font letters. To 
turn on the large font, press Ctrl-F. The title has to be centered on the 
chart, so press -+l enough times toget the cursor in the correct position. 
Now type ACME INC. SALES AND EARNINGS. 

Press ~ twice to skip a line. Type 1982 centered under ACME INC. 
SALES AND EARNINGS. You won't need any more large font letters in 
this exercise, so turn off the large font by pressing Ctrl-F again. 

Next change Thou on the Y-axis with the scale value 250. To do this 
you must first erase Thou, then type 250 in its place. Move the cursor as 
close to the T in Thou as possible using the arrow keys. Now press the 
space bar enough times to erase Thou. Be careful that you don't erase the 
tip of the Y-axis. You may see some residue. If so, you have to position 
the cursor so that the space bar erases the residue when it is 
pressed again. 

If the cursor does not line up exactly where you want it, press Ctrl-Z. 
When you press one of the arrow keys withCtrl-Z in effect, the cursor 
moves only a tiny fraction of the normal cursor movement. Practice mov­
ing it around now. 

As soon as the cursor is where you want it, press Ctrl-Z again. Normal 
cursor movement is again in effect. After erasing the Thou, type 250 in 
its place. 
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Next, add a vertical label along the left side of the Y-axis. The label 
reads "Thousands of Dollars" to explain the abbreviated Y-axis values. 
Move the cursor to the beginning of the top line, and type T. Press ~. 
Type the remainder of the word down the side of the screen. 

Now you can expand the letter abbreviations along the X-axis. Move 
the cursor to the line containing the letter abbreviations. Replace the 
single letter abbreviations by writing over them. Use Ctrl-Z to posi­
tion the cursor over the existing letter before entering the expanded 
abbreviations. 

The last change is to modify the legend. It is necessary to erase the 
existing words in the legend first, then type over them. Be careful to 
erase only the words in each legend item. If you accidentally erase a 
plotting symbol, the only way to restore it is to reload the chart. This 
destroys all the changes you've made so far. 

Erase the words in the legends. Again use Ctrl-Z to position the cursor 
over the first letter. Press the space bar repeatedly until the words are 
erased. Now type = Sales and = Earnings to the right of the plotting 
symbols. Use Ctrl-Z to position the cursor. 

You've now completed enhancements on the loaded chart, and the 
screen should look like the photograph in Figure 2-86. 

To save this chart you must exit the Text function and store the chart on 
a disk file. Press Esc to exit the Text function and redisplay the Plot menu. 
When the Plot menu returns: 

Screen ~ 

Save ~ 

[NEW FILE] ~ 

Enter Slidel ~ 

As soon as the screen has been saved on disk, the Plot menu reap­
pears. Select Text again. 

The modified chart is still on the screen and must be erased before you 
can continue. Press Ctrl-Home to erase the screen. The only thing you 
should see on the screen now is the block cursor in the upper-left corner. 

The next exercise gives you practice in using the Text function to 
create a text-only page. The page you are going to create will look like 
Figure 2-87 when you have completed the exercise. 
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Figure 2-81. Page of Text for Exercise 

To create the page of notes shown in the preceding photograph, you'll 
be using most of the same Text features that you used to enhance the 
Sales and Earnings chart. You'll also be using two new features: boldface 
letters and inverse video. 

As the photograph shows, you must center the title at the top of 
the page in large font letters. Not only that, the large font is combined 
with boldface. To create the title as shown in the photograph, follow 
this sequence: 

1. Press Ctrl-F to turn on the large font. 

2. Position the cursor. 

3. Press Ctrl-B to turn on boldface. 

4. Type HIGHLIGHTS and press ~ twice to skip a line after the title. 

The bulleted subtitles are also in boldface letters, but they are normal 
font size. Before typing the first subtitle, press Ctrl-F to return the letters 
to normal font size. The boldface feature remains in effect until you press 
Ctrl-B again. Type 0 for a bullet; skip one space; then type 2nd Half 
Earnings Up 102%. Press Ctrl-B to turn off boldface; then press ~ twice 
to skip a line after the subtitle. Type the three items and the second sub­
title as shown. 

2-122 



IBM PERSONAL COMPUTER 
TUTORIAL LESSON FIVE 

Notice that the first item under the second subtitle shows S300K in 
inverse video and boldface characters. To create this combination, press 
Ctrl-B for boldface and Ctrl-R for inverse video. This sequence is 
arbitrary; features don't have to be combined in any special sequence. 
After you've typed $300K, remember to turn off each feature by pressing 
Ctrl-B and Ctrl-R again. 

"When you've finished creating the text page, store it in a disk file just 
as you stored the chart, with the Save function in the Screen menu. 

In the last two exercises you've learned all the features of the Text func­
tion, and you've seen how some features can be combined for special 
effects. All features of the Text function can be combined with each 
other, as desired. 

FUNCTIONAL SUMMARY 

To From 

Draw multi-line chart Select menu 

Replot previous series Select menu 

Draw comparative bar Select menu 
chart 

Draw stacked-bar chart Select menu 

Draw, shade, and 
title a pie chart 

Select menu 
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Select/Enter 

l. Line 
2. Series names SPACE BAR 
3. Last series name ~ 
4. Plot 

l. Line/Bar/ Area/Pie/High-
Low-Close/XY 

2. [Same] 
3. Plot 

l. Bar 
2. Both 
3. Left series name 
4. Right series name 
5. Plot 

l. Bar 
2. N ormal/Both/Left/Rig h t 
3. Series name SPACE BAR 
4. Last series name ~ 
5. Plot 

l. Pie 
2. Series names SPACE BAR 
3. Last series name ~ 
4. Year or reference number 
5. Segment letter 
6. Original/Black/Fine Gray/ 

Course Gray/White 
7. Y to proceed 
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(Continued) 

To From 

Draw, shade, and 
title a pie chart 

Select menu 

Draw XY chart Select menu 

Recover from off-scale 
overlay. 

Scale 
message 

Display two charts Plot menu 

Annotate charts and 
create text screens 

Plot menu 

Text functions 
Change cursor movement (course/fine) 
Move cursor up 
Move cursor down 
Move cursor left 
Move cursor right 
Move cursor 5 places right 
Move cursor to beginning of next line 
Erase character 
Turn on/off large type 
Turn on/off bold face 
Turn on/off in verse video 
Clear screen 
Return to Plot Men 
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Select/Enter 

8. Title 
9. Add titles 
10. Exit 

1. XY 

TUTORIAL 

2. Series name for X-axis 
3. Series name for Y-axis 
4. Plot 

1. Redraw 

1. Window 
2. Horzontal/Vertical 
3. Line/Barl Area/High-Low-

Close/XY 
4. Series name 
5. Plot 
6. Window 
7. Switch 
8. Line/Barl Area/Pie/High­

Low-Close/XY 
9. Series name 
10. Plot 

1. Text 

Ctrl-Z 
i 
~ 

[TAB] 
~ 
Space Bar 
Ctro-F 
Ctrl-B 
Ctrl-R 
Ctrl-Home 
Esc 
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REFERENCE 
The Reference is designed to let you find specific facts and answer 

special questions quickly and easily. Use it at any time along with the 
lessons or later when you need to refresh your memory about some detail. 

USEFUL FACTS ABOUT PROGRAM OPERATIONS 

The capabilities of the VisiTrend/Plot program are: 

• Memory holds a maximum of 2000 data points or 16 series. 

• A maximum of six legend items can appear on a multi-series plot. 

• A series can contain up to 250 data points. 

• The union of ranges of two or more series can contain up to 250 data 
points. 

• You can select one dependent variable and up to five series as 
independent variables in a linear multiple regression. 

• The intersection of ranges in a linear multiple regression must con­
tain one more data point than there are independent variables; two 
more if a constant is used. 

• An Xform formula cannot exceed 158 characters. 

• A moveable title'is limited to 77 characters. 

KEYBOARD USAGE 

Figure 3-1. The Keyboard 
012-002 
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Most of the keys on the keyboard in Figure 3-1 are self-explanatory. A 
few keys have special uses: 

• The ~ key issues the command indicated by the cursor in a menu, 
selects a list item indicated by the cursor, or enters data typed at the 
keyboard. 

• The Space Bar marks and unmarks list items when multiple selection 
is allowed. In the Text function, the space bar works just like the 
space bar on a typewriter. 

• The - key moves the cursor to the right in a menu. 

• The +- key moves the cursor to the left in a menu. 

• The i key moves the cursor up in a menu or list. 

• The ~ key moves the cursor down in a menu or list. 

• The BKSP key corrects errors during data entry by erasing the last 
displayed character. 

• The Esc key aborts the current operation. It is also used to display or 
erase the menu when a chart is on the screen. It terminates the Text 
function. 

• The Y key is an affirmative response to the prompts to verify your 
request when deleting files, and exiting the pie chart shading 
function. 
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THE STATUS AREAS 

Figure 3-2 shows the Main, Trend, and Plot subprogram status areas 
and their components. 

012-077/P 

012-078/P 

012-079/P 

Figure 3-2. Subprogram Status Areas 

• The long prompt gives a longer description of the menu item to which 
the cursor is pointing. 

• The cursor indicates a menu item. The indicated item is selected if the 
~ key is pressed. 

• The data disk name indicates the drive for the disk that you will load 
data from or store data on (the data disk). 

• The chart type indicates the type of chart that was last selected. 

• The series name indicates the selected series or the first of multiple 
series selected. 

• The window code indicates that the window mode is active and which 
window is selected: top (WT), bottom (WB), left (WL), or right (WR). 

3-3 



IBM PERSONAL COMPUTER 
REFERENCE 

SHADING CODES 

Table 3-1 lists VisiTrend/Plot shades and the codes for each that 
appear in the Plot status area. 

Table 3-1. Shading Codes 

Shade Code 

Original Wh 

Black Bk 

White Wh 

Fine Gray FG 

Coarse Gray CG 

SERIES NAMING CONVENTIONS 

The VisiTrend/Plot program creates several series that are transforma­
tions of existing series. These transformations are modified series pro­
duced by the Trend subprogram. The VisiTrend/Plot program uses the 
name of the source series with a qualifier appended to the end as the 
name of the new series. Table 3-2 lists the qualifiers generated by the 
program and what they mean; 

Qualifier 

.Fnn 

.Rnn 

. Mnn 

.S 

.T 

.% 

. -nn 

. +nn 

RANGES 

Table 3-2. Series Name Qualifiers 

FUDction 

Fitted series 
Residual series 
Moving average 
Smoothed series 
Total series 
Percent change 
Lagging series 
Leading series 

Comment 

nn is program generated number. 
nn is program generated number. 
nn is number of periods averaged . 

nn is number of periods lagged . 
nn is number of periods lead . 

How Range Is Used 
Range is usually the period of time covered by the chart. The 

VisiTrend/Plot program plots range on the X-axis (the horizontal axis). 
The range does not have to be measured in units of time, although it 
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usually is. The range can be a reference number assigned to items; for 
example, the range could be reference numbers representing eight sales 
regions. The VisiTrend/Plot documentation treats most ranges in units of 
time because most ranges are measured in time: daily, weekly, monthly, 
quarterly, or yearly. 

The range has two parts, the major range which is usually expressed as 
years and the minor range or the period. The period divides the range 
into subparts. You can divide the range into any number of parts from 1 
(no division) to 99. Normal uses of the period are to divide the year into 
months (12 parts), quarters (four parts), or weeks (52 parts). The use of 
both the major and minor range is up to you. The major range can be 
days or weeks or months; it does not have to represent years. Likewise, 
the period can represent any division you want it to represent. 

How to Calculate the Range 
The range is calculated before each plot from the date information in 

the selected series. The range for a single series is the time from the start 
date to the end date. 

The calculated range for multiple series depends on the type of chart 
being plotted. Line and area charts use the union of the individual 
ranges. That is, the start date for the chart is the earliest start date in the 
selected series and the end date is the latest end date in the selected 
series. High-low-close, bar, and XY charts use the intersection of the 
individual ranges. That is, the earliest date and latest date that are com­
mon to all selected series are used as the range. Figure 3-3 shows the 
relationship between union and intersection of ranges. 

Series A Series B 
Range Range 

1973 
1974 
1975 

Union l:~r------------l:~r--I,ntersection 
!E~ _____________ !~!~ __ _ 

1979 
19BO 
!~~L __________________ _ 

Figure 3-3. Union and Intersection of Ranges 

012·010 

The maximum number of points that can be plotted is 250 and the 
minimum is 2. 

The pie chart is a special case. A pie chart is a comparison of different 
items at a single reference point rather than a comparison of the same 
item at different reference points. 
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How to Change the Range 
The VisiTrend/Plot program always determines a range for whatever 

series are being plotted. There are circumstances where you may want to 
limit that range. The range you specify must have at least two data points 
and no more than 250 data points. It must also have at least two data 
points in common with the selected series. 

The Range function in the Options menu allows you to change the 
program-calculated range. 

SCALES 

Scale is the scope of values plotted on the Y-axis (vertical axis). The 
scale is totally dependent on the data being plotted. It may be positive, 
negative, or span the zero point. Its increments may be in units from frac­
tions to a number of the 38th power. 

How to Calculate the Scale 

The program selects a range of values that encompasses the highest 
and lowest values in the series. This range is rounded up or down to 
values that are round and even. It then sets a number of divisions that 
result in round and even labels when possible. 

The VisiTrend/Plot program usually does a satisfactory job of figuring 
out a good scale for your data. If you desire a scale other than the one the 
program generates, you should use the Rescale function in the Options 
menu to obtain more meaningful Y-axis labels. 

You must enter data in decimal notation as opposed to exponential 
notation. The program displays large and small numbers in exponential 
notation and speCifies a scaling factor at the top of the Y-axis. 

How to Change the Scale 
The VisiTrend/Plot program always determines a scale for whatever 

series are being plotted. In some circumstances you may want to expand 
or limit that scale. 

The Rescale function in the Options menu lets you change the 
program-calculated scale and the number of divisions. To choose the 
number of divisions, subtract the low end-of-the-scale value from the 
upper-end value and pick a number of divisions that divide evenly into 
that value. 
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THE VISITREND/PLOT MENU FUNCTIONS 

This section describes the VisiTrend/Plot menu functions in 
alphabetical order. It lists the subprogram in which the function is used 
and the menu in which it is found. 

The menu flow diagrams in Figures 3-4, 3-5, and 3-6 show how to get to 
the various menus in each program. 

Flow between the subprograms is via the Plot, Trend, and Main 
options. You can call any subprogram to either of the others. 

Main 
Storage 
Management 
Subprogram 

Initial 
Load 

Jump Specs Undo Fill 
Insert Format Edit Exit 
Delete Print 

Figure 3-4. Main Subprogram Flow 

Main 

Trend 
Subprogram 
IT rend Menu) 

Plot 

Figure 3-5. Trend Subprogram Flow 
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Plot 
Subprogram 

Clear 

Moving-Average 
Smoothing 
Percent-Change 
Difference 
Lag 
Lead 
Total 
Exit 
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Full 
Both 
Left 
Right 

Horizontal 
Vertical 
Switch 
None 
Exit 

Print 
Driver 
Davice 
Configuration 
Exit 

Top 
First 
Second 
Third 
Side 
Legend 
Moveable 
Exit 

Set 
Clear 
Exit 

USER'S 
GUIDE 

Bar 
Line 
Area 
Pie 
Hi-Lo-Cl 
XV 
None 

Load 
Save 
Device 
Exit 

Title 
Range 
Format 
Grid 
Unlabel 
Rescale 
Background 
Shade 
Exit 

Symbols 
Lines 
Points 
Both 

Both 
Horizontal 
Vertical 
Exit 

Dutlina 
Shaded 
Solid 

IBM PERSONAL COMPUTER 

Cancel 
Main 
Trend 

Original 
Black 
Fine Gray 
Coarse Gray 
White 

REFERENCE 

Main Subprogram 
Trend Subprogram 

012-013 

Figure 3-6. Plot Subprogram Flow 
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Analyze (Trend subprogram- Trend menu) 
The Analyze option displays the Analyze menu. The functions in the 

Analyze menu list series contents, calculate and display series statistics, 
perform data regressions and trendline forecasting, and format data. For 
information on the specific functions see Format, Regression, Statistics, 
and Table. 

Area (Plot subprogram - Select menu) 
The Area function specifies that an area chart is to be drawn. You must 

choose one or more series. When choosing multiple series, all series 
must have the same period. When multiple series are plotted, each series 
is drawn over the previous series. You should select the series with the 
largest values first, then the next largest, etc. If the series have mixed 
values, you will not get full detail for either series. In this situation, use 
the Overlay function to draw a line chart of one of the series. All area 
charts are plotted from the base line; they are not stacked. 

Arithmetic (Main subprogram - Fill menu) 
(Trend subprogram - Fill menu) 

The Arithmetic function inserts new data into the current series begin­
ning at the location of the cursor. The new data is an arithmetic progres­
sion. You are prompted for the number of points to be inserted and the 
factor by which the preceding point is to be increased or decreased. The 
new data points are inserted immediately following the data point cur­
rently indicated by the cursor. 

Background (Plot subprogram - Options menu) 
The Background function sets the background shade of the plot. 

Background can be used with all chart types except a pie chart. This 
function displays a menu that gives you these choices: black, white, 
original shade, fine gray, and coarse gray. 

The program displays the code for the shade in the lower-right corner 
of the status area. Two shades are listed; the first is the plotting shade and 
second is the background shade. 

The Background shade is retained until it is explicitly changed with 
the Background function or until it is reset with the New function. 

When you change the background shade, the VisiTrend/Plot program 
changes the plotting shade to avoid using the same shade for 
background and plotting and to provide a clear, readable plot. 
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Table 3-3 lists the plotting shades the program uses for the various 
background shades. The following plotting shades apply if the 
background shade was selected last. 

Table 3-3. Plotting Shades Generated by Background 

Line 

Selected First Second Third 
Background Shade Shade Shade 
Shade (and 4th) (and 5th) (and 6th) 

Original White White White 
Black White White White 
Fine Gray Black Black Black 
Coarse Gray Black Black Black 
White Black Black Black 

Area and Bar 

Selected First Second Third 
Background Shade Shade Shade 
Shade (and 4th) (and 5th) (and 6th) 

Original White Fine Gray Coarse Gray 
Black White Fine Gray Coarse Gray 
Fine Gray Black Coarse Gray White 
Coarse Gray Black Fine Gray White 
White Black Coarse Gray Fine Gray 

Bar (Plot subprogram - Select menu) 
The Bar function specifies that a bar chart is to be drawn. You must 

choose one or more series. When choosing multiple series, all series are 
plotted; the bars for the various series are stacked on top of each other. 
That is, the first series is plotted on the base line and subsequent series 
are plotted from the top of the existing bars. The series are plotted in the 
order in which they are chosen. 

When selecting a bar chart, you have the choice of full-width bars 
centered on the tick marks, or half-width bars located to the left or right 
of the tick marks. The half-width bars are normally used to draw com­
parison charts. 

No zero line is drawn for bar charts with negative values. Negative 
values can be plotted but a zero line is not drawn on the screen. 
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Bar-chart bars are displayed in one of three formats: solid, outlined, 
and shaded (outline plus horizontal stripes). 

Bold (Plot subprogram - Title menu) 
The Bold function specifies that the subject title be displayed in bold 

characters. The alternatives to bold titles normal and inverse titles. 

Both (Plot subpl>ogram-Barl Formatl Gridl 
and Unlabel menu) 

The Both function specifies that both of the subject items are to be used 
or deleted. In the Bar menu, Both means a left bar and a right bar will be 
plotted at each major tick mark. The bars will be different shades. In the 
Format menu, Both means that plotting symbols and lines are used for 
line charts. In the Grid menu Both means that horizontal and vertical 
grid lines are drawn on the chart. In the Un label menu Both means that 
horizontal and vertical labels will be erased from the chart. 

Cancel (Plot subprogram - Data off-scale condition) 
(Plot subprogram - Moveable title) 
(Plot subprogram - Exit menu) 

When the message about data off-scale appears during an attempted 
Plot, you may select Cancel. Cancel cancels the Plot request and 
returns to the Plot menu without destroying the previous chart. For a bar 
chart, the plot cancels when the first off-scale data point is encountered. 

In the Moveable Title menu Cancel erases the title and returns to the 
Title menu. 

When Exit is selected from the Plot menu, you can transfer directly to 
the Main menu, to the Trend subprogram, or back to the Plot sub­
program. Cancel cancels the Exit request and returns the Plot menu. 

Clear (Main subprogram - Main menu) 
(Trend subprogram-Main menu) 
(Plot subprogram-Options menu) 

In the Main and Trend subprograms, the Clear function erases 
selected series from memory . You can select all, none, or specific series 
to be erased. This function does not affect the files stored on disk. 

In the Plot subprogram, the Clear function specifies that the range 
values you defined are to be disregarded and the range values stored 
with the series are to be used. This function has no effect if you did not 
define a range. 
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Configuration (Plot subprogram - Print menu) 
The Configuration function lets you select the printer driver and the 

printer used by the program. This option performs the same function as 
the Driver and Device options except that the selections made with this 
option remain in effect while the Driver and Device options are only 
effective for the duration of the current VisiTrend/Plot session. 

Continue (Main subprogram-various menus) 
(Trend subprogram - various menus) 

The Continue function is used in several functions that display data on 
the screen. If there is more data to be displayed, the Continue function 
displays the next screenfull. When the last screen is displayed, Con­
tinue exits the function and displays the next menu. 

Delete (Main subprogram-Edit menu) 
(Main subprogram-Files menu) 
(Trend subprogram-Edit menu) 

In the Edit menu, the Delete function deletes selected data points from 
the series being edited. The deletion begins at the item indicated by the 
cursor position when the function begins. The deletion ends at the item 
you select with the cursor after initiating the function. All data points 
between and including the beginning and ending points are deleted. 
T4e cursor can be moved up or down on the list. 

In the Files menu, the Delete function deletes selected files from the 
data disk. You select the file to be erased from the list of files. Before the 
file is erased, you are asked to confirm that you want to permanently 
erase the file. 

Device (Main subprogram-Main menu) 
(Plot subprogram - Screen menu) 

The Device function changes data disk drive. The currently assigned 
drive name is displayed in the bottom line of the status area. The 
remainder of the screen contains a list of available drives. To change the 
drive move the cursor to the desired entry and press ~. 

Device (Plot subprogram - Print menu) 
The Device function changes the printer. The function displays a list 

of the printer and communications cards installed in the computer. To" 
change the printer move the cursor to the desired device and press ~. 
This function only changes the printer for the current session, use the 
Configuration option to permanently change the printer selection. 
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DIF (Main subprogram-Main menu) 
The DIF (Data Interchange Format) function specifies that the series 

being saved is to be stored in a DIF file. Data in this format can be used 
with other VisiCorp programs, such as the VisiCalc program, that sup­
port the DIF format. The alternative is the Normal format, which is only 
usable by the VisiTrend/Plot program. 

The DIF format is described in Programmer's Guide to the Data 
Interchange Format, document number SATN-18, which is available 
from the DIF Clearinghouse, P.O. Box 527, Cambridge, MA 02139. 

Difference (Trend subprogram - Function menu) 
The Difference function computes the difference between adjacent 

data points in the source series. The Difference function lists the series 
currently in memory. From that list you can select one series for a Dif­
ference operation. This function creates a new series with the name of 
the source series and .D appended to the end. 

Display (Main subprogram-Main menu) 
(Trend subprogram- Trend menu) 

The Display function lists the data series currently in memory. The 
display includes the series name, period, start date, end date, and 
number of data points in the series. Selecting Return returns to the Main 
menu or Trend menu. Selecting Print prints this display. The program 
displays this list after each Load and Clear. 

Driver (Plot subprogram - Print menu) 
The Driver function in the Print menu allows you to change the printer 

driver used for graphic printing. The change is made by selecting a 
driver from the list of drivers. You can also specify automatic line feeds 
in the Driver function. The changes made in the Driver function remain in 
effect until changed or the end of the current VisiTrend/Plot program 
session. 

Edit (Main subprogram-Main menu) 
(Trend subprogram- Trend menu) 

The Edit function invokes the Edit facilities. You are prompted to select 
a series from those currently in memory or to create a new series. When 
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creating a new series, you are prompted for the name, period, starting 
date, and first data point. See also the following Edit commands: 

Delete 
Exit 
Fill 
Format 

Jump 
Print 
Specs 
Undo 

Exit (Plot subprogram - various menus) 
(Trend subprogram - various menus) 
(Main subprogram-various menus) 

The Exit function leaves the current menu without performing a func­
tion. Usually, the Exit function returns to the preceding menu. In the Plot 
menu it displays the Transfer menu, providing the option of going to the 
Trend or Main subprogram. 

Files (Main subprogram-Main menu) 
The Files function displays the Files menu from which you can format a 

disk, delete a file from a disk, or return to the Main menu. See Format, 
Delete, and Exit. 

Fill (Main subprogram - Edit menu) 
(Trend subprogram-Edit menu) 

The Fill function displays the Fill menu. From this menu you can 
generate data to be placed in the series being edited. The data can be an 
arithmetic series, a geometric series; or a series currently in memory. 
You are prompted for the number of values and a factor by whIch to 
increase or decrease the series. If the data is to be another series, you 
select the series from a list of series in memory. In all cases, the new data 
is inserted following the item currently indicated by the cursor. Fill also 
provides a linear interpolation function to approximate missing data 
points. See Arithmetic, Geometric, Insert, and Interpolation. 

First (Plot subprogram - Title menu) 
The First function, like the Second and Third functions, specifies the 

titles at the bottom of the chart. First specifies the first bottom-title line. 
Table 3-4 lists the maximum title lengths for the differert fonts and title 
locations. This title is centered across the bottom of the chart. If the @ 
symbol is typed as the last character in the title, the title will be left­
justified. You must choose between bold typeface, normal typeface, and 
inverse video in the titles. The bottom titles cover the legend lines. 
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Table 3-4. Maximum Title Lengths 

Location Typeface 

Left Centered Bold Normal or Inverse 

X X 
X X 

X X 
X X 

Format (Main subprogram-Edit menu) 
(Main subprogram ...... Flies menu) 
(Trend subprogram-Edit menu) 
(Trend subprogram-Analyze menu) 

Maximum 
Length 

73 
58 

77 
64 

In the Edit menus and the Analyze menu, the Format function 
specifies how data is displayed on the screen. Unless otherwise 
specified, data is displayed in the floating decimal-point format. In the 
fixed format, you can specify the precision (number of digits to the right 
of the decimal point, from 0 to 6), and the column width (total number of 
characters used to display the number, from 6 to 16 characters). 
Numbers that are too large or too small for the column width and preci­
sion are displayed as greater-than symbols (». Very large and very 
small numbers that require an exponential format display (le-8, for 
example) are displayed as (> > > » in the fixed format. You cannot 
enter values in the exponential format; the program displays numbers 
less than .000001 and greater than 7 digits to the left of the decimal point 
to the exponential format. The range of values accepted by the program 
is from 1.175495e-38 to 3.402823e + 38. 

In the Files option menu, Format allows you to format a disk for use 
with the program as a data disk. You are asked to insert the disk to be for­
matted in the data disk drive. The VisiTrend/Plot program allows you to 
cancel the Format operation even after a disk has been inserted. Never 
Format a program disk or the example disk. 

Format (Plot subprogram-Options menu) 
The Options menu Format function specifies how a line, bar, or XY 

chart is to be displayed. This function is not available for area, pie, and 
high-low-close charts. It displays a different menu for each chart. When 
the function is chosen for an unsupported chart, a error message is 
displayed. 

The line-chart and XY -chart Format menus allow the choice of plotting 
with symbols only, lines only, points only, or both symbols and lines. 
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The bar-chart Format menu allows the choice of plotting with solid, 
shaded, or outlined bars. 

The chart format is retained until you change it with the Format func­
tion, or until you select a different type of chart, or until you choose the 
New function. 

Full (Plot subprogram - Bar menu) 
The Full option draws full-width bars centered on the tick marks. 

Function (Trend subprogram - Main menu) 
The Function option displays the Function menu. The Function menu 

options calculate the moving average, do exponential smoothing, 
calculate the percent change, create new series with a specified lead or 
lag from an existing series, and create a new series with the cumulative 
total of the source series. For further information on these functions see 
Moving-Average, Smoothing, Percent-Change, Lag, Lead, and Total. 

Geometric (Main subprogram-Edit menu) 
(Trend subprogram-Edit menu) 

The Geometric function inserts new data into the series begin editied 
in a geometric progression. You are prompted for the number of data 
points to be generated and for the factor by which each preceding point 
is to be multiplied. The data points are inserted immediately following 
the data point indicated by the cursor. 

Grid (Plot subprogram - Options menu) 
The Grid function draws grid lines on the displayed chart. The func­

tion is valid for all charts except pie charts. It offers the choice of ver­
tical, horizontal, or both grid lines. You can erase grid lines by selecting 
them a second time. For example, to erase horizontal grid lines, select 
horizontal grid lines again. You can erase horizontal, vertical or both. 
You cannot select this option until a chart is displayed. 

Hi-Lo-CI (Plot subprogram - Select menu) 
The Hi-Lo-CI function lets you draw a high-low-close chart. You are 

prompted to select the high series, the low series, and the close series. 
When prompted for the close series, you can select None instead. You 
cannot generate high-low-close charts with multiple sets of series. A 
high-low-close chart is displayed as a series of vertical lines connecting 
the high and low values. The vertical lines are not connected from time 
period to time period. 
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Horizontal (Plot subprogram - Grid, U nlabel, 
and Window menus) 

In the Grid menu, the HOrizontal function specifies that horizontal grid 
lines are to be drawn. If horizontal grid lines already exist, this function 
erases them. 

In the Unlabel menu, the Horizontal function specifies that the 
horizontal range labels (X-axis) are to be erased. 

In the Window menu, the Horizontal function specifies that the screen 
is to be divided into top and bottom windows as opposed to side-by-side 
(Vertical) windows. 

Insert (Main subprogram - Edit menu) 
The Insert function inserts a new data point anywhere within the series 

being edited. The new point is inserted immediately preceding the data 
point under the cursor. The points that follow this point are pushed ahead 
to the next year and/or period. The last point in the series is given a new 
end date one period beyond the old end date. 

Interpolate (Main subprogram - Edit Fill menu) 
(Trend subprogram - Edit Fill menu) 

The Interpolate function performs a linear interpolation of the values 
beginning at the value immediately preceding the cursor and continuing 
to the first non-zero value after the cursor. The cursor must be on a zero 
value. The function replaces the zero values with the interpolated values 
between the two values. If the cursor is not located at a zero value, the 
function is canceled. 

Inverse (Plot subprogram - Title menus) 
The Inverse function can be used after a title created with the Title 

menu functions. Selecting Inverse displays the title in inverse video on 
the screen. The alternatives to this option are Bold and Normal 

Jump (Main subprogram- Edit menu) 
(Trend subprogram - Edit menu) 

The Jump function moves the cursor to a specific date in the series 
being edited. You are asked for the date, t, or t With the arrow keys you 
can move the cursor to the beginning (t) or end U) of the series. 
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Lag (Trend subprogram-Function menu) 
The Log function creates a new series that lags the source series by a 

specified number of periods. The lagging series has the same values as 
the source series but they are shifted forward in time. The lagging series 
name is the same as the source series with \\. - nn" appended to it, where 
nn is number of periods lagged. For example, a series that lags the series 
PE RATIO by 2 periods is given the name PE RATIO. - 02. Figure 3-7 
shows the effect of the Log function. You are prompted for the source 
series and for the number of periods that the new series is to lag by . 

... _ ..... _-a._ ..... __ ..... _ ... Lagged Series 

Feb I Mar I Apr I May I Jun 012-006 

Figure 3-7. Lag Function 

Lead (Trend subprogram-Function menu) 
The Lead function creates a new series that leads the source series by 

a specified number of periods. The leading series has the same values as 
the source series but they are shifted backward in time. The lead series 
name is the same as the source series with \\. + nn" appended to it, where 
nn is the number of periods of lead specified. For example, a series that 
leads the series PE RATIO by three periods is given the name PE 
RATIQ. + 03. Figure 3-8 shows the effect of the Lead function. You are 
prompted for the source series and for the number of periods the new 
series is to lead by. 
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I Jan I Feb I Mar I Apr May 

Source 
..... ,.... ....... "'7"'" ....... ...,.--1.....,_ ..... ,.... ... Series 

I Dec I Jan I Feb I Mar I Apr 

Figure 3-8. Lead Function 

Left (Plot subprogram - Bar Chart menu) 

012-007 

The Left option specifies that half-width bars are to be drawn and 
placed to the left of the tick marks. Left, along with Right can be used for 
comparative-bar charts. 

Legend (Plot subprogram - Title menu) 
The Legend function redisplays the chart legend after it has been 

erased by a bottom title. This function erases all bottom-title lines that 
covered legend lines. Bottom-title lines that did not cover a legend line 
are not erased. With a pie chart, Legend erases the pie chart legend. 
Once the pie chart legend is erased, it cannot be redisplayed without 
redrawing the entire chart. 

Most legend items contain a legend type code, plotting symbol for the 
corresponding series, and the name of the corresponding series. XY 
charts, without overlays, only display the series name along the 
appropriate axis. The legend type codes are as follows: 

A Area chart 

B Full bar chart 

BL Bar left chart 

BR Bar right chart 

Cl Close data on a high-low-close chart 

Hi High data on a hiqh-low-close chart 

L Line chart 

Lo Low data on a high-low-close chart 
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X X-axis series on an overlaid XY chart 

Y Y -axis series on an overlaid XY chart 

Line (Plot subprogram - Select menu) 
The Line function lets you draw a line chart. You must choose one or 

more series. All series must have the same period. The program uses dif­
ferent symbol when drawing multiple series. The first uses the square, 
the second uses a triangle, the third uses the number sign, the fourth 
uses the asterisk, the fifth uses the plus sign, and sixth uses an X. If more 
than six series are selected, the three symbols are reused. The legend 
lists the names of the first six series and the symbol used for each. 

Lines (Plot subprogram-Format menu) 
The Lines function specified that Line or XY charts be drawn with lines 

only (no symbols). This Format menu function is only valid for Line and 
XY charts. 

Load (Main subprogram - Main menu) 
The Load function loads a file from disk. Files contain one or more 

series. You select a file name from the list of files on the data disk. 

As many series from the file as can be put into memory are loaded. 
This type of partial load only occurs with files stored in the normal 
VisiTrend/Plot storage format. When loading from a DIF format file, one 
point from each series is loaded until the 2000 data point limit is reached. 

Load (Plot subprogram-Screen menu) 
The Screen menu Load function displays a list of the screen image 

(.PIX) files on the data disk. The selected file is displayed on the screen 
from which you can enhance it with the Text or Title functions, put it 
back on disk with the Screen menu Save function, or print it with the 
Print function. 

Main (Plot subprogram-Exit menu) 
(Main subprogram - Files menu) 
(Trend subprogram - Main menu) 

The Main function exits the Plot and Trend subprograms and returns 
to the Main subprogram. The series in memory are kept during these 
transfers. 
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Moveable (Plot subprogram - Title menu) 
The Moveable function places titles anywhere on the chart. A 

moveable title is limited to 78 characters (62 when displayed in bold), 
and is initially displayed near the center of the chart. You can put as 
many moveable titles on the chart as you want. 

As the name implies, the title can be moved to any location on the 
screen. Movement is controlled by the i, ~, +-, and ~ keys. The arrows 
on these keys indicate the direction they move the title. 

The number keys, 1 through 9, increase the distance of title movement 
each time an arrow key is pressed. The higher the number the farther the 
title travels. Initial movement is at the 2 rate. 

Pressing ~ after positioning the title displays the Moveable Title menu 
appears that offers typeface options. Bold displays the title in boldface, 
Inverse displays it in black letters on a white background, and Normal 
allows you to change back to the normal typeface after selecting Bold or 
Inverse. Selection of Bold, Inverse, or Normal before exiting the 
Typeface menu does not fix the title. 

Cancel erases the title on the chart and returns to the main Title 
menu. The chart is unaffected unless Normal, Bold, or Inverse are 
selected before Cancel. 

Selecting Exit fixes the title in place then returns to the Title menu. 
After a title is fixed in place, it can be erased with the Text function or by 
a mask created with the Moveable title function. The mask consists of 
blank spaces bounded by periods. When this mask is positioned over a 
title, and fixed in place, the title and the periods are erased. 

Moving-Average (Trend subprogram-Function menu) 
The Moving-Average function calculates an N + 1 moving average of 

a specified number of points within a selected series. The function asks 
you to select the source series and to specify the number of periods over 
which the moving average is to be calculated. The number of periods 
must be in the range 1 through the number of data points in the source 
series. The new series containing the moving average has the name of 
the source series with \\ .Mnn" appended to it. nn is the number of periods 
over which the average is calculated. For example, if you specify a mov­
ing average over three periods for the series DIVIDENDS, the new series 
is named DIVIDENDS.M03. 
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Figure 3-9 shows a source series and a moving period over three 
periods... 

Figure 3-9. Moving-Average 

Name (Main subprogram - Edit Specs menu) 

012·056/P 

The Name function changes the name of the series being edited. 

New (Plot subprogram-Plot menu) 
The New function clears the screen. It resets all options you have set 

and unselects series. New resets the default plotting and background 
shades. It returns to single window operation if two windows are set. The 
New function returns to the Select menu. 

None (Plot subprogram - various menus) 
The None function exits from a list without making a selection. None 

usually returns to the menu from which you called the current menu. 

Normal (Plot subprogram - Title menu) 
(Main subprogram-Save menu) 

In the Title menu, selecting Normal displays the subject title in the 
n.ormal typeface, as opposed to bold or inverse video typefaces. 

In the Save menu, selecting Normal stores a series in the normal 
VisiTrend/Plot storage format, as opposed to the DIF format. In the 
normal format, the data can only be used with the Plot subprogram. The 
VisiPlot storage format is described in Appendix C. 
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Options (Plot subprogram - Plot menu) 
The Options function displays the Options menu which lets you 

change plotting and formatting values such as range, scale, 
background, and format. It also adds titles to a chart. For more informa­
tion see Title, Range, Format, Grid, Unlabel, Rescale, Shade, and 
Background. 

Original (Plot subprogram-Shade menu) 
(Plot subprogram - Print menu) 

The Original option in the Shade menus returns the background and 
plotting shades to the initial program-selected shades, black and white 
(Bk.Wh). If you have not changed the shades, this option has no effect. 
When used with the Background function, Original changes both the 
background and the plotting shade. Used with the Shade function, it 
changes only the plotting shade to white (Wh). 

Overlay (Plot subprogram-Plot menu) 
The Overlay function draws a chart on top of an existing chart, unlike 

the Plot function which erases the existing chart before drawing a new 
one. Overlay does not compute range or scale values; it uses the existing 
values of the current chart. If the chart to be overlaid does not fit in the 
existing range and scale, an error message is issued and you have the 
option of proceeding or canceling overlay. 

You _must display a chart before you use Overlay. 

The overlying chart must have the same period as the existing chart. 
You cannot change the Range, Scale, or Background between a Plot 
and an Overlay. 

If you follow an Overlay function with a Plot function, only the last 
selected series is drawn; that is, the series selected for the last Overlay, 
not for the original Plot or any previous Overlay. 

You can overlay all types of charts except pie charts. You can mix 
chart types-except pie charts and XY charts-with the Overlay 
function. 

Percent-Change (Trend subprogram - Function menu) 
The Percent-Change function calculates the percent of change 

between successive points of a selected series and creates a new series 
containing the percent-change data. The newly created file has the name 
of the source series with ". %" appended to it. For example, if you 
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execute the Percent-Change function on the series named EARNINGS, 
the generated data is put into the series EARNINGS. %. The new series 
has the same period as the source series and a start date one period later 
than the source series. If the source series has the range 1971 through 
1980 and a period of 1, the percent-change series has the range 1972 
through 1980 and a period of 1. 

Periodicity (Main subprogram - Edit Specs menu) 
(Trend subprogram - Edit Specs menu) 

The Periodicity function changes the period of series being edited. The 
display shows what the current period is. You are asked to enter a new 
one. The valid periods are 1 through 99. If you don't enter a new period, 
the existing default (which is listed) is used. If you specify a new period, 
the currently displayed series is erased and redisplayed with the new 
period. The current beginning date is retained. 

The most common periods are 1 (yearly), 2 (twice a year), 4 
(quarterly), 12 (monthly), 30 (daily), and 52 (weekly). 

Pie (Plot subprogram - Select menu) 
The Pie function draws a pie chart. A pie chart is a circle that is 

divided into segments. The size of each segment is determined by the 
ratio of the segment-data value to the sum of all the data values. 

An individual pie chart compares the values of 2 to 16 series at a 
specified date or reference number. It does not compare the different 
values in a single series. (It is possible to do a pie chart for a Single series 
but the resulting chart is a circle, and the single series has a percentage 
of 100%.) \ 

In a pie chart, the segments are drawn in a clockwise direction begin­
ning at 3 o'clock. You are prompted for the date or reference point. Each 
selected series must have a value for the specified date or reference 
point. If some series have very small relative values that result in small 
percentages, the legend letters around the chart may overlap. If this 
occurs, change the order in which the series are selected so that small 
segments are not side by side. 

The pie chart is drawn with a letter outside the segments that cor­
responds to a line in the legend. The legend is to the right of the chart in 
a box that contains the series name and its relative percent of the total. 
The date or reference number of the data is displayed at the bottom of the 
legend. Because of rounding, the percentages listed in the legend may 
not add up to 100%. 
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Pressing ~ displays the shading prompt. You may shade any or no 
segments. All the usual titling capabilities apply. You can erase the 
legend with the Legend function of the Title menu. This use of the 
Legend function applies only to pie charts. Once you have finished 
shading and titling the chart, you cannot alter it. 

Points (Plot subprogram - Format menu) 
Selecting Points causes all subsequent line and XY charts to plotted 

with points only until the format is changed, New is selected, or a dif­
ferent type of chart is selected. 

Plot (Plot subprogram - Plot menu) 
The Plot function plots the currently selected data series according to 

the current options. The Plot function erases an existing chart before it 
draws another one. The error message Please select first is displayed if 
no series is selected. After the chart is drawn, pressing Esc (or any other 
key) returns the Plot menu to the screen. 

Plot (Main subprogram-Main menu) 
(Trend subprogram - Trend menu) 

The Plot function exits the current subprogram and loads the Plot sub­
program. The series in memory is not lost during the transition. 

Print (Plot subprogram - Plot menu) 
(Main subprogram-various menus) 
(Trend subprogram-various menus) 

The Print function reproduces the screen image on the supported 
printer. In the Plot menu it displays the Print menu. For more information 
on the Print menu options see Driver, Device, and Configuration. In the 
other menus it prints the current text screen on the printer. 

Proceed (Plot subprogram - Data off-scale) 
Choosing Proceed draws an off-scale, partial plot. Each time an off­

scale value is encountered, a beep sounds. Drawing is stopped when the 
first off-scale value is encountered. 

Quit (Main subprogram - Main menu) 
The Quit function exits the VisiTrend/Plot program and asks you to 

insert an IBM DOS disk. Remove program disk number 2, insert an IBM 
DOS disk, and press any key. 
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Range (Plot subprogram - Options menu) 
The Range function displays the Range menu. From the Range menu 

you can Set a new range or Clear a range you have previously Set. 
When Set is chosen, it prompts for new starting and ending dates. The 
chart is not redrawn until the Plot function is executed. You also have the 
option to Clear a user-set range. Clear has no effect on the range if you 
have not changed it with the Set option. You also have the option of 
exiting the function. 

See the description of Range for a description of how the VisitrendlPlot 
program sets ranges for different chart types. 

Redraw (Plot subprogram - Data off-scale) 
The Redraw option rescales a chart # you attempt to overlay a series 

with data points out of the current charts scale. This option selects a scale 
that fits the originally plotted chart and the series you were attempting to 
overlay. If other series were overlayed the orignal chart, are not 
included when the chart is redrawn. To include them in the final chart 
you must select and overlay them on the redrawn chart. 

Regression (Trend subprogram - Analyze menu) 
The Regression function calculates an ordinary least-squares linear 

multiple regression, such that: 

y(i) = B +,m(l)xl(i) + m(2)x2(i) + ... + m(5)xs(i) 

You must specify the dependent variable and from one to five indepen­
dent variables from the series in memory. If you select more than five 
series for independent variables, only the first five are used. You are 
asked if you want to keep or change the current range for the selections. 
In a regression, the current range is the intersection of the ranges qf the 
dependent and independent variables. The intersection of the ranges 
must have one more point than there are independent variables, two 
more if a constant is used. Finally, you are prompted to choose whether 
the regression is to be computed with a constant term or through the 
origin (no constant). 

The Regression function can generate a forecast series. This option is 
chosen by selecting [Trend] as the independent variable. You are asked 
to specify the number of periods to be forecast. The function develops a 
straight line series based on the dependent variable. It then extends the 
straight line series the specified number of periods beyond the depen­
dent series. 
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The results of the regression are displayed on the screen. These 
include the name of the dependent variable, the range, and the number 
of data points. For each independent variable, the series name, coeffi­
cient, standard error, and T-statistic are displayed. Below this informa­
tion, the regression statistics are displayed. These are the R-bar squared 
statistic, the corrected R-bar squared statistic, the standard error of 
regression, the sum of the squared residuals, the F -test value of the 
regression, and the Durbin-Watson statistic. When you perform a regres­
sion with one independent variable and no constant, the F -statistic and 
the corrected R-bar squared are undefined. 

After the results of the computations are displayed, you have the 
option of printing the display on a printer. If you do not print them, they 
are discarded. 

If at least two free series are in memory and the data-point limit hasn't 
been reached, you have the option of keeping or discarding the 
generated series. If you keep the values, they are saved under the name 
of the dependent variable with \\. Fnn" appended to the fitted series and 
\\. Rnn" appended to the residual series. n is a program-generated 
number. 

The formulas used by the VisiTrend/Plot program in computing 
regressions are summarized here for your convenience. For additional 
information on these and related formulas, refer to current textbooks 
dealing with econometrics and statistics. 

The values in formulas are defined as follows: 

Let Xj(i) = ith data point from jth independent series. 

m(i) = ith regression coefficient. 

Y(i) = ith data point from dependent series. 

n = number of series data points. 
k = number of regression coefficients to be estimated. 

and let 

[

(0) XI(O) ... Xk - 1(0) J 
"0(1) xl (l) 

X = .. . 

~(n - 1) ~I(n - 1) •.• ~k _ I(n - 1) 

~ I ~ 
d d 

SIS I 

e I e 

I 
I ~ 
I 
I s 

I e 

N # 
1 I I k-1 

3-27 



VISITREN DIPLOT™ ~5T~~s IBM PERSONAL COMPUTER 
REFERENCE 

If you want a constant computed in the regression, then-independent 
series 0 is an artificial series with all data values equal to 1. In this case, 
column 0 of X is all l's. If n>k and (X'X)-l is invertable, coefficient 
estimates 

m(O), ... , m(k-l) 

are given by 

M = (X'X)-l X'Y 

Coefficients for a Trend forecast are computed in exactly this manner 
also. In this case, column 0 of X is an artificial series of all l's, and 
column 1 of X is an artificial series with data values 1, 2, 3, ... , n. 

Regression Statistics: 

1. The standard errors of coefficients are given by 

sCi) = Vdiagi (SER2 (X'X) -1) 

where diag denotes the ith diagonal element of a matrix. 

2. The T statistic is given by 

t(i) = m(i)/s(i}, sCi) =1= 0 

3. If 9(i) denotes the fitted value for the ith dependent data value, i.e. 

k-l 
y(i) = L m(j)xj(i) 

1=0 

then the ith residual is defined to be 

e(i) = y(i) - ~(i) 

The Sum of Squared Residuals (SSB) is then 

n-l 

SSB = E e2(i} 
i = 0 
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4. The Standard Error of Regression (SER) is given by 

SER = ~_1 SSR 
n-k 

5. The Coefficient of Determination R is 

R2 = 1 - ~ (SST*O) 
SST 

n-l 
where SST = 1: (y(i) _ y)2 

i=O 

-where y 
n-l 

~ 'E y(i) t mean of y(i» 
i=O 

6. The Corrected Coefficient of Determination R is given by 

7. The F Statistic is 

F(k-1, n-k) = n-k (~) if R2 =1= 1 and k * 1 
k-1 1-R 

8. The Durbin-Watson Statistic is computed as 

n-l 

~ (e(i) - e(i - 1»2 

DW = if SSR * ° 
SSR 
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Rescale (Plot subprogram-Options menu) 
The Rescale function changes the Y-axis scale established by the sub­

program. The function prompts for a new minimum and a new maximum 
value. It also requests the number of divisions into which the Y-axis is to 
be divided (tick marks). For an XY chart, it also prompts for maximum, 
minimum, and number of divisions for the X-axis. 

If you specify a minimum that is greater than the maximum, the pro­
gram reverses the values. If you specify the same value for the minimum 
and maximum, the program uses the specified value as the minimum and 
sets a maximum that is approximately 20 percent higher. 

See the Scale section for a description of how the program sets scales 
for the charts. 

Return (Main subprogram - various menus) 
(Trend subprogram - various menus) 

When the choice is between Print and Return, the Return function 
returns to the subprogram main menu. 

Right (Plot subprogram - Bar menu) 
The Right function specifies that a bar chart is to be drawn with haIf­

width bars to the right of the tick marks. This function, alo~g with the Left 
function, can be used to draw comparative-bar charts. 

Save (Plot subprogram - Screen menu) 
The Save function stores the screen image in a disk file. The saved 

screen image can subsequently be loaded back onto the screen from 
disk. A list of all screen image files is displayed and you have the choice 
of selecting one of them. Screen image files stored by the Save function 
are given the suffix. PIX. 

Save (Main subprogram-Main menu) 
The Save function writes one or more series to a disk file for perma­

nent storage. You must choose whether the data is to be saved in the 
normal VisiTrend/Plot format or the DIF format. After you select a for­
mat, the function displays a list of the series currently in memory and 
requests that you select those to be saved. It then displays a list of the 
files currently on the data disk. You can choose to store the selected 
series in an existing file or create a new file. If you choose an existing 
file, all the data that is currently in that file is erased and replaced by the 
new series, not just those series with the same name. If you choose to 
store the series in a new file, you are prompted to name the file. If you do 
not specify a name, the SAVE function is canceled. 
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Screen (Plot subprogram - Plot menu) 
(Plot subprogram - Pie chart options) 

The Screen function displays the Screen menu, which loads a screen 
image from a disk file to the screen, saves a screen image on a disk file, 
or specifies which disk drive is the data disk drive. For more information 
see Load, Save, Device, and Exit. 

Second (Plot subprogram - Title menu) 
The Second function, like the First and Third functions, specifies a title 

at the bottom of the chart. Second specifies the second bottom-title line. 
Table 3-5 lists the maximum title lengths for the differert fonts and title 
locations. This title is centered across the bottom of the chart. If the @ 
symbol is typed as the last character in the title, the title will be left­
justified. You must choose between bold typeface, normal typeface, and 
inverse video in the title. The bottom titles cover the legend lines. 

Table 3-5. Maximum Title Lengths 

Location Typeface Maximum 
Left Centered Bold Normal or Inverse Length 

X X 73 
X X 58 

X X 77 
X X 64 

Select (Plot subprogram - Plot menu) 
The Select function displays the Select menu from which you can 

select the type of chart to be drawn. The Select function does not 
eliminate the current active series until a new chart is selected and it 
does not change the current options in effect. You can keep the currently 
active series by choosing None and returning to the Main menu. To 
eliminate the current active series and the current options you have set, 
use the New function to display the Select menu. 

The selected series name is displayed in the bottom line of the Plot 
status area. If you select multiple series, the name of the last one selectee 
is displayed in the status area. 
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Series (Trend subprogram - Fill menu) 
In the Fill menu, the Series function inserts a series from memory into 

the currently displayed series. The new data immediately precedes the 
data point at the cursor. The new data is given the date of the point at the 
cursor. The points that follow are pushed ahead and given new dates 
and/or periods as appropriate. 

Set (Plot subprogram - Range menu) 
The Set function sets a new range for the series. You are asked to enter 

new start and end dates for the new range. The range you set can be 
eliminated with the Range menu Clear function. 

Shade (Plot subprogram-Options menu) 
The Shade function changes the plotting shade used to draw a chart. 

The shading menu offers five selections. 

The program displays the code for the shade in the lower-right corner 
. of the status area. Two shades are listed; the first is the plotting shade, 
and'the second is the background shade. 

The plotting shade is changed when the background shade is 
changed. See Background for a listing of the plotting shades generated 
when Background is used. Table 3-6 lists the shades used for second and 
third selected series when the first plotting shade is selected with the 
Shade option. You can use only two plot shades with the Background 
option, three shades with the Shade option. Shade must be used after 
Background. Multiple plotting shades only apply to multiple selections 
plotted at the same time. The sequence is not carried between plotting 
and overlaying; that is, when a series is overlaid, the shade sequence 
starts over with the first shade regardless of the number of series already 
plotted. 

Table 3-6. Plotting Shades Generated by Shade 

Selected Shade 
(and 4th shade) 

Original/White 
Black 
Fine Gray 
Coarse Gray 
White 

Second Shade 
(and 5th shade) 

Fine Gray 
Coarse Gray 
Coarse Gray 
White 
Fine Gray 
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Side (Plot subprogram - Title menu) 
In the Title menu, Side specifies that a title is to be placed to the left of 

the Y-axis. The side title is written from top to bottom and centered verti­
cally along the Y-axis. The side title is limited to 19 characters. The 
Unlabel function erases the side title. If you have created left and right 
windows, you can put a different Side title in each. In the window mode, 
a single Side title is drawn when top/bottom charts are displayed and 
separate Side titles are drawn when left/right charts are displayed. 

Smoothing (Trend subprogram-Function menu) 
The Smoothing function performs single exponential smoothing of the 

source series . You are asked to select a series from those in memory. You 
must enter a smoothing factor (lambda), which must be between 0 and 1. 
The smoothed series is saved under the name of the source series with 
".S" appended to the name. 

For each data point i in series X and a smoothing factor of lambda, the 
function generates a corresponding point i in series Y according to the 
algorithm: 

Y(i) = A XCi-I) + (1- A )Y(i-1) 

Specs (Main subprogram - Edit menu) 
(Trend subprogram-Edit menu) 

The Specs function changes the specifications of the series being 
edited. The specifications that can be changed are the name of the 
series, the period, and the start date. For further information see Name, 
Per, and Start. 

Start (Main subprogram - Edit Specs menu) 
(Trend subprogram-Edit Specs menu) 

The Start function changes the starting date of the series being edited. 
The series dates are changed immediately and shown in the display. 

Statistics (Trend subprogram - Analyze menu) 
The Statistics function computes the data point count, minumum, max­

imum, mean, varience, and standard deviation one or more series. When 
two or more series are selected, this function also computes and displays 
the correlation coefficients of the selected series. 
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The function uses the following formulas: 

For a series xCi), i = 0, 1, ... , n-l 
n-l 

_! .l:,x(i) 
The mean x = i=:O 

n 

REFERENCE 

n-l 
The population variance (12 = ss where ss = ~- (x(i) - X)2 

n 

The population standard deviation (J 
= ~~ 

The Statistics display is 79 columns wide. If more data than will fit in 79 
columns is selected, some of the data will not be displayed. 

The program prompts you to select one or more series. After selecting 
the series, you have a chance to keep the existing range or change it. If 
you don't change the range, the function uses the intersection of the 
ranges of all selected series. If you change the range, you are prompted 
for major and minor (if applicable) start and end dates. You have the 
option of printing the statistics. 

Switch (Plot subprogram- Window menu) 
The Switch function switches from one window to the other when the 

program is in two-window mode. This function does not affect the chart 
displayed in the current window. The current window designation, which 
is in the lower-right corner of the status area, is changed to show the 
window that is being used. 

When you switch windows, the chart in the window you leave is frozen. 
You can only changes to it with the Title menu options. 

Symbols (Plot subprogram-Format menu) 
The Symbols function draws a chart with plotting symbols alone (no 

interconnecting lines). This function is used in the Format menu for line 
and XY charts. Up to seven different symbols are used. When there are 
more than six series drawn on the same chart, the symbols are repeated 
in sequence. That is, the first-series symbol is used for the seventh series, 
the second-series symbol is used for the eighth series, and so on. The 
symbols used by the VisiTrend/Plot program are shown here, in the 
sequence they appear on a chart: 
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c::J 
A 
# 
* 
+ 
X 

First series (Dot inside a square) 
Second series (triangle) 
Third series 
Fourth series 
Fifth series 
Sixth series 

VISITREN DIP LOTTM ~~T~~s 

Table (Trend subprogram-Analyze menu) 
The Tobie function produces a table of one or more series. You are 

prompted to select the series to be displayed. After selecting the series, 
you are given the option to keep the existing range or change it. If you 
don't change it, the program uses the union of the ranges of all selected 
series. If you change the range, you are prompted for start and end 
dates. 

The function display is a total of 79 character-columns wide. If you 
select more series than will fit, those that will not fit are ignored. 

The table is displayed 19 lines at a time. After each 19 lines, you are 
prompted to continue to the next 19 lines, print the current screen 
display and continue, or exit the function. 

Text (Plot subprogram - Plot menu) 
The Text function allows you to place customized titles, labels, 

legends, and notes on a displayed chart. It also allows you to create text­
only pages. When this function is selected, your computer and its 
associated printer operate much like an electronic typewriter. The Text 
function can be .. used on a new display and can also be used on a display 
that has been loaded from a disk file. Table 3-7 summarizes the command 
keys usable in the Text function. 

Table 3-7. Summary of Text Command Keys 

Operation 

Erase a character 
Change cursor movement 
Move cursor up 
Move cursor down 
Move cursor left 
Move cursor right 
Move to beginning of next line 
Change font size 
Tab five spaces 
Turn bold face onloff 
Turn in verse video onloff 
Clear entire screen 
Terminate Text function 

3-35 

Command Keys 

space bar/BKSP 
Ctrl-Z 
t 
~ 

.J 
Ctrl-F 
[TAB] 
Ctrl-B 
Ctrl-R 
Ctrl-Home 
Esc 
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Third (Plot subprogram - Title menu) 
The Third function, like the First and Second functions, specifies a title 

at the bottom of the chart. Third specifies the third bottom-title line. Table 
3-8 lists the maximum title lengths for the differert fonts and title loca­
tions. This title is centered across the bottom of the chart. If the @ symbol 
is typed as the last character in the title, the title will be left-justified. You 
must choose between bold typeface, normal typeface, and inverse video 
in the title. The bottom titles cover the legend lines. 

Table 3-8. Maximum Title Lengths 

Location Typeface Maximum 
Left Centered Bold Normal or Inverse Length 

X X 73 
X X 58 

X X 77 
X X 64 

Title (Plot subprogram - Options menu) 
The Title function displays the Title menu, which contains the functions 

to add top, bottom, side, and moveable titles to the currently displayed 
chart. For more information see Top, First, Second, Third, Side, 
Legend, and Moveable. 

Top (Plot subprogram - Title menu) 
The Top function centers a title over the displayed chart. ,If the @ sym­

bol is typed as the last character in the title, the title will be left-justified. 
Table 3-8 lists the maximum title lengths for the differert fonts and title 
locations. You are prompted to enter the title then asked if it should be 
displayed in normal typeface, bold typeface, or inverse video. You 
return to the Title menu for the Top function. 

Total (Trend subprogram-Function menu) 
The Total function generates a new series that contains the cumulative 

total of the data points in the source series. The first data point in the 
Total series is equal to the first point in the source series. The second 
point in the new series is equal to the first plus the second points in the 
source, and so forth. 
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Trend (Main subprogram - Main menu) 
(Plot subprogram - Exit menu) 

The Trend function loads the Trend subprogram. 

Undo (Main subprogram-Edit menu) 
(Trend subprogram-Edit menu) 

The Undo function discards all changes made to a series during an 
editing session. This function restores the series to the condition it was in 
when it was selected for editing. When you Undo a newly created series, 
it is deleted. 

Unlabel (Plot subprogram-Options menu) 
The Unlabel function erases the X- and/or Y-axis labels. The function 

displays the Unlabel menu which offers the choice of erasing horizontal 
(X-axis) labels, vertical (Y-axis) labels, or both. You can also exit the 
function without erasing either. When the vertical labels are erased, a 
left title is not erased. If no chart is displayed, this function immediately 
returns to the Main menu. 

Vertical (Plot subprogram - Grid. Unlabel. 
and Window Menus) 

In the Grid menu, Vertical draws vertical grid lines on the current 
chart. 

In the Un label menu, Vertical erases the current vertical labels. 

In the Window menu, Vertical divides the screen vertically into side­
by-side windows. 

Window (Plot subprogram-Plot· menu) 
The Window function divides the screen into two windows, switches 

between the windows, and changes back to one full-screen window 
format. This function divides the screen horizontally with top and bottom 
windows or a vertical, configuration with side-by-side windows. 

The chart legends are not displayed in the window mode. 

The window mode is displayed in the lower-right corner of the status 
area. If the area is blank, the screen is not divided into two win­
dows. When the screen is divided, the codes WT, WS, WL, or WR are dis­
played, indicating that the current window is the top, bottom, left, or 
right window. 
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The two-window mode is canceled by selecting None from the 
Window menu. It is also canceled by selecting the New function from the 
Plot menu. 

Xform (Trend subprogram - Main menu) 
The Xform function mathematically transforms any existing series or 

groups of series to create a new series. 

You are prompted to enter a name for the series to receive the 
transformed values. If you press ~ without entering a series name, the 
program generates a name in the form Seriesn, where n is a digit. 

After naming the new series, you are prompted to enter the transform 
expression. The list of series in memory is displayed with this prompt. 

To enter the transform, type it at the keyboard. However, do not type 
the name of the series. To enter a series name into the transform, press 
the i or ~ key. The cursor appears in the series listing. The indicated 
name appears in the transform. Pressing the arrow keys moves the cursor 
up and down the listing in the normal manner. As the cursor moves, the 
currently indicated series name replaces the previous name in the 
transform. To select a series, press ~ or enter the next character in the 
transform expression. 

When the formula or expression is complete press ~ to perform the 
transformation and create the new series. If the last item in the transform 
is a series name, you must press ~ twice, once to select the series and 
once to fix the transform. 

You can erase the last character or series name you entered by press­
ing the BKSP key. A series name is erased as a whole, not a character at 
a time. 

You can make an error several ways in creating a transform. You can 
enter an invalid expression, such as one with unbalanced parentheses, 
or you can specify an invalid operation, such as division with zero. It's 
also possible to mismatch parentheses (or make a similar syntactical 
mistake) or type a series name instead of using the arrow keys to select it. 
When an error is encountered, Can't! Bad transform: bad expression 
is displayed. . 
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In creating transforms you can use the following mathematical 
operators: 

Arithmetic operators: 

+ Addition 

Subtraction 

Multiplication 

Division 

A Exponentiation 

Logical operators: 

AND 
OR 
NOT 

Comparative operators: 

< Less than 

< = Less than or equal 

Equal 

> Greater than 

> = Greater than or equal 

Functions (with allowable input ranges): 

SGN(x) Sign 

INT(x) 

SQR(x) 

LOG (x) 

EXP(x) 

RND 

ABS(x) 

Integer part of 

Square root (0.0 < = x < = 3.402823e+38) 

Natural logarithm (0.0 < x < = 3.402823e + 38) 

e to the power of ( - 87.33654 < = x < = 88.72282) 

Random number between 0 and 1 

Absolute value of 

Trigonometric functions: 

SIN(x) 

COS(x) 

TAN(x) 

ATN(x) 

Sine (-2.98156e+8 < x < 2.981568e+8) 

Cosine (-2.981568e+8 < x < 2.981568e+8) 

Tangent ( - 2.981568e + 8 < x < 2.981568e + 8) 

Arctangent ( - 3.402823e + 38 < = x < = 3.402823e + 38) 

The functions are applied exactly as in Basic. In place of the Basic 
variables, you substitute the name of a VisiTrend/Plot series. 
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XY (Plot subprogram-Select menu) 
The XV function specifies that an XY chart is to be drawn. You are 

asked to select the series to be plotted along the X-axis and the Y-axis. 
The X-axis is scaled to the minimum and maximum for the X-axis series, 
and the Y-axis is scaled correspondingly for. the Y-axis series. The range 
of an XY chart is the intersection of the two series and is not explicitly 
shown in the chart. You can change the range. 

An XY chart can be drawn with points or plotting symbols. If you don't 
make a choice with the Format function, plotting symbols are used. 

When you Rescale an XY chart, you are asked for new scale values for 
both the X-axis and Y-axis. 

The X-axis scale factor, when required, is displayed below the X-axis. 
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ERROR MESSAGES 

APPENDIXA 

The following are the error messages issued by the VisiTrend/Plot pro­
gram. The messages are in alphabetical order by the first word of the 
message. The error descriptions include suggestions on further action 
whenever possible. 

(loud beep) 
A beep is sounded whenever inappropriate data is entered or an 

illegal operation is attempted. When inappropriate data is entered, no 
message is displayed, only the beep is sounded. When you encounter 
this, try your entry again. You probably pressed the wrong key by 
mistake, such as pressing a letter key when the program was looking for 
numeric data. 

Can't access data diskette! 
You attempted to load or save a file or series from the data disk but the 

disk drive door is open or the disk is damaged. It's also possible that a 
non-DOS disk or a non-VisiTrend/Plot disk is in the drive. 

Can't access program diskette! 
You tried to load the VisiTrend/Plot program from the wrong disk, or 

the drive A door is open, or the disk is damaged. Program Disk #2 should 
be in Drive A at this time. 

Can't! Bad data for pie chart 
You attempted to plot a pie chart that had negative data points mixed 

with positive data points, or all the data points are zero value. Re-specify 
the data series to be plotted, making sure that all series are either 
positive or negative, and that there is at least one data point other 
than zero. 

Can't! Bad periodicity 
You selected series that have different periods. All series used in a 

chart, whether a multiple series chart or an overlay of two or more 
charts, must have the same period. 

Can't! Bad range 
If this message occurs as the result of an attempted Plot, it means that a 

series being used does not have at least two data points or the series has 
more than 250 data points. Use the Edit function to check the series, and 
make sure it contains at least two data points. 
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Several conditions can cause this message to be issued: 

• There is no data in the range you specified with the Range function. 

• There are more than 250 points in the range. For example, you tried 
to plot two series and the combined ranges of the two series exceed 
250 points. 

• You attempted to draw a scatter chart with two series that have no 
common values at any date. 

• You attempted to draw a pie chart with one or more series that have 
no data at the date specified for the pie chart. 

Can'tl File already exists 
You typed a new file name that is the same as a file name already on 

the disk. 

Can't I File not found 
The file you selected is not on the disk. You probably changed the disk 

drive name so the program is looking for the file you selected on the 
wrong disk drive, or you have the wrong disk in the drive, or the disk is 
damaged, or the disk is write protected. Change the disk drive name and 
try again. 

Can'tl Font file read errorl 
The VisiTrend/Plot file that contains the font you requested cannot be 

accessed. Make sure the Program Disk #2 is in drive A and make sure 
the disk drive door is firmly closed. If this message recurs, contact 
your dealer. 

Can'tl Formatting error 
You are trying to initialize a defective disk or a program disk, or the 

data disk drive door is open. 

Can'tl Graphics hardware not present 
The Plot subprogram cannot be used because the computer is not 

hooked up to a graphics video monitor or a color video controller card 
has not been installed in the computer. Review the computer require­
ments in the Introduction to this manual, and make sure your computer is 
set up accordingly, then load the Plot subprogram. Be sure to save your 
data before exiting the program or turning the computer off. 

Can'tl Incompatible file type 
You attempted to load a data file that is not in the VisiTrend/Plot data 

format or the DIF format. Only files in these formats can be loaded by the 
VisiTrend/Plot program. 
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Can't load printer driver! 
The driver you requested is not on the disk, or disk drive A door is 

open, or the disk is damaged. 

Can't load subprogram 
You attempted to load the Main, Plot, or Trend subprogram, but the 

disk drive door is open or Program Disk #2 is not in the drive. If this 
message recurs, contact your dealer. 

Can't mix XY with other chart types! 
You attempted to mix an XY chart with another chart type during 

an overlay. 

Can't! Must plot first 
You attempted to use the Overlay function when there was no chart 

displayed. Another possible cause of this message is trying to mix an XY 
chart with another chart type during an overlay. This message also 
appears if you attempt to select the Grids, Titles, or Unlabel function 
without first having a chart displayed. Select Background, then Plot, 
then Overlay another series; or make sure you're not mixing an XY chart 
with another chart type, then retry the overlay. 

Can't I No active series! 
You attempted to invoke a function that cannot be invoked until you 

have loaded a file or created one with Edit. 

Can't! No more room! 
Memory capacity has been reached. Memory can hold a maximum of 

16 series or 2000 data points, whichever is reached first. Clear some 
series from memory with the Clear function, then try function again. 

Can't! No options available at this ·time 
You attempted to select the Options menu without selecting a chart 

type first. From the Plot menu, choose the Select function and select a 
chart type, then tr.y again. 

Can't! No option for this chart type 
Certain options are not applicable in-all instances. When you see this 

error message, you tried to apply a function that is not legal in the cur­
rent circumstances. Usually, an option can be applied wherever it is 
meaningful and useful. 

Can't! No printer driver loaded 
You must create a new configuration file with the Configuration func· 

tion in the Print menu. 
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Can't perform operation on loaded screen image 
You attempted to select an operation that is illegal on a display loaded 

from a screen image file. Only these functions can be selected when a 
screen image loaded from disk is displayed: Text, Save, Title, and Print. 

Can'tl Please select first 
You selected the Plot or Options function wihout first selecting a series 

or a graph type. You may have switched windows; you must use the 
Select function to select a series after switching windows, even if you 
want to plot the same series. Select a series and then return to the 
Options function. 

Can'tl Printer not found 
The printer is not hooked up to the computer, or not turned on, or the 

printer was not turned on at the time the program was loaded, or the 
printer switches are not correctly set. If the printer was turned off, turn it 
on and select the printer with the Device option in the Print menu. 

Can'tl Series too large to insert 
You attempted a Fill operation that would have resulted in a series 

exceeding the 2S0-data-point limit. The series you specified for inserting 
or the factor you specified for computing the fill was too large. Use a 
shorter series or smaller fill factor then try again. 

Can't! Singular matrix 
You selected independent variables for a multiple regression that 

either exhibit a high degree of collinearity or have very different scales. 
The independent series are linearly dependent. 

When the independent variables are highly correlated, it is mathe­
matically impossible to perform a regression. If two variables are simple 
multiples of each other, they are perfectly correlated. You should 
keep these facts in mind when creating regression variables using the 
Xform function. 

Can'tl Title too long 
You attempted to create a side title longer than 19 characters. The 

maximum length of a side title is 19 characters. Shorten the title; then 
try again. 

Can't transforml Bad expression 
You entered an Xform expression that contains an illegal operator, 

unbalanced parentheses, or you typed a series name instead of selecting 
it with the cursor and .J. 
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Can't transform! Expression too complex! 
You have created a transform equation that is too complex for the 

VisiTrend/Plot program. Possibly there are too many layers of paren­
theses. One solution is to split the complex equation into several simpler 
ones and process them individually. 

Can't transform! Invalid operators 
There are invalid operators or misspelled function names in your 

transform, or values in your transform are not in the correct location. 
Make sure you are using the operators listed in the Reference section, 
then try again. 

Can't transform! No series referenced 
At least one data series must be referenced in a transform equation to 

establish a range for the resultant series. Add the appropriate series, 
then try again. 

Data off scale, choose action 
You rescaled the chart and in the new scale, some data points fall out­

side the specified scale. Redraw causes the chart to be redrawn using a 
new Y-axis. Cancel cancels the entire plot operation. When overlays 
are involved, Proceed is a third choice of action. Proceed causes a par­
tial plot to be drawn. Each time an off-scale value is encountered, the 
beep sounds. If the chart is a bar chart, the plot is canceled when the first 
off-scale data point is encountered. 

Can't! Data read error 
The file you requested is not on the disk, the disk drive door is open, or 

the disk is damaged. 

Can't! Data write error 
Either the disk is full, or it is write-protected. If a write-protect tab is on 

the data disk, remove it; then try again. If this message recurs, the disk is 
full; put the material on another disk. 

No room for regression values! 
The fitted and error series resulting from a regression operation are too 

large to fit in memory. The result table will display, but the fitted and 
error series cannot be saved. 

Transform error: Division by zero 
You specified a division by zero in an Xform operation. Reenter the 

formula after correcting the division-by-zero error. If you selected Union 
of ranges, the series are zero-filled. 
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Transform error.: LOG of zero or negative 
You wrote a transform equation that contains a logical operator on zero 

or a negative value. Logical operators are not allowed with zero or a 
negative number, so rewrite the equation and try again. If you selected 
Union of ranges, the function used zero for all missing data values-this 
can easily cause division by zero or log of zero. 

Transform error: Number too large 
Computing of the transform expression resulted in a number which is 

too large for floating point representation on your computer. The largest 
positive number allowed is 3.402823e + 38. 

Transform error: Number too small 
Computing of the transform expression resulted in a number which is 

too small for floating point representation on your computer. The 
smallest number allowed is 1. 75494e - 38. 

Transform error: Parameters out of range 
Certain Xform functions such as sine, cos, and tan have limitations on 

the size of argument they can handle. Where sine is used, for example, 
you should avoid using any value as large as 1.0e37. The limitations are 
listed under "Xform" in the Reference chapter. 

Transform error: SQR of negative 
A transform equation attempts to calculate the square root of a 

negative value, which is not allowed. Rewrite the equation. 

Transform error: Undefined value 
The transform equation you attempted to process contains a meaning­

less value or operation, such as 0/0. 

Warning! Intermediate series lost 
You did a Plot and then an Overlay successfully. You then attempted 

one or more additional Overlays, got an off-scale indication, and 
selected Redraw. Redraw only draws the original series and the last 
overlay. 

Warning! Number too large or too small 
You performed an operation that caused an excessively large or small 

floating point number to be computed. In this program an excessively 
large or small number is anything near 3.4e38 or - 3.4e38. If the opera­
tion that caused this warning is a statistical computation, DO NOT 
TRUST THE COMPUTED RESULTS. When this happens the program 
changes infinities to representable, large numbers and undefined 
numbers (such as 0/0) to o. 
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The VisiTrend/Plot program can be used with several different graphic 
printers. This appendix contains a list of the supported printers with the 
required options and switch settings where applicable. It also contains a 
list of the drivers needed to use non-graphic printers. 

If you have a printer other than the supported graphic printers, you 
can print listings and tables but not charts. No drivers are necessary for 
printing listings or tables. 

Each printer requires a printer driver to correctly print your charts 
and screen images. A printer driver is a program that the VisiTrend/Plot 
program uses to communicate graphic information to a printer. There 
are several printer drivers on your VisiTrend/Plot Program Disk # 2. 
The names of the printer drivers and their purpose are listed later in 
this Appendix. 

The VisiTrend/Plot Program Disks you received are already set up to 
print on the IBM 80-Character-Per-Second Matrix Printer (with 
Graftrax). 

If you use this printer or do not have a printer connected to the com­
puter, you do not have to make any changes. 

If you use one of the other supported printers, you'll need to change 
drivers. 

CHANGING THE PRINTER DRIVER 

1. Load the Plot subprogram and display the Plot menu. 

2. Select Print. The Print menu replaces the Plot menu. 

3. Move the cursor to Configuration and press ~. The program displays 
a list of the printer drivers. 

4. The status area tells you what printer driver is currently selected. 
To change the selection, move the cursor to the desired driver and 
press ~ 

5. The program asks if you want automatic line feeds. If your printer 
generates a line feed for every carriage return, select Yes, otherwise, 
select No. See your printer manual for this information. 



VISITREN DIP LOT™ ~5T~~s IBM PERSONAL COMPUTER 
APPENDIX 8 

6. The program lists the names of the printer and communication cards 
that are installed in the system. Move the cursor to the descired name 
and press ~. The program returns to the Print menu and your pro­
gram is configured for the selected printer and printer driver. 

You can change the printer driver or printer for the duration of a 
VisiTrendlPlot session with the Driver and Device functions. The next 
time you load the program, it will use the printer driver and printer 
selected with the Configuration option. 

SUPPORTED GRAPHIC PRINTERS 

The standard printer is the IBM 80 CPS Matrix Printer (with Graftrax­
Plus or Graftrax-80). The installation instructions, packed with the 
printer, describe how to unpack, install, and check out the printer. 

Follow the installation and checkout procedures in the printer manual. 
This appendix does not tell you how to install and operate your printer. 
See your computer dealer if you have trouble. This appendix only tells 
you which switches to set so you can print the graphic output from 
the program. 

When using the printer drivers, position the paper in the printer 
before you request the printing of listings or charts. The program does 
not issue a top-of-form command. 

The VisiTrend/Plot program supports the graphic printers listed in 
Table B-1. Any printer and model not specifically mentioned is not tested 
for graphics printing nor does the program supply a printer driver. The 
table lists the drivers associated with each printer. In high density mode, 
the printer prints twice as many dots per inch as it does in low density. 

Table B-1. Drivers for the Supported Printers 

Printer 

IBM 80 CPS Matrix 

EPSON MX-80 

Driver Description 

Small size; high-density; no rotation 

Normal size; low-density; 90 - degree rotation 

Normal size; high-density; 90 - degree 
rotation 

Small size; high-density; no rotation 

Normal size; low-density; 90 - degree rotation 

Normal size; high-density; 90 - degree 
rotation 
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Table B-1. Drivers for the Supported Printers (Continued) 

Printer 

EPSON MX-IOO 

NEC 3530 Spinwriter 

Driver Description 

Small size; high-density; no rotation 

Normal size; low-density; no rotation 

Normal size; low-density; 90 -degree rotation 

Normal size; high-density; 90 - degree 
rotation 

Normal size; high-density; no rotation 

Normal size; low-density; no rotation 

NEC 5530 Spinwriter Normal size; low-density; no rotation 

NEC 7730 Spinwriter Normal size; low-density; no rotation 

OKIDATA Microline 83A Normal size; low-density; no rotation 

Normal size; low-density; 90 - degree rotation 

USE OF NON-GRAPHICS PRINTERS 

If you have a printer other than the supported graphic printers, you 
can print listings and tables, but not charts. A driver is not needed to 
print text. 

PRINTER SET UP AND SWITCH SETTINGS 

The following sections describe the preparation of the individual 
supported printers and interface cards for use with the program. These 
sections are intended only as an aid in preparing the printers and inter­
face cards for use with this program. They are not exhaustive directions 
on setting up the printers. For that information, see the documentation 
that the manufacturer ships with the printer or contact your local dealer. 

You must turn your printer off before setting the switches. 

Only those switch settings that are necessary to print graphics are 
listed. Because the other switches may depend upon your configuration 
or are meaningless in this application, no switch position is suggested. 

Not.e that there may be as many as three different sets of switches 
involved with a specific printer set up. The printer may have internal 
and/or external switches. Make sure you are setting the correct switches. 
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IBM SO-CPS MATRIX PRINTER 

The printer contains internal DIP switches which must be set correctly 
for it to print graphics. The DIP switches are located near the back of the 
main circuit board. See your printer literature or dealer for complete 
details. Table B-2 lists the switch settings that must be checked and set if 
necessary. Switches that are not listed can be set as your system or 
configuration requires. The printer must be on-line. There are no other 
external switches to set. 

Table B-2. IBM 80-CPS Matrix Printer Internal DIP Switch Settings 

DIP Switch Setting 

DIPSl 2 On (CR= print) 

3 On (Buffer full = print) 

NEC 3530 SERIAL SPINWRITER 

The DIP switches on the left side of the front panel should be set 
according to Table B-3. The switches within this cluster are numbered 
from the left to the right. 

Table B-3. NEC 3530 Front Panel Switch Settings 

DIP Switch Setting 

2 1 Off-6 Lines per inch 

2 and 3 Off-lO Characters per inch 

4 Off-Constant spacing 

3 2 Off-Single line feed 

3 Off-Normal operation 

NEC 5530 PARALLEL SPINWRITER 

The switches on the front panel should be set according to Table B-4. 
The switches are listed from the left to the right. 

B-4 



IBM PERSONAL COMPUTER VISITREN DIP LOT™ ~~f~~s 
APPENDIX B 

Table B-4. NEC 5530 Front Panel Switch Settings 

Name Setting 

LPI 6 Lines per inch 

Spacing Single 

Local/Remote Remote 

NEe 7730 PARALLEL SPINWRITER 

The DIP switches on the left side of the front panel should be set 
according to Table B-S. The switches within this cluster are numbered 
from the left to the right. 

Table B-S. NEC 7730 Front Panel Switch Settings 

DIP Switch Setting 

SWI 6 and 7 Off-Buffer length 163 characters 

SW2 6 Off-Normal operation 

SW3 1 Off-Normal operation 

2 Off-Constant spacing 

3 Off-6 lines per inch 

4 Off-Single line spacing 
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THE VISITREND/PLOTTM INTERNAL 
DATA FORMAT 

VisiTrendlPlot data series can be stored in either of two formats: the 
VisiTrend/Plot data format or the DIF format. Data is stored in the 
VisiTrendlPlot data format when you select Normal from the Save format 
menu. It is stored in the DIF format when you select DIF. Data in the DIF 
format can be used by other VisiCorp programs. 

The VisiTrend/Plot data format is described in this appendix. The DIF 
format is described briefly in Appendix D. The DIF format is covered in 
more detail in the Programmer's Guide to the Data Interchange Format, 
number SATN-18 which is available from the DIF Clearinghouse, P.O. 
Box 527, Cambridge, MA 02139. 

A VisiTrendlPlot data file is a sequential text file. The fields are 
variable length and each field is terminated with a linefeed. The follow­
ing list contains a description of the contents and, in parentheses, the 
limitations on and expected contents of the fields. 

The fields of a data file are: 

Number of series (1-16) 
Series name (string-up to 14 characters) 
Number of data points (1-250) 
Periodicity (1-99) 
Start year (0-2499) 
Start period (I-periodicity) 
End year (I-periodicity) 
End period (I-periodicity) 
Data point 1 
Data point 2 

Data point n 

C-l 

(must be consistent with 
the start year and period, 
the periodicity, and 
number points) 
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The following is the listing of a sample file containing two series, 
named First and Second. First has a period of 1 and contains five data 
points beginning at date 1. The values of the data points are 100, 200, 
300, 400, and 500. Second has a period of 1 and contains three data 
points beginning at date 1980. The values of the data points are 1111, 
2222, and 3333. 

2 
FIRST 
5 
1 
1 
1 
5 
1 
100 
200 
300 
400 
500 
SECOND 
3 
1 
1980 
1 
1982 
1 
1111 
2222 
3333 

Number of series in file 
Series name 
Number of data points 
Periodicity 
Start date 
Start per~od 
End date 
End period first series 

Data points 

Second series 
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The DIFTM format is a standard file format that allows unrelated pro­
grams to share data. A file saved in the DIF format is a text file that can 
be read by other DIF -supporting programs. Thus, a data series created 
by the VisiTrend/Plot program can be saved in the DIF format and read 
by other programs that support DIF. 

This appendix describes the file format and lists three sample pro­
grams in Applesoft BASIC that retrieve and save DIF files. 

Further information is available through the DIF Clearinghouse, 
which has been set up to coordinate and distribute information about the 
DIF format. The Clearinghouse maintains and distributes the DIF 
Technical Specification, which is a detailed technical description of the 
DIF format, and information about the commercially available programs 
that support the format. To obtain this information, please send your, 
name, address, and a note requesting this information to: DIF Clearing­
house, P.O. Box 527, Cambridge, MA 02139. 

THE DIF FORMAT 

The DIF format stores data in a form accessible to programs other than 
the VisiTrend/Plot program. To accommodate a wide range of languages 
in which such a program might be written, several simplifying tech­
niques have been used: 

• Information about the size of the file is provided at the beginning. 

• Records are kept as short as possible. 

• The data type (string or number) of each value is explicitly defined. 

• Strings are stored one per line. 

• Strings that contain special characters are enclosed in quotation 
marks. 

• The file ends with an explicit End-Of-Data record. 

Figure D-1 shows a sample data series created in the VisiTrendiPlot 
program. Before this data series could be used by another program, such 
as VisiCalc, it would have to be saved in a DIF file in the VisiTrend/Plot 
program. 
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Date XVZ Fund 

1980 1 227.16 
2 272.73 
3 317.71 
4 329.13 
5 378.24 
6 345.06 

1981 1 428.38 
2 496.02 
3 443.15 
4 485.82 
5 489.03 
6 503.32 012·014 

Figure D-l. Sample VisiTrend/Plot Data Series 

The OIF format stores the data in a series of slices; it can be sliced 
either horizontally (by rows) or vertically (by columns). Each of these 
slices is called a tuple; each slice along the other axis is called a vector. 
In the sample data series in Figure 0-1, the row formed by 80, 1, and 
277.16 is a tuple; the column beginning with 1 is a vector; and the row of 
values beginning with 277.16 is another vector. 

A OIF file consists of a series of header records that describe the 
file, followed by one set of data records for each tuple, and ends with a 
pair of End-Of-Data records. When the data series shown in Figure 0-1 is 
saved in the OIF format, it would be laid out as shown in the following 
three diagrams. 
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Header 
The header consists of four sets of three records that give information 

about the entire file: 

Data Records 

TABLE 

~~------
TUPLE.DlF 

VECTORS 

~_1 _____ _ 

TUPLES 

~~.3 ____ _ 

LABEL 

TUPLE 

PERIODICITY 

~-"------
6 

MAJORSTART 

.!:~~~~---
1980 

MINORSTART 

~~------
1 

TRUELENGTH f---------
~-~-----
12 r-------
DATA r--------
0,0 

f-::-~-----

The data records consist of a pair of header records that identify the 
beginning of a tuple, and a pair of records for each value in the tuple: 

.:-_1.:.~ .. __ 
BOT 

~]~:0~~_ 

-1,0 

BOT 

0, 317.71 

V 

~~-----
BOT 

-1,0 

1 BOT------
I 0,503.32 
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End-Of-Data Records 
The End-Of-Data records mark the end of the file: 

WORKING WITH DIF FILES 

The following three programs demonstrate how Basic programs might 
be written and used with the DIF format. They perform the following 
functions: 

• Dump a DIF file just as it is stored, record by record. 

• Print a DIF file that contains a data series. 

• Create a DIF file by prompting for the file entries. 

Dumping a DIF File 
This program prints the DIF file just as it is stored, record by record. It 

asks for the name of the file, and whether to print it. If not instructed to 
print the file, the program displays the file on the screen. 

100 • • ••••••••••••••••••••• 
110 •• INITIALIZATION • 
120 • • ••••••••••••••••••••• 
130 NUL$ = CHR$(34) + CHR$(34) 
140 FALSE = 0 
150 TRUE = -1 
440 • 
450 • 
460 • • ••••••••••••••••••••• 
470 •• MAIN ROUTINE • 
480 • • ••••••••••••••••••••• 
490 • 
500 GOSUB 1000' 
510 GOSUB 1200 
520 GOSUB 1400' 
530 GOSUB 1600' 
540 END 
940 • 
950 • 
960 • • ••••••••••••••••••••• 
970 • • PROMPT FOR ORDERS • 
980 • • ••••••••••••••••••••• 
990 • 
1000· CLS 
1010 INPUT "Fila naIRe, ",FILENAI'IE. 

• PROMPT FOR ORDERS 
• PRINT HEADER 
• PRINT DATA RECORDS 
• END-OF-PROGRAM CLEANUP 

1020 IF RIGHT. (FILENAI'IE$, 4) < > ". DIF" THEN FILENAME ... FILENAME$ + ". DIF" 
1030 INPUT "Print the fila (Yor N): ",REPLY$ 
1040 IF REPLY$ = "V" OR REPLY$ = "y" THEN HARDCOPY = TRUE 
1050 OPEN FILENAME$ FOR INPUT AS .1 
1060 IF NOT HARDCOPY THEN CLS 
1070 IF HARDCOPY THEN LPRINT FILENAME •• LPRINT .. "cLPRINT ELSE PRINT FILENAl'ES,P 
RINT.PRINT 
1080 RETURN 
1140 • 
1150 • 
1160 ••••••••••••••••••••••• 
1170 •• PRINT HEADER • 
1180 ••••••••••••••••••••••• 
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1190 • 
1200 INPUT .1, TITLE$ 
1210 INPUT .1, TYPE, NUKBER 
1220 INPUT .1, STRNG$ 

VISITREN DIP LOT™ USER'S 
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1230 IF HARDCOPY THEN LPRINT TITLE$:LPRINT TYPE; ","; NUMBER ELSE PRINT TITLE$aP 
RINT TYPE; .. , "; NUMBER 
1240 IF STRNG$ = .. " THEN IF HARDCOPY THEN LPRINT NUL$ ELSE PRINT NUL$ ELSE IF HA 
RDCOPY THEN LPRINT STRNG$ ELSE PRINT STRNG$ 
1250 IF TITLE$ <> "DATA" THEN 1200 
1260 IF NOT HARDCOPY THEN GOSUB 2000 
1270 RETURN 
1340 • 
1350 • 

1360 • *********************. 
1370 • * PRINT DATA RECORDS * 
1380 • *****.* ••• **.* •••• * ••• 
1390 • 
1400 INPUT .1, TVPE, NUMBER 
1410 INPUT .1, STRNG$ 
1420 IF CSRLIN > 20 AND NOT HARDCOPY THEN GOSUB 2000 
1430 IF HARDCOPY THEN LPRINT TYPE; ","; NUMBER: LPRINT STRNG$ ELSE PRINT TYPE; " 
,K; NUMBER: PRINT STRNG$ 
1440 IF STRNG$ <> "EOD" THEN 1400 
1450 RETURN 
1530 • 
1540 • 
1550 • ..* •• * •••• * •• * •• **.* •• 
1560 •• END-OF-PROGRAM • 
1570 •• CLEANUP • 
1580 • • ••••••• ************** 
1590 • 
1600 CLOSE 1 
1610 RETURN 
1920 • 
1930 • 

1940 • *************.******** 
1950 • * PRINT * 
1960 • * "RETURN FOR MORE" * 
1970 • * MESSAGE AT BOTTOM * 
1980 • ****************** •• ** 
1990 • 
2000 LOCATE 24,1 
2010 PRINT "RETURN for more"; 
2020 REPLY$ = INPUT$(I)' 
2030 CLS 
2040 RETURN 

• WAIT UNTIL ANY KEY I S PRESSED 

Printing a Data File From a DIF File 
The following program prints the data series exactly the way it looks in 

the DIF format. It asks for the name of the file in which the data series was 
saved in the DIF format, the width of columns to be printed, and whether 
the data series was saved by rows or by columns. 
60 • .*****.** •• *****.***.* 
70 • * INITIALIZATION * 
80 • ********************** 90 • 
100 DIM WORKSHEET(50,50) 
110 FALSE = 0 
120 TRUE = -1 
130 BYROWS = FALSE 
440 • 
450 • 
460 • *.**.********.*.*****. 
470 • * MAIN ROUTINE * 
480 • *.* •••• ***********.*** 
490 • 
500 GOSUB 1000' 
510 GOSUB 1200' 
520 GOSUB 1400' 
530 IF NOT FILEBAD THEN GOSUB 1600' 
540 GOSUB 1800' 
550 END 

* PROMPT FOR ORDERS * READ HEADER 
• READ DATA RECORDS * PRINT THE WORKSHEET * END-QF-PROGRAM CLEANUP 
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940 • 
950 • 
960 • • ••••••••••••••••••••• 
970 • • PROMPT FOR ORDERS • 
980 • • •••••• * ••••••••••••• * 
990 • 
1000 CLS 
1010 INPUT "File name: ", FILENAI'tE. 

APPENDIX D 

1020 IF RI6HT$(FILENAI'tE.,4) <> ".DIF" THEN FILENAME$ = FILENAME. + ".DIF" 
1030 INPUT "Column width: ",COLl.lt1NWIDTH 
1040 INPUT "Saved by row or column (R or C): ",REPLV$ 
1050 IF REPLV$ = "R" OR REPLV. = "r" THEN BVROWS = TRUE 
1060 INPUT "Print the worksheet (V or N): ",REPLV. 
1070 IF REPLV$ = "V" OR REPLV. = "y" THEN HARDCOPV .. TRUE 
1080 OPEN FILENAME. FOR INPUT AS *1 
1090 RETURN 
1140 • 
1150 • 
1160 • • ••••••••• * •••• * •••••• 
1170 •• READ HEADER • 
1180 ••••••• * ••• * ••••••••••• 
1190 • 

TITLE. 
TVPE, NUMBER 
STRNG$ 

1200 INPUT *1, 
1210 INPUT *1, 
1220 INPUT *1, 
1230 IF TITLE. 
1240 IF TITLE$ 
1250 IF TITLE$ 
1260 BOTO 1200 
1340 • 

"VECTORS" THEN VECTORS a NUMBER 
"TUPLES" THEN TUPLES = NUMBER 

= "DATA" THEN RETURN 

1"350 • 
1360 • • ••••• * •••••••• * •••••• 
1370 • • READ DATA RECORDS • 
1380 • .* •• *.** ••••••••••••• * 

ROW = 1 TO TUPLES 
INPUT *1, TVPE, NUMBER 
INPUT *1, STRNG$ 

1390 • 
1400 FOR 
1410 
1420 
1430 IF TVPE <> -1 OR STRNG$ <> "BOT" THEN 

GOSUB 20001 

1440 
1450 

RETlIRN 
FOR' COL = 1 TO VECTORS 

INPUT *1, TVPE. NUMBER 
INPUT *1, STRNG$ 1460 

1470 IF TVPE < > 0 AND TVPE < > 1 THEN 
GOSUB 2000: RETURN 

1480 IF BVROWS Tl£N IF TVPE = 0 THEN WORKSHEET. (COL, ROW) = STR$ (NUMBER) 
ELSE WORKSHEET$(COL,ROW) '" STRNG. ELSE IF TVPE = 0 THEN WORKSHEET$(ROW,COL) ... ST 
R. (NUMBER) ELSE WORKSHEET$ (ROW, COL) = STRNG. 
1490 NEXT COL 
1500 NEXT ROW 
1510 RETURN 
1540 • 
1550 • 
1560 • .., ................. .. 
1570 • • PRINT THE WORKSHEET. 
1580 • • ••••••••• * ••••••••• ** 
1590 • 
1600 IF BVROWS THEN WDTH = TUPLES: DEPTH = VECTORS ELSE WDTH = VECTORS: DEPTH = 
TUPLES 
1610 FOR ROW = 1 TO DEPTH 
1620 FOR COL = 1 TO WDTH 
1630 IF HARDCOPV THEN LPRINT WORKSHEET.(ROW,COL); TABCCOL.COLUMNWIDTH). 
ELSE PRINT WORKSHEET.CROW,COL); TAB(COL'COLUMNWIDTH); 
1640 NEXT COL 
1650 IF HARDCOPV THEN LPRINT " .. ELSE PRINT 
1660 NEXT ROW 
1670 RETURN 
1730 • 
1740 • 
1750 • 
1760 • 
1770 • 
1780 • 
1790 • 

~ ••••••••• * •• * •••••••• 
• END-OF-PROGRAM • 
• CLEANUP • .* ••••• * •••••••••••••• 

1800 CLOSE 1 
1810 RETURN 
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1940 • 
1950 • 
1960 • • ••••••••••••••••••••• 
1970 •• ERROR IN FILE • 
1980 • • ••••••• * •• * •••• * •• * •• 
1990 • 
2000 PRINT 
2010 BEEP: PRINT "ERROR IN FILE 
2020 PRINT TAB(S); "TYPE ="; TYPE 
2030 PRINT TAB(S); "NUttBER ="; NUttBER 
2040 PRINT TAB(S); "STRING = "; STRNG. 
2050 FILEBAD = TRUE 
2060 RETURN 

VISITREN DIPLOT™ 

Creating a DIF File Outside of the VisiTrend/Plot 
Program 

USER'S 
GUIDE 

The following program prompts for VisiCalc worksheet entries (by 
row-column coordinate), then writes the entries on a disk in a DIF file. 
Either a string or number (integer or real) can be entered. To enter a 
label that starts with a number, type a quotation mark (") as the first 
character of the label. To end a row, press Esc ~; to end the worksheet, 
press Esc. 

The program assumes the coordinate of the lower-right corner of the 
worksheet is the row-column coordinate of the location immediately to 
the left of the coordinate where Esc is typed, so the last row should be at 
least as wide as all preceding rows. The worksheet is saved by rows. 

60 • • ••••••••••••••••• * •• * 
70 •• INITIALIZATION • 
80 • • ••• * •••••• * •••••• * ••• 
90 • 
100 ESC. = CHR.(27) 
110 LASTINROW. = ESC. 
120 LASTONSHEET. = ESC. + ESC. 
130 QUOTE. = CHR.(34) 
140 NUL. = QUOTE. + QUOTE. 
150 CLSCREEN. = CHR$(12) 
160 ROW = 1 
170 COL = 1 
IBO FALSE = 0 
190 TRUE = -1 
200 DItt WDRKSHEET.(50,50) 
440 • 
450 • 
460 • • ••••• * •• ** •••••• ** ••• 
470 • * MIN ROUTINE • 
480 • • ••••• * ••• * ••••• *.* •• * 
490 • 
500 BOSUB 1000' 
510 GDSUB 1200'. 
520 60SUB 1400' 
530 GOSUB 2000' 
540 END 
940 • 
950 • 

960 • **.*.** •• * •••••••• * ••• 
970 • • PROttPT FOR ORDERS • 
9BO • • •••• **.** ••••••• ** •• * 
990 • 
1000 PRINT CLSCREEN$ 

• PROMPT FDR ORDERS 
• PROttPT FOR ENTRIES 
• WRITE FILE 
• END-QF-PROGRAtt CLEANUP 

1010 INPUT "Writ. the file (Y or N). ",REPLY. 
1020 IF REPLV. = "V" OR REPLY. = "y" TI-£N DISKCDPV = TRUE 
1030 IF DISKCOPY 

THEN INPUT "File naMe. ",FILENA/'tE.1 
IF RIGHT.(FILENAI'IE$,4) <> ".DIF" THEN FILENA/'tE$ = FILENA/'tE$ + ".DIF 
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1040 RETURN 
1140 • 
1150 • 
1160 ••••••••••••••••••••••• 
1170 •• PROMPT FDR ENTRIES. 
1180 • •••••••••••••••••••••• 
1190 • 
'1200 PRINT CLSCREENS 
1210 WORKSHEETS (ROW, COL) = "" 
1220 PRINT "Row"; ROW; ", Column " j CHR.(64+CQL); ": H; 
1230 REPLYS = INPUTS(I) 

APPENDIX D 

1232 IF REPLYS = CHRS(8) THEN IF LEN (WORKSHEETS (ROW, COL> ) > 0 THEN PRINT CHRS(29 
);" "; CHRS (29) J : WORKSHEETS (ROW, COL> = LEFTS (WORKSHEETS (ROW, COL> ,LEN (WORKSHEETS (R 
OW, COL> )-1) ISOTO 1230IELSE SOTO 1230 
1240 IF REPLYS <> CHRS(13) 

THEN PRINT REPLYS; I WORKSHEETS (ROW, COL) = WORKSHEETS(ROW,CDU + REPLYS: 
SOTO 1230 
1250 PRINT 
1260 IF WORKSHEETS (ROW, COL) = LASTONSHEET$ 

THEN WDTH = COL - 1: DEPTH = ROW: RETURN 
1270 IF WORKSHEETS (ROW, COL) = LASTINROWS 

THEN ROW ROW + 11 COL = I: PRINTIBOTO 1210 
1280 COL = COL + 1 
1290 BOTO 1210 
1310 • 
1320.' 
1330 • • ••••••••••••••••••••• 
1340 •• WRITE FILE • 
1350 ....................... . 
1360 • 
1370 • ----------------------
1380 • , HEADER 
1390 • ----------------------
1400 IF NOT DISKCOPY THEN RETURN 
1404 OPEN "0", I, FILENAMES 
1410 PRINT .1, "TABLE" 
1420 PRINT ttl, 0; ",", 1 
1430 PRINT .1, NULS 
1440 PRINT .1, "VECTORS" 
1450 PRINT .1, 0; ","; DEPTH 
1460 PRINT .1, NlLS 
1470 PRINT .1, -TUPLES" 
1480 PRINT .1, 0; ",", WDTH 
1490 PRINT .1, NULS 
1500 PRINT .1, "DATA" 
1510 PRINT .1, 0; ",", 0 
1520 PRINT .1, NUL. 
1540 • 
1550 • ----------------------
1560 • DATA RECORDS 
1570 • ----------------------
1580 FOR COL = 1 TO WDTH 
1590 PRINT ttl, -1; ", "; 0 
1600 PRINT ttl, "BOT" 
1610 FOR ROW = 1 TO DEPTH 
1620 IF VAL(WDRKSHEETS(ROW,COL» > 0 THEN 

660 
1630 

1640 
1650 
1660 
1670 
16BO • 

PRINT ttl, 0; n, "; VAL (WDRKSHEETS (ROW, COL> ): PRINT .1, "V":GOTO 1 

IF LEFT$(WORKSHEET$(ROW,COL) ,1) = QUOTES THEN 
WORKSHEETS (ROW, COL) = MIDS(WORKSHEETS(ROW,COL),2) 

PRINT .1, 1; ","; 0 
PRINT ttl, QUOTES; WORKSHEET$(ROW,COL); QUOTE$ 
NEXT ROW 

NEXT COL 

1690 • ----------------------
1700 • END-OF-DATA 
1710 • ----------------------
1720 PRINT ttl, -1; ..... ; 0 
1730 PRINT .• l, "EoD" 
1740 RETURN 

D-8 



IBM PERSONAL COMPUTER 
APPENDIX D 

1930 • 
1940 • 

1950 ' ******************.**. 
1960 '. END-OF-PROGRAM • 
1970 '. CLEANUP • 
1980 ' .t***.* •••• ****.* ••• ** 
1990 ' 
2000 CLOSE 1 
2010 RETURN 

VISITREN DIP LOT™ ~~T~~s 

CONSIDERATIONS WHEN TRANSFERRING 
TO THE VISICALC PROGRAM 

When transferring VisiTrend/Plot program data to the VisiCalc pro­
gram, there are certain considerations you should observe in your 
VisiTrendlPlot data series: 

• You should use VisiCalc version 177 or later. 

• The VisiCalc program uses a matrix of 63 rows by 252 columns. 

• A data series DIF file that exceeds 63 time units must be read into the 
VisiCalc program by columns. 

• A file that contains more than 252 time units exceeds the VisiCalc 
capability. 
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GLOSSARY 

This manual uses some terms that might be new to you or that you use 
in a different way. This glossary will help you to get acquainted with the 
precise meaning of these important terms. 

Chart: The output of the plotting program~ The graphic representation 
of one or more data series. 

Command: An order given to the computer program. In the 
VisiTrend/Plot program, commands are issued by selecting one of the 
choices displayed in a menu. 

Cursor: A white area on the screen used to point to items in menus 
and lists. The cursor is controlled with the four arrow keys and the space 
bar in menus and by just the t and ~ keys in lists. When the cursor is 
pointing to an item, the item is displayed in dark letters against a 
white background. 

Data Point: A numeric value that is associated with a date or reference 
point. In most charts, the value is plotted against the Y-axis and the time 
against the X-axis. Data points, along with their associated date or 
reference point, make up a series. 

Date: A value indicating a year or point within a year. A date or 
reference point is associated with every data point. 

DIF: Acronym for Data Interchange Format, a method for storing data 
on diskettes in a format that is readily acceptable to different computers 
and different computer programs. 

Exponential Smoothing: A forecasting technique to show trends in a 
data series by generating a new series by giving preference to the cur­
rent data and forecast. 

File: A collection of data on a floppy diskette. A file can contain from! 
to 16 series. 

Function: The operation or processing the program does in response to 
a command. 

Grid: Horizontal and vertical lines on a chart used as an aid in determin­
ing the value of a point or bars. In the VisiTrend/Plot charts, grid lines 
are series of small dots, light against a dark background and dark against 
a light background. 
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Intersection of the Range: The range of data points in two or more 
series that are common to all of the series. 

Inverse Video: The display of black letters on a white background. The 
standard format in a display is white letters on a black background. 

Least Squares: See Linear Multiple Regression. 

Linear Multiple Regression: A method of developing an equation that 
relates a dependent variable, such as a company's sales, to one or more 
independent variables, such as inventory, economic indexes, competi­
tion, etc., which should explain the dependent variable. Linear multiple 
regression in the VisiTrend/Plot program uses the ordinary least squares 
method. The method produces an equation consisting of a constant and 
independent coefficients that reproduce historical data with the smallest 
error, where error is the'sum of the squares of the residuals (SSR). 

List: A display that offers a collection of data items, one or more of 
which are selected with the cursor, the space bar, and the ~ key. 

Menu: A display that offers two or more command choices. The choices 
in a menu are selected with the cursor and the ~ key. A choice can also 
be selected by typing the first two letters of the command. 

Menu Item: A command choice that is offered in a menu. A menu item 
is selected with the cursor and the ~ key, or by typing the first two 
characters of the command. 

Moving-Average: An average taken over a specified number of points 
in a series. A series made up of moving averages may illustrate trends 
that are obscured by erratic peaks or valleys in the data. 

Period or Periodicity: The frequency at which data points occur within 
a year. A period of one means the data is shown on a yearly basis. A 
period of 12 means the data is shown on a monthly basis. 

Point: See Data Point. 

Range: The period of time covered by a series or the scope of the series. 
The range is the beginning date (and period) to the ending date 
(and period). 

Scale: The scope of values covered by the Y-axis of a chart. A scale 
usually, but not always, covers the highest and lowest values in a series. 
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Series: A collection of data points in sequence, usually time. A series is 
the basic unit of data that the VisiTrend/Plot program uses in memory. A 
series has a name. Up to 16 series can be stored in a file on diskette. 
Memory can hold a maximum of 16 series. 

Smoothing: A trending enhancement that performs a exponential 
computation on the source series. The smoothing computation is based 
on the most current data point and current forecast. 

Time Series: See Series. 

Union of the Range: The range of data points in two or more series that 
begins with the earliest data point in all series and ends with the latest 
data point in all series. 

X-axis: The horizontal axis of a chart. VisiTrend/Plot plots the date on 
the X-axis (except on XY charts). 

Y-axis: The vertical axis of a chart. VisiTrendiPlot plots the data point 
values on the Y-axis. 
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A 
Absolute Value, 2-86 
Adding 

an Entry, 2-56, 2-59 
Detail to a Chart, 2-9 
DOS to the Program Disk, 

1-9 
Values to the Series, 2-56, 

2-59 
Agreement Customer License, 

1-11 
Analysis Display Regression, 

2-75 
Analyze, 3-9 
Analyze Function Using, 2-68 
Analyze Menu, 2-68 
Annotation Creating on Charts 

and Text Pages, 2-117 
Arctangent, 2-86 
Area, 3-9 
Areas Status, 3-3 
Arithmetic, 3-9 
Arithmetic Operators, 3-39 
Automatic Correcting, 2-21 
Average, 2-71 

B 
Background, 3-9 
Backspace Key, 1-9 
Bar, 3-10 
Bar Chart Drawing, 2-6 
Bar Menu, 2-6 
Bk,3-4 
Black, 3-4 
Bold, 3-11 
Booting the Program, 1-10 
Both, 3-11 
Bringing Back the Legend, 

2-17 

c 
Calculate the Range, 3-5 
Calculate the Scale, 3-6 

INDEX 

Calculating Series Statistics, 
2-70 

Cancel, 3-11 
Capabilities Program, 3-1 
Cg,3-4 
Change Percent of, 2-79 
Change the Range, 3-6 
Change the Scale, 3-6 
Changes Remove, 2-62 
Changing 

and Moving Fixed Titles, 
2-117 

the Data Drive, 2-36 
the Printer Driver, B-1 
the Series Specifications, 

2-60 
Chart 

Adding Detail, 2-9 
Comparative-Bar, 2-103 
Displaying Two, 2-115 
Drawing, 2-5 
Formatting, 2-24 
Pie, 2-107 
Plotting, 2-4 
Printing, 2-29 
Retrieving a Screen Image, 

2-30 
Saving on Disk, 2-29 
Single-Bar, 2-100 
Single-Line, 2-95 
Three-Line, 2-97 
Titling, 2-10 
Two-Line, 2-96 
Type Selecting, 2-3 
XY,2-110 

Charts Creating Annotation, 
2-117 

Charts Well-Scaled, 2-21 
Clear, 3-11 
Clearing Series from Memory, 

2-43 
Coarse Gray, 3-4 
Coefficients of Correlation, 

2-71 
Color Adapter, 1-7 
Commands Edit, 2-57 
Comparative Operators, 3-39 
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Comparative-Bar Charts, 2-103 
Computer Requirements, 1-7 
Configuration, 3-12 
Considerations When Transfer-

ring to the VisiCalc 
Program, D-9 

Continue, 3-12 
Continuing with the Trend 

Subprogram, 2-91 
Control-B, 2-119 
Control-F, 2-119 
Control-Home, 2-119 
Control-R, 2-119 
Control-Z, 2-119 
Conventions Naming, 3-4 
Converting 

to a Centered Moving 
Average (Even Number 
of Periods), 2-86 

to a Centered Moving 
Average (Odd Number 
of Periods), 2-85 

to an N Moving Average, 
2-85 

Correcting Automatic, 2-21 
Correlation Coefficients, 2-71 
Cosine, 2-87 
Creating a DIF File Outside of 

the VisiTrend/Plot 
Program, D-7 

Creating Annotation on Charts 
and Text Pages, 2-117 

Ctrl-B, 2-119 
Ctrl-F, 2-119 
Ctrl-Home, 2-119 
Ctrl-R, 2-119 
Ctrl-Z, 2-119 
Cursor, 1-11 
Customer License Agreement, 

1-11 

D 
Data 

Disk Deleting Files, 2-45 
Disk Formatting, 2-40 
Display Changing, 2-61 
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Drive Changing, 2-36 
Format Internal, C-l 
Loading, 2-37 
Maintaining, 2-54 
Off-Scale During an 

Overlay, 2-111 
Point Erasing, 2-59 
Point Maximum, 3-1 
Points Number, 2-4 
Records, D-3 
Saving, 2-40 

Date Series End, 2-4 
Date Series Start, 2-4 
Delete, 3-12 

INDEX 

Delete: Erasing a Data Point, 
2-59 

Deleting Files from the Data 
Disk, 2-45 

Detail Adding to a Chart, 2-9 
Device, 3-12 
DIF, 3-13 
DIF File Dumping, D-4 
DIF Files Working with, D-4 
DIF Format, D-l 
DIF Suffix, 2-48 
Difference, 2-79, 3-13 
Differences One Disk Drive 

System, 1-8 
Disk 

and Disk Drives, 2-35 
Drive Requirements, 1-7 
Program Preparing, 1-9 
Saving Chart on, 2-29 
Taking Care of, 1-8 

Display, 3-13 
Display Startup, 1-10 
Displaying the Series In 

Memory, 2-39 
Displaying Two Charts At 

Once, 2-115 
DOS Adding to Program Disk, 

1-9 
Drawing a Bar Chart, 2-6 
Drawing Grid Lines, 2-26 
Drawing the Chart, 2-5 
Drive Changing, 2-36 
Drive Requirements, 1-7 
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Driver, 3-13 
Driver Printer Changing, B-1 
Drives and Disks, 2-35 
Dumping a DIF File, 0-4 

E 
Edit, 3-13 
Edit 

Command Menu, 2-57 
Exiting, 2-58 
Function, 2-54 
Returning, 2-58 
Using, 2-54 
Returning to the Entry Level, 

2-62 
Editor Commands, 2-57 
End Date, 2-4 
End-of-Data Records, 0-4 
Entry Adding, 2-59 
Erasing 

a Data Point, 2-59 
Fixed Titles, 2-17 
Moveable Titles, 2-16 

Error Messages, A-I 
Esc Key, 3-2 
Examples Plotting, 2-94 to 

2-117 
Exchanging Files, D-l 
Exit, 2-30, 2-58, 3-14 
Exit Menu, 2-30 
Exit: Leaving the Edit 

Function, 2-58 
Exiting Program, 2-46 

F 
Facts About Program 

Operations, 3-1 
Fg,3-4 
File and Series Names, 2-37 
Files, 3-14 
Files 

and Series, 2-36 
Deleting from Data Disk, 

2-45 
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Exchanging, D-1 
Menu, 2-40 

Fill, 3-14 
Fill Menu, 2-62 
Fill: Adding to a Series, 2-62 
Fine Gray, 3-4 
First, 3-14 
Fitted Data Series, 2-74 
Fixed Title Erasing, 2-17 
Fixed Titles Moving and 

Changing, 2-17 
Forecasting with the Regres-

sion Function, 2-76 
Format, 3-15 
Format Data Internal, C-1 
Format Menu, 2-61 
Format: Changing the Data 

Display, 2-61 
Formatting 

a Chart, 2-24 
a Data Disk, 2-40 

Formulas Regression, 3-26 
Full, 3-16 
Function, 3-16 
Function Menu, 2-78 
Function Series Names, 2-78 
Function Using, 2-78 
Functions Edit, 2-57 
Functions Trigonometric, 3-39 

G 
Geometric, 3-16 
Getting Started, 1-8, 2-94 
Getting to the Main Menu, 

2-34 
Graphic Printers Supported, 

B-2 
Graphics Monitor Adapter, 1-7 
Gray Coarse, 3-4 
Gray Fine, 3-4 
Grid, 3-16 
Grid Lines Drawing, 2-26 
Grid Menu, 2-26 
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H 
Header, D-3 
Hi-Lo-CI, 3-16 
Horizontal, 3-17 
How Range Is Used, 3-4 
How to 

1 

Calculate the Range, 3-5 
Calculate the Scale, 3-6 
Change the Range, 2-22, 3-6 
Change the Scale, 2-19, 3-6 
Convert an N + 1 Moving 

Average, 2-85 
Make Backup Copies of Your 

Data Disks, 1-8 

IBM 80-CPS Matrix Printer, 
B-4 

IBM Color/Graphics Monitor 
Adapter, 1-7 

Insert, 3-17 
Insert: Adding an Entry, 2-59 
Integer, 2-86 
Internal Data Format, C-1 
Interplay Between Scale and 

Range, 2-24 
Interpolate, 3-17 
Introduction, 1-1 
Inverse, 3-17 
Item Selecting, 1-12 

J 
Jump, 3-17 
Jump: Moving from Point to 

Point, 2-58 

K 
Key Backspace, 1-9 
Key Esc, 3-2 
Key Tab, 1-9 
Keyboard, 1-9, 3-1 
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L 
Lag, 2-79, 3-18 
Lead, 2-80, 3-18 
Least Square, 2-72 

INDEX 

Leaving the Edit Function, 2-58 
Left, 3-19 
Legend, 3-19 
Legend Bringing Back Length 

of Titles, 2-13 
License Agreement, 1-11 
Line, 3-20 
Linear Multiple Regression, 

2-72 
Lines, 3-20 
Listing Series In Table Format, 

2-68 
Load, 3-20 
Loading 

Data, 2-37 
the Program, 1-10, 2-1 
the Plot Subprogram, 2-44 
the Trend Subprogram, 2-44 

Log Natural, 2-86 
Logical Operators, 3-39 

M 
Main, 3-20 
Main Menu, 2-34 
Maintaining Data, 2-54 
Maximum, 2-71 
Maximum Data POints, 3-1 
Mean, 2-71 

'Memory Clearing Series, 2-43 
Memory Requirements, 1-7 
Menus 

Analyze, 2-68 
Bar, 2-6 
Edit Command, 2-57 
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Files, 2-40 
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Format, 2-61 
Function, 2-78 
Grid,2-26 
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Print, 2-29 
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Screen, 2-29 
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Specification, 2-60 
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Typeface, 2-11 
Unlabel,2-28 
Window, 2-115 

Menu Options 
Analyze, 3-9 
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Bar, 3-10 
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Cancel, 3-11 
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Configuration, 3-12 
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Delete, 3-12 
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Difference, 3-13 
Display, 3-13 
Driver, 3-13 
Edit, 3-13 
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Lead, 3-18 
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Load, 3-20 
Main, 3-20 
Moveable, 3-21 
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Name, 3-22 
New, 3-22 
None, 3-22 
Normal, 3-22 
Options, 3-23 
Original, 3-23 
Overlay, 3-23 
Percent-Change, 3-23 
Periodicity, 3-24 
Pie, 3-24 
Points, 3-25 
Plot, 3-25 
Print, 3-25 
Proceed, 3-25 
Quit, 3-25 
Range, 3-26 
Redraw, 3-26 
Regression, 3-26 
Rescale, 3-30 
Return, 3-30 
Right, 3-30 
Save, 3-30 
Screen, 3-31 
Second, 3-31 
Select, 3-31 
Series, 3-32 
Set, 3-32 
Shade, 3-32 
Side, 3-33 
Smoothing, 3-33 
Specs, 3-33 
Start, 3-33 
Statistics, 3-33 
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Text, 3-35 
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Window, 3-37 
Xform, 3-38 
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Messages Error, A-I 
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and Changing Fixed Titles, 

2-17 
Average, 2-81 
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2-85 
Average Converting an 

N + 1, 2-85 
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Moving-Average, 3-21 
Multiple Regression, 2-72 
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Name, 3-22 
Name Series, 2-3 
Names Series and Files, 2-37 
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B-4 
NEC 7730 Parallel Spin writer , 
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None, 3-22 
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Off-Scale Data During an 

Overlay, 2-111 
One Disk Drive System 

Differences, 1-8 
Operators 

Arithmetic, 3-39 
Comparative, 3-39 
Logical, 3-39 

Options, 3-23 
Options, Menu 

Analyze, 3-9 
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Bold, 3-11 
Both, 3-11 
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Configuration, 3-12 
Continue, 3-12 
Delete, 3-12 
Device, 3-12 
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Difference, 3-13 
Display, 3-13 
Driver, 3-13 
Edit, 3-13 
Exit, 3-14 
Files, 3-14 
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Format, 3-15 
Full, 3-16 
Function, 3-16 
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Grid, 3-16 
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Percent-Change, 3-23 
Periodicity, 3-24 
Pie, 3-24 
Points, 3-25 
Plot, 3-25 
Print, 3-25 
Proceed, 3-25 
Quit, 3-25 
Range, 3-26 
Redraw, 3-26 
Regression, 3-26 
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Return, 3-30 
Right, 3-30 
Save, 3-30 
Screen, 3-31 
Second, 3-31 
Select, 3-31 
Series, 3-32 
Set, 3-32 
Shade, 3-32 
Side, 3-33 
Smoothing, 3-33 
Specs, 3-33 
Start, 3-33 
Statistics, 3-33 
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Title, 3-36 
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T.rend, 3-37 
Undo, 3-37 
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Window, 3-37 
Xform, 3-38 
XY,3-40 

Options Menu, 2-9 
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Overlay, 3-23 
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Percent of Change, 2-79 
Percent-Change, 3-23 
Performing a Linear Multiple 

Regression, 2-72 
Periodicity, 3-24 
Pie, 3-24 
Pie Chart, 2-107 
Pie-Chart Data, 2-105 
Pie Chart Titling and Shading, 

2-108 
Pix Suffix, 2-37 
Plot, 3-25 
Plot Menu, 2-4 
Plot Subprogram, 2-1 
Plotting 

a Chart, 2-4 
Examples, 2-94 to 2-111 
Symbols, 2-6 

Pointing Technique, 1-11 
POints, 3-25 
Preparing the Program Disk, 

1-9 
Print, 3-25 
Print Menu, 2-29 
Print: Listing a Series, 2-62 
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B-3 
Support, B-2 

Printing 
a Data File from a DIF File, 

D-5 
the Chart, 2-29 

Proceed, 3-25 
Program 

Capabilities, 3-1 
Disk Preparing, 1-9 
Exiting, 2-46 
Loading, 1-10, 2-1 
Operation Facts, 3-1 

Putting Titles on a Chart, 2-10 

Q 
Qualifiers Series Name, 2-74, 

2-78, 3-4 
Quit, 3-25 

R 
Random Number, 2-86 
Range, 3-26 
Range 

and Scale, 2-18 
Calculate, 3-5 
Change, 3-6 
How Used, 3-4 
Menu, 2-22 

Record Data, D-3 
Record End-of-Data, D-4 
Redraw, 3-26 
Reference, 3-1 
Regression, 3-26 
Regression 

Analysis Display, 2-75 
Formulas, 3-26 
Function Trend Forecasting, 

2-76 
Series Names, 2-37 

Remove All Changes, 2-62 
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Requirements 

Computer, 1-7 
Disk Drive, 1-7 
Memory, 1-7 

Rescale, 3-30 
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Residual Data Series, 2-74 
Retrieving a Chart from a 

Screen Image File, 2-30 
Return, 3-30 
Returning 

to the Edit Function, 2-58 
to the Entry Level; 2-62 

Right, 3-30 

s 
Save, 3-30 
Saving 

Chart on Disk, 2-29 
Data, 2-40 

Scale 
Calculate, 3-6 
Change, 3-6 
Factor, 2-18 
How to Change, 2-19 
and Range, 2-18 
and Range Interplay 

Between, 2-24 
Scales, 3-6 
Screen, 3-31 
Screen Image Retrieving, 2-30 
Screen Menu, 2-29 
Second, 3-31 
Select, 3-31 
Select Menu, 2-3 
Selecting 

Chart Type, 2-3 
Menu Item, 1-12 
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Series 
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Name, 2-3 
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Statistics Calculating, 2-70 
Totaling, 2-81 
Transformation Writing, 2-86 

Set, 3-32 
Set Up Printer, B-3 
Shade, 3-32 
Shading 

and Titling a Pie Chart, 
2-108 

Codes, 3-4 
Side, 3-33 
Sign, 2-86 
Sine, 2-87 
Single Disk Drive System 

Differences, 1-8 
Single-Bar Chart, 2-100 
Single-Line Chart, 2-95 
Smoothing, 2-78, 3-33 
Some Uses for the Xform 

Function with Multiple 
Regression, 2-90 

Specification Menu, 2-60 
Specifications Changing, 2-60 
Specs, 3-33 
Specs: Changing the Series 

Specifications, 2-60 
Square Root, 2-86 
Standard Deviation, 2-71 
Start, 3-33 
Start Date, 2-4 
Startup Display, 1-10 
Statistics, 3-33 
Statistics Calculating, 2-70 
Status Areas, 3-3 
Subprograms 

Main, 2-44 
Plot, 2-44 
Trend,2-44 
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DIF, 2-37 
PIX, 2-37 
SER, 2-37 

Support Printer, B-1 
Supported Graphic Printers, 

B-2 
Switch, 3-34 
Switch Settings Printer, B-3 
Symbols, 3-34 
Symbols Plotting, 2-6 
System Differences One Disk 

Drive, 1-8 
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Tab Key, 1-9 
Table, 3-35 
Table Format, 2-70 
Taking Care of Disk, 1-8 
Tangent, 2-87 
Text, 2-117, 3-35 
Text Pages Creating 

Annotation, 2-117 
Third, 3-36 
Three-Line Chart, 2-97 
Title, 3-36 
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Erasing, 2-16, 2-17 
Lengths, 2-13 
Menu, 2-10 
Moving, 2-14 

Titling a Chart, 2-10 
Titling and Shading a Pie 

Chart, 2-108 
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Total, 3-36 
Totaling a Series, 2-81 
Transformation W riling, 2-86 
Trend, 3-37 
Trend Forecasting with the 
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2-76 

Trend Subprogram, 2-44 
Trigonometric Functions, 3-39 
Two-Line Chart, 2-95 
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u 
Undo, 3-37 
Undo: Remove All Changes, 

2-62 
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Usage Keyboard, 3-2 
Use of Non-Graphics Printers, 
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Use of Range, 3-4 
Useful Facts About Program 

Operations, 3-1 
User Support Plan, 1-11 
Using 
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Edit, 2-54 
Function, 2-78 
the Analyze Function, 2-68 
VisiCalc Data In the 

VisiTrend/Plot Program, 
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Value Replacing, 2-57 
Variance, 2-71 
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Well-Scaled Charts, 2-21 
Wh,3-4 
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Window, 2-115,3-37 
Window Menu, 2-115 
Working with DIF Files, D-4 
Worksheet VisiCalc, 2-46 
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Transformation, 2-86 
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Xform, 3-38 
Xform Function Uses, 2-90 
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